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1 INTRODUCTION 

Welcome to SeisImager/SWTM! SeisImager/SW is an easy-to-use, yet powerful program that 

allows you to analyze multi-channel active- and  passive-source (microtremor) surface wave 

data. SeisImager/SW includes functions to perform the following basic procedures, and more: 

 

• Input and display data. 

• Control how data is displayed. 

• Make changes/corrections to data files and save them. 

• Calculate and edit dispersion curves. 

• Invert data for a one-dimensional shear-wave velocity curve. 

• Invert data for a two-dimensional shear-wave velocity cross-section. 

• Display results in graphical form. 

SeisImagerTM is the master program that consists of seven modules for refraction, downhole, and 

surface wave data analysis. The individual modules are PickwinTM, PlotrefaTM, WaveEqTM, 

PSLogTM, SPACPlusTM, and GeoPlotTM. The Surface Wave Analysis WizardTM is not a separate 

module but automatically calls on specific functions from Pickwin, WaveEq, and GeoPlot to 

walk you through the analysis process. The overall structure of SeisImager is shown below: 

 

  

 

 

Figure 1: SeisImager family of applications. 
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Pickwin and WaveEq are the main modules used for surface wave data analysis, making up the 

program called SeisImager/SW, which is available in two packages. The first, SeisImager/SW-

1D, is capable of one-dimensional (1D) analysis of multi-channel active- and  passive-source 

(microtremor) data, with output of a single curve of shear-wave velocity (VS) viewed in 

WaveEq. The second package, SeisImager/SW-2D, is capable of two-dimensional (2D) analysis 

of multi-channel active- and  passive-source data, with output of a cross-section of VS viewed in 

GeoPlot. Note that GeoPlot is its own standalone module for general data visualization. In this 

manual, only the GeoPlot functions needed in the 2D surface wave analysis process are covered. 

See the GeoPlot manual for full documentation of GeoPlot.  

For refraction data analysis, Pickwin and Plotrefa make up the program called SeisImager/2D. A 

separate manual exists for SeisImager/2D, and due to the overlap of Pickwin with 

SeisImager/SW, reference is made to the SeisImager/2D manual for explanation of the common 

Pickwin menus. 

SeisImager is also available for rent in run-time periods of 40, 75, and 250 hours. The rental 

package, by default, includes both SeisImager/2D and SeisImager/SW-2D. 

Section 2 of this manual describes software installation. Section 3 describes data acquisition 

methods, and Section 4 describes data analysis using the wizard. Section 5 describes the features 

and capabilities of SeisImager/SW-ProTM. Section 6 explains the surface wave functions of 

Pickwin, and Section 7 describes the WaveEQ functions. Appendix A goes through the basic 

processing flows, and Appendix B discusses data quality control. Some theory is touched on (see 

Appendix C), but this manual is not meant to be a treatise on multi-channel analysis of surface 

waves (MASW) or microtremor array measurements (MAM). It is assumed that the user has a 

reasonable grasp of the main principles of seismology and mathematics to understand the 

principles behind the analysis techniques employed by the software. Appendix D provides links 

to online tutorials with example data, and Appendix E provides a list of links to short course 

material. Finally, see Appendix F for a list of recommended reading on surface wave theory and 

techniques. 

Although this manual can be printed, it was designed as an online resource, and includes 

many internal and external hyperlinks. It will be updated on a semi-regular basis, and a 

current version will always be available for download on our site. Be sure to display the 

navigation tool bar in Acrobat Reader (as of this writing, the toggle switch was F8) to simplify 

navigation: 

 

Figure 2: Acrobat Reader navigation tool bar. 

If your version of Acrobat Reader does not have the above tool bar, use Alt+Left Arrow to return 

to the previous view after clicking on a link. 
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The manual makes liberal use of color, so if you elect to print it, using color is highly 

recommended. 

Finally, we are very interested in your constructive criticism of both this manual and the software 

itself. Please contact us at seismicsales@geometrics.com with any comments you might have. 

 

Note: This is a general manual covering all features of all versions of SeisImager/SW. There are 

several tiers of software available, all having different sets of features. If you see features 

described in the manual which are not present in your software, it is because the level of 

software you purchased does not include those features. 

 

Note: SeisImager/SW includes many features that are very rarely used, and only then by a select 

few, often only those who requested the features in the first place. The average user will 

generally have no need for them. In the interest of completeness, these features, although not 

described, are included in this manual, with a pointer to our support email. If you see something 

that you think you might wish to make use of, please contact SeisImager support. 

 

Note: SeisImager/SW is very complex software “under the hood” and may grow unstable and 

give spurious results if many different models are run in one session or if there are unit conflicts 

between modules. It is therefore best to begin a new instance of the application to run new 

models. If the program does exhibit instabilities, follow this procedure: 

 

 

• Close all SeisImager modules. 

 

• In the Windows search box, 

 

 
 

Type in “SeisImager Registration.” You will see the following: 

 

 
 

• Select View or change registration. You will be presented with the SeisImager Registration 

dialog box.  

 

• Select Advanced options (upper right) and then press Restore all modules to default settings 

and then press OK. 
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Note: Throughout this manual, you will find that certain menu items are greyed out. There are 

two reasons for this. The most common is that the feature is not applicable to that dataset or that 

point in time. The other reason is that some items may not be available under your license. 

 

Prior to reading this manual, you might find it instructive to watch some videos on MASW, 

MAM, and H/V data acquisition and analysis: 

 

 

Seismic Surface Waves Overview (5.48) 

 

1D MASW (active-source) Field Setup and Data Acquisition – Geode Seismograph (4:53) 

 

1D MASW (active-source) Data Processing using SeisImager/SW (30:53) 

 

Atom Seismograph Field Operations and pro (9:37) 

 

MAM and H/V Analysis of Atom Data (28.53) 

 

1D MASW (active-source) and MAM (passive-source) Acquisition and Analysis using the 

Atom-1C Seismograph (50:40) 
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2 INSTALLING THE SOFTWARE 

The SeisImager USB stick is supplied (1) for trial evaluation of the programs, (2) for purchase, 

rental, or upgrade of one or more of the programs, or (3) with purchase of an ES-3000TM, 

GeodeTM, or StrataVisor NZXPTM, or AtomTM seismograph, which all include the Lite version of 

SeisImager/2D. The USB contains all programs and all documentation.  

Occasionally, there will be a software release in between USB releases. In this situation, the USB 

will be labeled with a notice to download the latest version. 

Note: Even if the USB is not labeled with instructions to do so, it is best practice to download and 

install the latest software prior to installation, as SeisImager is updated frequently. The USB is 

convenient, especially if you do not have an internet connection. However, if you do have an 

internet connection, we highly recommend that you skip the USB for installation altogether. If you 

do so, be sure to download the newest manual as well. 

Note: You must have administrator rights to install the software. After installation by an 

administrator, users with lower-level privileges can use the software. 

To install or update the software, click on the file named SeisImager.msi (or 

SeisImager_xxxx.msi). If SeisImager is already installed on your computer, you will be 

prompted to remove it or repair it. Remove the software, run SeisImager.msi again, and then 

simply follow the prompts. 

After the installation is complete, you will be presented with the registration screen: 
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If you already have a registration ID, indicate as such, type it in, and press Register. If you do not 

have an ID, click I do not have a registration ID, and send your keyword and order number or 

seismograph serial number to support@geometrics.com. You will be given a registration ID that 

will enable the products that you purchased or rented. You may return to this screen later by 

typing “SeisImager Registration” into the Windows search box at the lower left of your desktop: 

 

The programs enabled by the registration ID will be reported in a series of messages. Click OK 

to accept each message. 

After these messages have appeared, the register will reflect the programs that have been 

registered, as shown below. In this case, Pickwin ProTM and Plotrefa ProTM are the programs that 

have been registered. 
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Typically, installing an upgrade of the software does not require re-registration, but if you are 

upgrading from a version older than April 2007, you will need to re-register. 

 

Once installed, the program modules can be opened directly through the desktop icons shown 

below: 

 

 

The Surface Wave Analysis Wizard is not a separate module but automatically calls on specific 

functions from Pickwin, WaveEq, and GeoPlot to walk you through the analysis process. All of 

the icons (shortcuts) will be copied to your desktop regardless of which program(s) has been 

purchased or will be used. You may wish to create a folder for the various shortcuts to avoid 

cluttering on your desktop. Alternatively, you may elect to simply delete the shortcuts that you 

did not purchase/rent the rights to. 

To begin using the software, double-click the appropriate shortcut.  
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For registered installations, the module opens and is ready for use. The other registered modules 

are ready for use as well.  

For unregistered installations running in demonstration mode, you will be presented with the 

message shown below. Press OK. 

 

 

 

To enter a registration ID after your 15 times in demonstration mode, go to the Windows search 

box (lower left) and type “SeisImager” to find the SeisImager Registration  program as 

shown above. Open the register and email the keyword to support@geometrics.com with your 

order number and seismograph serial number (if you purchased the software with a 

seismograph), and we will reply with a registration ID to enable the version of the software you 

have purchased. Once received, enter the registration ID press OK. You will see a message like 

the following: 

 

 

Once the software is registered, the data input dimensions of the demonstration version will be 

updated to reflect the limits of the program purchased. You will see a message like the one 



Installing the Software 
 

 

9 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

below. Press OK. 

 

This completes the description of all possible registration pathways. 

As mentioned previously, the Lite version of SeisImager/2D comes free with all seismograph 

purchases, so if you have purchased SeisImager/SW with a seismograph, you are also entitled to 

the Lite version of SeisImager/2D. If you do not already have a license for SeisImager/2D, Lite 

or otherwise, but would like to order a copy, please contact us at support@geometrics.com. 

A general recommendation when using the SeisImager suite is to close and reopen the software 

modules or open a second instance of the software modules to start new, separate analyses. The 

programs are efficient and quickly launch so this is easy to do and will prevent complications 

when processing data. 

Regarding making report graphics and documenting your data processing, SeisImager includes 

the ability to print graphics to a printer or pdf, as well as save images to PNG, JPG, BMP, or GIF 

format. You might also find it handy to have a screen capture program such as HyperSnap
® 

from 

Hyperionics. Bitmap screen captures can be quickly and easily made at the desired stages of 

processing and saved for import into Microsoft Word or other applications. 

 

For more advanced graphics, consider Geometrics GeoPlot.   
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3 DATA ACQUISITION 

SeisImager/SW includes the functions for three main processing flows, two for analyzing active-

source datasets and a third for  passive-source datasets. Methods for collecting these data types 

for input to SeisImager/SW are discussed in this section with specific set up instructions using 

the ES-3000, SmartSeis ST, Geode, and StrataVisor NZ seismographs. The basics of running the 

acquisition and data analysis software are covered, with a brief introduction to surface waves. 

We recommend and refer you to the published body of literature for an in-depth discussion of 

surface wave theory and survey methods (See Appendix F, Page F-1.) 

Dispersion, or change in phase velocity with frequency, is the fundamental property utilized in 

surface wave methods. Shear-wave velocity (VS) can be calculated by mathematical inversion of 

the dispersive properties of surface waves. Surface wave dispersion can be significant in the 

presence of velocity layering, which is common in the near-surface environment. In this 

application, we are concerned with the Rayleigh wave, which is also called “ground roll”, since 

the Rayleigh wave is the dominant component of ground roll. Although there are other types of 

surface waves, the term “surface wave”, when used in the SASW (Spectral Analysis or Surface 

Waves), MASW (Multi-channel Analysis of Surface Waves), or MAM (Microtremor Array 

Measurement) context has come to mean the Rayleigh wave.  

There are two ways surface waves are generated. “Active-source” means that seismic energy is 

intentionally generated at a specific location relative to the geophone spread and recording 

begins when the source energy is introduced into the ground. This contrasts with “ passive-

source” surveying, also called “microtremor surveying”, or sometimes referred to as “refraction 

microtremor” (or the commercial term “ReMi”) surveying. In  passive-source surveying, there is 

no time break, and ambient vibrations from energy generated by cultural noise, wind, wave 

motion, etc. at various (and usually unknown) locations relative to the geophone spread is 

recorded.  

Surface wave energy decays exponentially with depth beneath the surface. Longer wavelength 

(that is, longer period and lower frequency) surface waves travel deeper and thus contain more 

information about deeper velocity structure. Shorter wavelength (that is, shorter period and 

higher frequency) surface waves travel shallower and thus contain more information about 

shallower velocity structure.  

In this context, by their nature and proximity to the geophone spread, it can be said that higher 

frequency active-source surface waves resolve the shallower velocity structure and lower 

frequency  passive-source surface waves resolve the deeper velocity structure. When the total 

depth of interest is great enough to require use of  passive-source surveys, it is still very 

important to sufficiently sample the shallower depths. The shallower section will have a 

relatively large impact on average IBC VS100 (UBC VS30) curves and the usefulness of VS 

cross-sections. In SeisImager/SW, the results from active- and  passive-source surveys can be 

combined to maximize the resolution and overall depth range of investigation. 
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3.1 1D MASW DATA ACQUISITION 

Seismic energy for active-source surface wave surveys can be created in various ways, but a 

sledgehammer to strike the ground is recommended since it is a low cost, readily available item 

and tends to be energetic enough for most near-surface investigations. Of course, a 

sledgehammer may not be appropriate for all situations and the actual source used should be 

tailored to the survey scale and goals. To signal to the seismograph when the energy has been 

generated, a trigger switch is used as the interface between the hammer and the seismograph. 

When the sledgehammer hits the ground, a signal is sent to the seismograph to tell it to start 

recording.  

Table 1 on Page 12 summarizes the parameters suggested for active-source 1D MASW surveys. 

Most parameters are self-evident, but two settings to consider further, as they relate to the depth 

range of sampling, are the spread length and geophone interval.  

Surface waves sample to an approximate depth of their wavelength divided by three. 

Furthermore, in surface wave surveying, it is assumed that the longest wavelength that can be 

sampled is as long as the spread length. So, to determine the spread length, two times your depth 

of interest is a good (and the accepted) rule of thumb. However, when combining active- and  

passive-source results, since the  passive-source survey can be used to sample greater depths, the 

active-source survey spread length need not always be as long as two times the depth of interest. 

To determine the active-source survey spread length, it is suggested to consider the maximum 

distance that the source energy propagates and the shallowest depth of interest.  

For an active-source survey with a sledgehammer, a geophone interval of 1.5 to 3 meters (5 to 10 

feet) is suggested. Using a 24-channel seismograph, this would give a spread length of 35 meters 

(115 feet) using the 1.5-meter (5-foot) geophone interval. Applying the ½ wavelength (or spread 

length) rule of thumb, the depth of sampling would be about 17.5 meters (58 feet). Depending on 

the site materials and conditions, source energy may not strongly propagate to an offset of 35 

meters (115 feet), and stacking may be needed and/or the geophone interval may need to be 

reduced. You must find a balance between signal propagation, geophone interval, and the spread 

length. Site-specific testing and judgment should always be applied to confirm that the suggested 

recording parameters are appropriate. 

If you are only doing an active-source survey and will not have passive data to resolve greater 

depths, it is recommended that the spread length be equal to about two times the depth of 

interest. Additionally, the active-source survey can include two (or more) spreads, one with a 

shorter spread and lighter weight hammer and one with a longer spread and heavier weight 

hammer (or other source), to sufficiently sample a range of depths.  
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Parameter 

 

 

Setting 

 

Spread configuration 

 

 

Linear. 

 

 

 

Spread length 

About equal to depth of interest when 

supplementing with  passive-source data; about 

equal to two times depth of interest if no  

passive-source data available.*  

 
Geophone interval 

 

1.5 to 3 m or 5 to 10 ft. * 

Total number of geophones 

 
12 or more, minimum of 16 preferred. 

 

Geophone type 
4.5 Hz vertical geophones, with base plates for 

surveys on paved ground. 

 
 

Shot locations 

 

Minimum of one shot, located in-line and off-

end (either end) of spread; reverse shots 

suggested. 

 
 

Shot near offset 
About 10% to 20% of spread length; an 

additional shot located at about 40% of spread 

length is suggested. 

 
 

 

Source equipment 

Sledgehammer (most common), 8 lbs (3.6 kgs), 

16 lbs (7.2 kg), 20 lbs (9 kg), scale hammer 

weight up with increase in spread length*, and 

striker plate. 

 
 

Trigger 

Hammer switch taped to sledgehammer handle 

and connected to seismograph trigger port. 

 

Sample interval 

 

0.5 ms. 

 

 

Record length 

1 to 2 seconds; long enough to capture the 

surface wave train. 

 

 

Stacking 

 

As needed to improve data quality, wait for 

quiet times to shoot. 

 
*Also refer to preceding discussion in text. 

 
Table 1: 1D MASW Acquisition Parameters. 
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3.1.1 1D MASW SURVEY GEOMETRY 

The geometry of a survey describes the spatial relationship of the shot and receivers. The spread 

of receivers will have some configuration and relative spacing to the shot(s). When there is one 

or just a few shots per survey, the geometry is simple and easy to track and record. When the 

number of shots grows, and especially if the spread locations change, like for a 2D MASW 

survey (Section 3.3, Page 38), recording the geometry requires more attention and effort.  

 

3.1.1.1  1D MASW SURVEY SPREAD CONFIGURATION 

For 1D MASW surveying, a linear spread configuration is used (Figure 3). The geophones are 

configured in a straight line on the ground and interconnected with a spread cable (black line). 

The distance between the first and last active geophones is the spread length and the distance 

between the shot location and the nearest active geophone is the near offset. The resultant VS 

curve is an average over the spread and accordingly should be located at the center of the spread. 

 

 

 

Figure 3: 1D MASW survey spread configuration. 

3.1.2 1D MASW SURVEY DATA ACQUISITION WITH GEOMETRICS 

SEISMODULE CONTROLLER SOFTWARE 

The data acquisition setup is illustrated using the Geometrics Seismodule Controller Software 

(SCS) for the ES-3000, SmartSeis ST, Geode, and StrataVisor NZ seismographs. Other 

seismographs that record data in the SEG-2 file format can also be used. In this section, the 

essential software dialog boxes pertaining to acquisition of surface wave data are discussed, with 

the menu paths indicated in the PATH boxes. The menus and dialog boxes are addressed in order 

that they appear in the software, working from left to right on the menu bar. You may also want 

to set parameters in other dialog boxes not mentioned in this section. Please refer to the separate 

manual specific to your seismograph for a complete explanation of SCS. The seismograph 

manuals should also be referred to for instructions on how to set up the system hardware.  

The first step is to install SCS. Once this is done, launch SCS from the icon on your desktop, or 

from the Start menu under All Programs | Geometrics, Seismodule Controller.  
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If this is the first installation of SCS on your PC, you will be presented with a 12-digit code and 

asked for a registration password. Copy and paste the 12-digit code in an email and send with the 

serial number of your seismograph to support@geometrics.com. You will be sent a 40-digit 

registration password. Email is recommended because it is easy to mistype or misspeak the code 

and registration password.  

 

3.1.2.1 1D MASW SURVEY SCS SETUP 

First, select Survey | New Survey to assign a Survey Name and Initial Line Number. The Survey 

Name is used as the name for the survey log that is maintained during the survey. All software 

activities during the survey, such as parameters set or files written to the hard drive, are saved to 

the survey log. The survey log is a text file that you can recall for reference later. Press OK when 

done.  

 

 

 
 

 

Next, select Geom | Geophone interval and set the distance between each geophone in the line, 

and the applicable units. Press OK when done. 
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Next, select Geom | Group/Shot Locations and set up the survey geometry. In the Geometry 

dialog box, it is recommended to navigate using the keyboard keys, not the mouse. The up and 

down arrow keys will move the cursor between rows and the right and left arrow keys will move 

the cursor between columns. Note that the Backspace key functions the same as the left arrow 

key. 

Below the graphical display of the spread, the parameters are viewed as rows and columns. The 

row names are shown on the left-hand side and the column names are the Trace numbers shown 

just below the spread graphic. The cells for Interval are offset to indicate that the entered value is 

the distance between Trace 1 and 2, 2 and 3, etc. 
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The Geophone Interval entered in the previous dialog box is shown. The default Shot Coordinate 

and starting Geophone Coordinate is zero, but you may use whatever numerical coordinate 

system you wish. If a value is changed, the change will “ripple” through the rest of the geophone 

coordinates if Ripple is checked (the default).  

Note that the seismograph and geophone cable are wired so that the seismograph is always on the 

“high side”. That is, in native configuration, the nearest channel or geophone to the seismograph 

is always the highest channel number. For example, with a 24-channel Geode seismograph 

connected to a standard 24-takeout spread cable, when the line is set up, the nearest geophone to 

the Geode will be connected to channel 24. Further on this point, if you want the source location 

to be off the end nearest the seismograph, the Shot Coordinate value will need to be changed 

from 0 to the appropriate value greater than the coordinate of geophone 24. Once it is determined 

at which end of the spread the shot is located, set the Shot Coordinate to reflect that location.  

Note: If the data is recorded with the wrong geometry, it can easily be reassigned in 

SeisImager/SW at the time of data processing.  

The default settings in the rows for Gain (how much the signal is boosted before digitization) 

and Use (how a channel is used), require no adjustment. If your settings do not match the default 

settings shown, go ahead and change them. For all channels, the Use row should be Data. Gain 

is changed in a subsequent menu. Press OK when done. 
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Next, select Acquisition | Sample Interval/Record Length and set the data acquisition timing 

parameters. Delay should be set to zero. Press OK when done.  

 

 

Next, select Acquisition | Acquisition filters. Check the acquisition filter settings. Acquisition 

filters are permanent; any data filtered with an “acquisition” (versus “display”) filter will be 

irreversibly so. Acquisition filters are not typically needed when collecting surface wave data, 

and thus, should be disabled with the setting Filter Out. Press OK when done. 

 

 

Next, select Acquisition | Stack Options and set the stacking parameters. Stacking is a way to 

increase the signal-to-noise ratio by hitting the striker plate repeatedly at each shot point and 

adding the files together as they are collected. Coherent signals will add, and incoherent noise 

will cancel. In many cases, stacking will not be needed, and thus, the Stack Limit default value is 

set to 1. If, however, you are in an urban environment and there is a high level of noise, or the 

signal quality on the distant traces is low, stacking will help (but remember that what is called 

“noise” in an active-source survey is the “signal” recorded during a  passive-source survey). The 

benefits of stacking start tapering off after ~8-10 stacks, as the S/N ratio increases with the 

square root of the number of stacks. To stack 8 times, enter 8 as the Stack Limit. Press OK when 

done. 
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Next, select Acquisition | Preamp Gains and set the gains to All High Gain, which equals 36 dB. 

All Low Gain equals 24 dB and Individual applies when non-uniform gain settings are needed. 

There may be cases where the geophones nearest the shot location are close enough that they are 

overdriven by the signal and the recorded waveform is clipped. In this situation, Individual gain 

settings of 24 dB for the near channels and 36 dB for the rest of the channels can be used. Press 

OK when done.  

Note: Unlike refraction surveys, where only the first breaks are important, surface wave surveys 

require the entire waveform and clipping must therefore be strictly avoided. If clipping is still 

observed (signified by a red trace on the seismograph) even after setting the gains to the lowest 

value, get a smaller hammer and/or swing the hammer more softly. See the “freeze” function in 

the seismograph manual for more recording options if clipping becomes an issue. 
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Next, select File | Storage parameters and set up the data storage parameters. The Next File 

Number should be a numerical value; after each save, the name will automatically increment by 

one. For the SEG-2 format, the file extension .dat is appended to the numerical name 

(Geometrics seismographs). Since the survey line is called Line 1, the suggested starting file 

number is 101.  

Checking Auto Save will ensure that each file will be automatically saved after the Stack Limit is 

reached. If this is unchecked, you will need to manually save (and clear) each file. The Stack 

Limit reflects what was entered in the previous Acquisition Stack Parameters dialog box.  

For the Path of saved data, enter the desired folder name. Press OK when done. 

Note: When creating a folder using SCS, you can only go one folder deep. 
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This is the last essential dialog box in SCS for the 1D MASW survey setup.   

 

3.1.2.2 AFTER SETUP – ACQUIRING, DISPLAYING, AND QUALITY CHECKING 

1D MASW DATA 

Once the setup is complete, you are ready to begin data acquisition. An example of the main SCS 

window is shown below. The number of traces in the Noise Monitor Window matches the 

number of channels in the seismograph; this example shows 24 traces.  
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Figure 4: Main SCS Window 

Before any data is recorded, use the Noise Monitor Window to check the line. Lightly tap the top 

of the nearest geophone and watch which trace shows the largest response; it should be the 

geophone with the highest channel number. Check that the response level of each geophone to a 

tap is about the same. If there is a trace with a dissimilar or atypical level of noise, walk down 

the line to check that the internal sensor element can oscillate freely (give a gentle shake up and 

down in the vertical orientation.) Make sure the geophone is correctly and vertically planted and 

that it is connected to the spread cable. It is best practice to make sure all traces are responding 

properly before collecting data.  

Next, check that the status bar on the bottom of the window shows an Armed condition and is 

colored green. You may want to first press the “1” shortcut key to toggle the armed state off and 

practice hitting the striker plate with the hammer.  

When ready, press 1 to return the system to an armed state, and swing the hammer at the shot 

location. Check to confirm that the system triggered, and the shot was recorded. A typical active 

dataset consists of one (or more as needed) shot records. Make sure there are no red traces 

indicating clipping. 

When you first view the data, the display gains will probably need adjustment. One condition 

that can occur is that the signal may not be visible for all traces as shown in the record below.  
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To adjust the display gains, select Auto Scale Traces or press the “6” shortcut key. Selecting 

Auto Scale Traces causes the software to find the gain that optimizes the allotted space for each 

trace in the Shot Window. 
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To further adjust the gain, highlight the Shot Window and use the right arrow key to activate the 

display gain controls. If when you press the right arrow key, the Shot Display Gain Style 

Parameters dialog box appears, choose Fixed Gain. Press OK when done.  

 

 

Press the right arrow key again, and as directed in the instruction box, use the up and down 

arrow keys to increase and decrease the gain by the same amount for all channels.  

 

 

Press the Esc key to end.  
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The Shot Window can also be zoomed in and out using the Page Down and Page Up keys and 

scrolled up and down using the up and down arrow keys.  

The final display settings should provide a shot record looking like that shown below:  

 

 

 

Figure 5: Ground roll. 

   

Note: Red traces indicate clipping. If any traces are clipped, you must adjust the acquisition 

gain settings and re-record the data. 

Once the display parameters are optimized, check for the presence of dispersive surface waves. 

Surface waves are relatively lower frequency, higher amplitude, and slower than other events in 

the record. Ground roll in a “wedge” or “fan” shape indicates dispersion. In addition to visual 

analysis, refer to Section 4 (Page 54) on how to run a field check of dispersion using 

SeisImager/SW. 
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After you have collected the active-source record(s) and are satisfied with the data, continue to 

the  passive-source survey if applicable. 

 

3.2 MAM DATA ACQUISITION  

During a  passive-source survey, the seismograph records ambient vibrations generated by 

cultural noise, traffic, factories, wind, wave motion, etc. There is no timing device to trigger the 

seismograph.  

The ideal vibration sources are steady, at a constant level, and far away relative to 

the array size. The fundamental assumption of microtremor data analysis using the 

spatial autocorrelation (SPAC) method of SeisImager/SW is that the signal 

wavefront is planar, stable, and isotropic (coming from all directions), making it 

independent of source location. A high level of intermittent noise (like nearby 

passing cars) is tolerable if the sources are relatively distant (approximately equal to 

or greater than one array length). Even if the intermittent noise sources are near, this 

is usually countered by recording at least 20 long records (32 seconds each). Long 

records make for smooth input when the records are converted from the time to 

frequency domain and many records provide a statistically robust representation of 

ambient vibrations.  

Table 2 summarizes the recommended  passive-source acquisition parameters.  
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Parameter 

 

 

Setting 

 

Spread/array configuration 

 

 

L-shape, Triangle, Circle, Linear, or custom. 

Array size Minimum of 1 times depth of interest. 

 

Geophone interval 

 

Up to 15 m or 45 ft; adjust to suit array 

configuration and size. 

 

Total number of geophones 

 

Various based on spread configuration. 

 

 

 

Geophone type 

4.5 Hz vertical geophones, with base plates 

for surveys on paved ground; alternatively, if 

available, 1 or 2 Hz seismometers can be 

used, especially if depth of interest is greater 

than 30 m (100 ft). 

 

Trigger 

 

Manual keyboard trigger. 

Sample interval 2 milliseconds (ms). 

 

 

Record length 32 seconds (s) each record, total of at least 20 

records. 

 
 

Table 2: MAM Acquisition Parameters. 

 

3.2.1 MAM SURVEY GEOMETRY 
 

Continue. 

 

3.2.1.1 MAM SURVEY SPREAD CONFIGURATIONS 

SeisImager/SW allows four preset types of  passive-source spread or array configurations and a 

custom option. Figure 6 through Figure 10 (not drawn to scale) illustrate the various preset 

configurations. As in Figure 3, the black line represents the spread cable, and the green inverted 

triangles represent the geophones.  
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Of the four preset arrays, one is linear and three are 2D; that is, geophones are distributed in two 

dimensions versus a line, on the ground surface. 2D arrays provide the most rigorous distribution 

of data points for analysis; however, the SPAC method used by SeisImager/SW handles data 

from all array types because it is independent of source location.  

Consider a linear array. If microtremors propagate parallel to the survey line, the surface wave 

phase velocity can be directly calculated. Conversely, if microtremors propagate perpendicular to 

the survey line and reach all the geophones at the same time, the phase velocity cannot be 

calculated. As the angle of propagation increases from parallel to perpendicular, the apparent 

phase velocity increases. In reality, source locations of microtremors vary and energy radiates 

from many directions at unknown angles to the geophones. Since angles of propagation are 

unknown, with a linear array, the calculated phase velocity may be higher than the actual phase 

velocity unless a method independent of the source locations such as SPAC is used.   

 

 

Figure 6: Map view of MAM survey equilateral triangle spread configuration with 10 geophones (“Triangle 10”).  

  

 
 

Figure 7: Map view of MAM survey equilateral triangle spread configurations with 7 (“Triangle 7”) and 4 

geophones (“Triangle 4”). 

For a triangular array (Figure 6 and Figure 7), the Array size is defined as the length of a side. 

The resultant VS curve is an average over the array and, accordingly, should be located at the 

center of the triangle.  
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Figure 8: Map view of MAM survey L-shape spread configurations with 11 (“L11”), 9 (“L9”), and 7 (“L7”) 

geophones.  

For an L-shaped array (Figure 8), the Angle between the branches of the L is typically 60 to 90 

degrees, but technically can be as small as 0 degrees, which is a linear array. Both branches are 

the same length; the Array size equals the length of the branches. The resultant VS curve is an 

average over the array and accordingly should be located essentially at the origin or near the 

origin between the two branches of the L. The L-shaped array is the two-dimensional array that 

is easiest to set up in the field. It can easily be constructed after an active-source survey by 

turning one-half of the spread 90 degrees and adjusting the geophone intervals to span the 

required Array size.  

 

 
 

Figure 9: Map view of MAM survey circle spread configurations with 8 outer geophones on one circle and one 

center geophone (“Single circle 9”) and 18 geophones in two circles and one center geophone (“Double circle 

37”).  

For the Double circle 37 array (Figure 9) the inner circle diameter equals one-half the outer 

circle radius. For all circle arrays, the Array size equals the diameter of the outer circle. The 

resultant VS curve is an average over the array and accordingly should be located at the center of 

the circle.  
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Figure 10: MAM survey linear spread configuration using all channels, one per geophone. 

 

For a linear array (Figure 10), the Receiver spacing equals the geophone interval and the Number 

of receivers equals the number of geophones. The resultant VS curve is an average over the array 

and accordingly should be located at the center of the spread.  

 

3.2.2 MAM SURVEY DATA ACQUISITION WITH GEOMETRICS SEISMODULE 

CONTROLLER SOFTWARE 

The data acquisition setup for MAM surveys involves the same dialog boxes used in the 1D 

MASW survey setup. This section assumes that you have already worked through the 1D 

MASW survey setup, that you are doing a MAM survey at the same site to supplement the 1D 

MASW survey, and that the MAM array type is L11 for a depth of interest of approximately 30 

meters (100 feet). MAM surveys can also be performed to supplement 2D MASW. Refer to 

Section 3.1.2, on Page 13, for an introduction to the 1D MASW setup process and for more 

detail on the dialog boxes common to both survey setups. 

 

3.2.2.1 MAM SURVEY SCS SETUP 

First, select Survey | New Survey and assign a Survey Name and Initial Line Number. An Initial 

Line Number of 2 indicates that this is a new line configuration with different geophone locations 

compared to Line 1.  

 

 

Next, select Geom | Geophone Interval and set the Geophone Interval to reflect the distance 

between active geophones in the applicable units. Although it is common practice to set the 
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geophone interval and units at the time of acquisition, this is not essential for MAM surveys 

because the full geometry (configuration and Array size) will be set in SeisImager/SW at the 

time of data processing.  

 

 Next, select Geom | Group/Shot Locations to set up the survey geometry: 
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Since there is no active-source at a single location, the Shot Coordinate is not applicable and 

should be set to zero.  

For most of the MAM array configurations that are 2D (L-shape, Triangle, Circle), you will 

likely be recording on fewer channels than the total number of channels in the seismograph. The 

unused channels should be deactivated. Deleting dead channels can be done in SeisImager/SW, 

but it is most efficient to deactivate them at the time of acquisition.  

To deactivate/activate channels, selection Acquisition | Specify channels. The same dialog box as 

above will appear. Uncheck the Ripple box and in the row named Use, use the “4” key and the 

right arrow key to individually deactivate the channels that have no geophone connected.  

Example 1A:  

For a 16-channel seismograph with a 30-foot interval spread cable, in an L11 array with 

geophones 30 feet apart, the channels on the end of the spread that are not connected to 

geophones are deactivated. This equals channels 1 through 5 if channel 11 is positioned at the 

corner of the L, or channels 12 through 16 if channel 6 is positioned at the corner of the L.  

End Example 1A. 
 

Example 1B:  

For a 24-channel seismograph with a 5-meter interval spread cable, in an L11 array with 

geophones 10 meters apart, with channel 12 positioned at the corner of the L, channels 1, 3, 5, 7, 

9, 11, 13, 15, 17, 19, 21, 23, and 24 are deactivated.  
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End Example 1B. 

The Geometry dialog box only shows linear configurations of geophones; you will not see a 

graphic of the actual 2D array. This is fine; as mentioned previously, the full geometry is set in 

SeisImager/SW at the time of data processing. The main setting here is deactivation of unused 

channels.  

Next, select Acquisition | Sample Interval/Record Length and set the acquisition timing 

parameters: 
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Next, make sure the acquisition filters are disabled by selecting Acquisition | Acquisition Filters 

and choosing FILTER OUT for each. 

 

Next, select Acquisition | Stack Options and set the Stack Limit to 1 since stacking is not 

applicable to MAM surveys.  
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Next, select Acquisition | Preamp Gains and make sure the gains are set to All High Gain.  

 

Next, select File | Storage Parameters and set the Next File Number. Since the survey line is 

called Line 2, set the Next File Number to 201. Leave Auto Save on and the Stack Limit set at 1. 

For the Path of saved data, enter the desired folder name.   
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This is the last essential dialog box in SCS for the MAM survey setup. 

 

3.2.2.2 AFTER SETUP – ACQUIRING, DISPLAYING, AND QUALITY CHECKING 

MAM DATA 

Once the setup is complete, you are ready to begin data acquisition. An example of the main SCS 

window is shown below. As discussed for 1D MASW surveys, perform the same system checks 

before starting acquisition. Check that the status bar on the bottom of the window shows an 

Armed condition (colored green).  
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Figure 11: Main SCS window. 

Once ready, trigger manually by pressing the “t” shortcut key or by selecting System | Manual 

Trigger.  

 

After triggering, wait for the record to be acquired and saved. Repeat at least 19 more times. 

Refer to the status bar to monitor the stage of acquisition. A record length of 32 seconds, times 

20 records, equals 640 seconds or about 10 minutes total.  
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A typical  passive-source record is shown below. You may need to adjust the display gains with 

Auto Scale Traces (“6” shortcut key).  

 

Figure 12: Typical  passive-source record. 

There will likely be some coherent noise events representing when cars have passed or such. 

Some isolated variation in amplitude usually does not significantly impact data quality. A steady 

level of signal without strong changes in amplitude throughout the record and from trace-to-trace 

is ideal.  

In addition to visual analysis, refer to Sections 4 (Page 54) and 5.3 (Page 212) on how to run 

more sophisticated checks of data quality.  
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3.3 2D MASW DATA ACQUISITION 

As with 1D MASW surveying, 2D MASW surveys use an active-source with a linear spread of 

geophones. Instead of one shot, however, numerous shots are taken at incrementing locations, 

and the geophone spread may not be fixed, depending on the total survey line length. (Remember 

here that 1D and 2D refer to the type of results, that is, VS curve or cross-section, respectively, 

not to the spread configuration.) Acquisition of numerous shot records allows SeisImager/SW to 

calculate a VS cross-section. 

Table 3 summarizes the parameters used for active-source 2D MASW surveys. The discussion 

on selecting geophone interval and spread length in Section 3.1 (Page 11) applies.  Passive-

source data may not be available, or if available, will only supplement a 1D VS curve, so the 

active-source energy level will have a larger bearing on the maximum possible depth of 

penetration.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Data Acquisition 
 

 

39 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

 

Parameter 
 

 

Setting 

 

Spread configuration 

 

 

Linear. 

 

 

 

Spread length 

About equal to two times depth of interest 

assuming that no passive data is available; about 

equal to depth of interest when supplementing 

with  passive-source data. 

 

Total number of geophones 

 

12 or more, minimum of 16 preferred. 

 

 

Geophone interval 

 

1.5 to 5 m or 5 to 20 ft; adjust according to 

number of channels available and to suit required 

spread length. 

 

 

 

Geophone type 

4.5 Hz vertical geophones, with base plates for 

surveys on paved ground; optionally configured 

in a land streamer for a towed spread. 

 

 

Parameter 

 

 

Setting 

 

Shot locations 

 

Depending on spread configuration, multiple in-

line locations at appropriate offset and interval. 

 

 

 

 

Shot near offset  

About 10% to 20% of spread length (applies to 

configurations where this parameter does not 

equal one-half the geophone interval, such as the 

roll-along end-on spread). 

 

 

 

Source equipment 

Sledgehammer (most common), 8 lbs (3.6 kgs), 

16 lbs (7.2 kg), 20 lbs (9 kg), scale hammer 

weight up with increase in spread length, and 

striker plate. 

 

 

 

Trigger 

Hammer switch taped to sledgehammer handle 

and connected to seismograph trigger port. 

 

Sample interval 

 

0.5 milliseconds. 

 

 

Record length 

1 to 2 seconds, long enough to capture the surface 

wave train. 

 

 As needed to improve data quality, wait for quiet 

times to shoot. 

 
Table 3: 2D MASW Acquisition Parameters. 
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3.3.1 2D MASW SURVEY GEOMETRY 

The basic linear geometry of MASW surveys is described in Section 3.1.1, Page 13. The linear 

spread is simple, but with the addition of numerous shots and possibly an incrementing geophone 

spread, the geometry of 2D MASW surveys is more involved. To illustrate the 2D MASW 

geometries, the following sections use more sophisticated plots generated by Pickwin. The 

figures are based on 24-channel examples. Table 4 explains the symbols used in the Pickwin 

geometry plots shown in this section. 

 

Circle/Dot Color 

 

Meaning 

 

Teal blue  

 

Shot point. 

 

Yellow  

 

Receiver for which a trace (waveform) has 

been read. 

 

Black  

 

Grid point (no meaning in actual geometry). 

 

Table 4: Selected 2D MASW Geometry Plot Attributes. 

The geometries used in 2D MASW surveying, especially the roll-along end-on spread 

configuration, may look familiar, as they are adopted from reflection seismology. 

SeisImager/SW also utilizes the reflection concept of the mid-point, which is the point midway 

between a source-receiver pair, and the common mid-point (CMP) gather, which is an assembly 

of traces that have the same mid-point. For any given spread configuration, SeisImager/SW 

cross-correlates every pair of traces in a shot record, gathers all correlated traces by CMP, then 

stacks those traces having equal spacing in the time domain (Hayashi and Suzuki, 2004). These 

additional steps advance the original MASW technique by effectively increasing the lateral 

resolution and accuracy of the final VS cross-section.  

In Figure 13, the top row (1) illustrates the distribution of CMPs for a shot record (1b) and a 

CMP gather (1c). Gathering by CMP (1c) and adding (stacking) focuses sampling and thus 

increases the signal-to-noise ratio and lateral resolution. The bottom row (2) illustrates how the 

CMP concept is applied to surface wave methods. Analysis by shot record (2b) for 1D MASW 

poses no resolution issues as 1D MASW provides a single VS curve averaged over the total 
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length of the spread. A series of 1D MASW VS curves could be used to construct a VS cross-

section but processing first by CMP (2c) increases lateral resolution and accuracy.  

 

 

Figure 13: The CMP concept applied to 2D MASW. 

Another issue, not necessarily a benefit but rather something to be aware of and account for if 

needed, is that the multiplicity of CMPs (the fold) tapers down toward the ends of the survey 

line. Note that the higher the fold, the higher the signal-to-noise ratio. The effect is that the 

lateral sampling decreases from the mid-point(s) of maximum fold to the ends of the survey line. 

Methods to account for this in survey design are discussed below.  

 

3.3.1.1 FIXED RECEIVER SPREAD CONFIGURATION 

The simplest configuration for 2D MASW surveys is the fixed receiver spread (Figure 14). The 

geophones are set up in a line at fixed locations and the shot is moved through the spread. The 

first shot is located off-end at a near offset of one-half the geophone interval. The shot is then 

advanced at an increment equal to the geophone interval so subsequent shots are located midway 

between geophones. As the Shot number increases, the shot location advances by one interval 

across the Survey distance.   
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Figure 14: 2D MASW fixed receiver spread configuration. 

The last shot is located off the opposite end by the same near offset of one-half the geophone 

interval.  

The Spread length (a) equals the survey line length over which there are active geophones. The 

survey depth is approximately a/4 to a/2. 

The fixed receiver spread is useful if the survey line length of interest is not very long, if the 

survey area is confined, or if there are limited channels or time/labor resources available. 

With a shot interval equal to the geophone interval, the fold will be highest at the center shot; 

that is, in between the two middle geophones, and will taper down on either side. The effect of 

tapering is to reduce the accuracy of analysis at depth. If full fold is desired for the entire survey 

line of interest, the continuous fixed receiver spread (Section 3.3.1.2) or the roll-along end-on 

spread (Section 3.3.1.3) should be used.  

 

3.3.1.2 CONTINUOUS FIXED RECEIVER SPREAD CONFIGURATION 

In many cases, one fixed receiver spread is not sufficient to cover the survey line length of 

interest. So, the fixed receiver spread can be used continuously, by taking a set of shots, moving 

the past receivers up-line, then resuming with another set of shots (Figure 15). First, Spread A is 

set up, then 12 shots (one end-shot and 11 inner-spread shots) are taken. Receivers from sub-

spread A1 are advanced up-line to become sub-spread B1. Shooting resumes for 12 more (inner-

spread) shots, then sub-spread A2 is advanced up-line to form sub-spread B2. There will be 24 

live channels for each shot. This process continues until the survey line length of interest has 
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been covered.  

 
 

Figure 15: 2D MASW continuous fixed receiver geometry. 

 

The Spread length (a) equals the survey line length over which there are active geophones. The 

survey depth is approximately a/2. 

 

The fold will be at full value when the number of shots from the start of the line equals half the 

number of active geophones per shot; full fold starts tapering down when the number of shots 

remaining to the end of the line equals half the number of active geophones per shot (again, if the 

shot interval equals the geophone interval). For the example in Figure 15, full fold will begin at 

shot 13 in between geophones 12 and 13 (between sub-spreads A1 and A2). It is best practice to 

leave space at the survey site so the locations of full fold can be positioned at the beginning and 

end of the survey line of interest. The fold tapering over 12 geophone intervals of 2 m equals 24 

m; where the survey line of interest equals x, then the total survey line equals 24 m + x + 24 m.  

This method of acquisition requires spread cables with the number of takeouts equal to one-half 

the seismograph channels. This allows for the first spread cable and associated geophones to be 
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picked up and advanced at the halfway point. For the example in Figure 15, with a 24-channel 

seismograph, you would need two 12-takeout cables. Furthermore, having a third spread cable 

and set of geophones would allow you to set up sub-spread B1 in advance and minimize 

downtime in between each set of shots. 

The continuous fixed receiver spread becomes tedious if your survey line is very long. An 

advancement in this method with increased efficiency is the roll-along end-on spread 

configuration.  

   

3.3.1.3 ROLL-ALONG END-ON SPREAD CONFIGURATION 

For long survey lines, the spread needs to be efficiently advanced by a more automated means 

compared to the continuous fixed receiver spread. There are three methods to achieve this using 

the roll-along end-on spread configuration.  

 

Method A: Software roll-along: most modern seismographs are capable of rolling an active 

spread of channels via software. The seismograph will require more channels than the actual 

number of live channels per shot, typically 50% to 100% more. For example, if 24 channels are 

the desired number of live channels, a 48-channel seismograph with 48 geophones is set up. 

Using software roll-along, the 24 live channels are rolled through the total of 48. For the first 

shot, channels 1-24 are active, for the second shot, channels 2-25 are active, etc. After the last 

shot with channels 25-48 active, the first half of the spread is picked up and moved up-line 

similar to the continuous fixed receiver spread. Note that software roll-along is not only for 

rolling an active spread; it is also used with the other methods to roll geometry coordinates.  

 

Method B: Land streamer: geophones are affixed to a “streamer” that makes gravity contact 

with the ground and is towed, typically by hand or an ATV or other vehicle. The streamer 

connects to a seismograph positioned on the vehicle, the number of geophones equals the 

number of recording channels, and all channels are kept active for each shot. The source is 

usually located in between the vehicle and the streamer or on the down-line end of the streamer, 

and its location is incremented together with the streamer after each shot.  

 

Method C: Mechanical roll box (also called roll-along switch): a separate box is connected 

between the spread cables and seismograph, interfaced with a set of input/output cables. The 

number of spread cable takeouts is larger than the number of seismograph channels, usually by 

100%. The roll box allows the seismograph channels to be advanced up-line by mechanical 

rotation of the connections between the channels and takeouts. For example, spread cables with a 

total of 48 takeouts are connected to a roll box with input of 48 channels and output of 24 

channels, which are transmitted to a 24-channel seismograph. For the first shot, channels 1-24 

are connected to takeouts 1-24 and takeouts 25-48 are disconnected. After the first shot, the 

channel connections are advanced by turning a dial on the roll box, which disconnects channel 1 

and connects channel 25. The source location is incremented together with the active spread.   

For all scenarios, the shot will usually have some near offset equal to about 10% to 

20% of the survey line length.  
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Figure 16 illustrates the roll-along end-on spread configuration with a fixed receiver spread 

configuration used at the end of the line.  

 

 

 

 

Figure 16: 2D MASW roll-along end-on geometry. 

The Spread length (a) equals the survey line length over which there are active geophones. The 

survey depth is approximately a/2. The fold value is determined the same as for the other spread 

configurations.  

 

3.3.2 2D MASW SURVEY DATA ACQUISITION WITH GEOMETRICS 

SEISMODULE CONTROLLER SOFTWARE 

The data acquisition setup for 2D MASW surveys involves the same dialog boxes used in the 1D 

MASW survey setup plus a few more for advanced geometry settings. This section assumes that 

you have already worked through the 1D MASW survey setup and only covers the dialog boxes 

that are new for 2D MASW surveying. Refer to Section 3.1.2, Page 13, for an introduction to the 



Data Acquisition 
 

 

46 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

1D MASW setup process and for more detail on the dialog boxes common to both survey setups.  

 

3.3.2.1 2D MASW SURVEY SCS SETUP 

The difference between the 1D and 2D MASW survey setups is the geometry. As mentioned 

previously, 2D MASW surveying involves numerous shots at incrementing locations, and the 

geophone spread may or may not be fixed. The geometry can be automatically updated and 

recorded to the file headers during acquisition, or it can be tracked and recorded separately by 

hand in observer’s notes and assigned in SeisImager/SW during data processing. It is also 

possible to manually update the geometry in the software after each shot, but this is not 

recommended as it usually slows production down.  

SCS can be set up to automatically increment just the shot coordinate, or both the shot and 

receiver coordinates, depending on the type of spread configuration used and if the SCS roll-

along function is available. If you have the SCS roll-along function and choose to record the 

geometry in the file headers during acquisition, continue with this section to set up SCS. If you 

do not have the SCS roll-along function and/or choose to assign the geometry in SeisImager/SW 

at the time of data processing, skip this section.  

Once Section 3.1.2.1 (beginning on Page 14) has been completed, the shot and receiver 

coordinates can be set up to automatically increment, depending on the configuration: fixed 

receiver spread, continuous fixed receiver spread, or roll-along end-on spread.  

For a fixed receiver spread configuration, the shot coordinate is set to automatically advance 

after each shot. First, check that the starting shot location is set off from the spread by one-half 

the geophone interval using the Geometry dialog box. Select Geom | Group/Shot Locations: 
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Example 1C:  

For a fixed receiver spread, with a geophone interval of 10 feet and first geophone coordinate of 

100 feet, the first shot is set at 95 feet: 
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End Example 1C. 

Next, set up rolling of the shot coordinate in the Roll Parameters dialog box. Select Geom | Roll 

Parameters. The Shot Roll Increment should equal 1 to advance the shot by one geophone 

Interval after the previous file is saved. With a starting shot coordinate that is off-end by one-half 

the geophone interval, a Shot Roll Increment of 1 will position the rest of the shots midway 

between the geophones. Check Enable Auto Roll Up/Right to advance the shot to the “right” or 

up-line. If your shot was on the right of the geophone spread, you would roll “left” or down-line. 

Press OK when done.  
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When the Shot Roll Increment is not equal to the Active Spread Roll Increment, a warning 

appears. Since the receiver spread is fixed in this case and should not roll with the shot; ignore 

the warning and press OK.  

 

Next, activate Auto Save as required with automatic rolling. Select File | Storage Parameters: 
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• For the continuous fixed receiver spread configuration, the shot coordinate will be set to 

automatically advance after each shot in the same way as for the fixed receiver spread. In 

addition, after the first half of the geophones are advanced up-line, the coordinates for the 

new locations occupied by geophones will need to be assigned through the Geometry dialog 

box.  

Example 1D:  

For a continuous fixed receiver spread, with a geophone interval of 10 feet and first geophone 

coordinate of 100 feet, the starting shot coordinate is set to 95 feet. The geophone coordinates are 

set to 100 feet for geophone 1, 210 feet for geophone 12, and 330 feet for geophone 24.  
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After the first half of the geophones are advanced up-line, the continuing coordinates are set to 

220 to 450 feet and the next starting shot coordinate to 215 feet. 
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End Example 1D. 

For a roll-along end-on spread configuration, the geometry setup will depend on the rolling 

method (Section 3.3.1.3, Page 44), using either software roll-along (Method A), a land streamer 

(Method B), or a mechanical roll box (Method C). 

To set up using Method A, a subset, usually one-quarter or one-half of the channels, are 

deactivated so that there is a uniform channel number per shot record. The active spread of 

geophones is rolled through the deactivated channels. The inactive spread is continuous in the 

beginning, but as the active spread advances up-line, there will be an increasing number of 

inactive channels down-line and a decreasing number of inactive channels up-line.  

Example 1E:  

For a roll-along end-on spread using Method A, with 48 total channels and 24 live channels for 

each shot, channels 25 through 48 are deactivated.  
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After pressing OK, the Geometry Tool bar in the main SCS window reflects the deactivation by 

greying out the symbols for geophones 25 through 48 (circled in red). 

 

Figure 17: Geometry tool bar. 

The Shot Roll Increment and Active Spread Increment are both set to 1, so that the shot 

coordinate and the active set of geophones are advanced by one interval after each shot. Enable 

Auto Roll Up/Right is checked to roll to the “right” or up-line. 
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End Example 1E. 

To set up using Method B and Method C, none of the channels would be deactivated via 

software, and both the shot and geophone coordinates would be advanced after each shot. For 

Method C with a mechanical roll box, the dial that sets the connections between channels and 

geophones also needs to be advanced in sync with the coordinates after each shot.  

For a complete explanation of the SCS roll-along function, please refer to the separate manual 

specific to your seismograph.  

 

3.3.2.2 AFTER SETUP – ACQUIRING, DISPLAYING, AND QUALITY CHECKING 

2D MASW DATA 
 

Once the setup is complete, you are ready to begin data acquisition. As discussed for 1D MASW 

surveys, perform the same system checks before starting acquisition, make the same adjustments 

to optimize the data display, and run the same data quality analyses.  

 

After you have collected the active-source records and are satisfied with the data, continue to the  

passive-source survey if applicable.  

4 DATA ANALYSIS USING THE WIZARD 
 

SeisImager/SW is capable of 1D and 2D MASW for active sources and MAM data analysis for  

passive sources. The 1D analysis outputs a VS curve and the 2D analysis outputs a VS cross-

section.  

 

Note: If you change units, you may have to change the limits of some of the axes in the phase 

velocity plots in WaveEQ – this is not automatic.  

 

Note: In general, it is best to confirm the units in Pickwin, WaveEQ, and GeoPlot and close all 

three modules prior to running the wizard. Neglecting to do this can lead to errors and cause the 



Data Analysis Using the Wizard 
 

 

55 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

program to become unstable. If this happens, the fix is to reset the modules to the factory 

defaults. See Note on Page 3. 

 

 

4.1 SURFACE WAVE ANALYSIS WIZARD 
 

As discussed in Sections 1 (Page 1) and 2 (Page 5), the Pickwin, WaveEq, and GeoPlot modules 

comprise SeisImager/SW and the Surface Wave Analysis Wizard automatically calls on 

functions from these three modules to walk you through the processing flows. There is a flow for 

processing 1D MASW active-source data (Section 4.1.1, Page 55), MAM  passive-source data 

(Section 4.1.2, Page 78) and 2D MASW active-source data (Section 4.1.3, Page 90).  

 

This section provides an explanation of the wizard’s operation, processing flows, and basic 

dialog box parameters. Please refer to Sections 5.3 (Page 212) and 7 (Page 320) for a complete 

description and explanation of menu items and dialog box parameters (including some of the 

items in the Advanced menu), and Appendix A (Page A-2) for an ordered list of the functions 

used in the wizard so the processing flows can be manually reproduced. 

 

The general processing flows as follows: 

 

 

Figure 18: Surface wave processing flow. 

  

The wizard is based on the Enter key. At any time, you can manually override the wizard by 

entering the menus. A complete 1D dataset is considered to consist of at least one active-source 

file and a set of  passive-source files, and a complete 2D dataset consists of a series of active-

source files (the total number will vary depending on the survey).  Passive-source results can also 

be integrated with 2D MASW datasets for deeper control. Integration of datasets is done 

manually outside of the wizard (Section 4.2, Page 156).  

 

4.1.1 ACTIVE-SOURCE 1D MASW WIZARD 
 

Double-click on the Surface Wave Analysis Wizard icon.  

 

 
 

The SeisImager/SW Analysis of Surface Waves dialog box appears. Select Active-source 1D 

MASW and press OK.  
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The Pickwin module will be launched.  
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The main Pickwin window appears. The wizard calls functions from the File and Surface Wave 

Analysis menus. Press the Enter key as instructed in the upper left-hand corner of the window to 

begin. 

 

 
 

The first step is to input the active-source data file. Highlight the file and press Open. (You may 

use the Enter key.) 

 

 
 

The waveform file is displayed.  
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Figure 19: Shot record. 

 

If the unit labels displayed are incorrect, open the Edit/Display menu and select Edit 

source/receiver locations.  
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The Geometry dialog box appears and the Units setting allows selection between meters and 

feet. The Units setting will affect the unit labels shown in the dialog boxes as well as update the 

Minimum phase velocity default value used for picking the dispersion curve, which is 35 m/s or 

150 ft/s. Once set (and Pickwin is closed), the assigned units will be recalled for subsequent uses 

of the wizard. (It is necessary to close Pickwin to register the new Units setting. At the end of 

the wizard, simply close Pickwin to register the new Units setting.)  

 

The Geometry dialog box also reports the source and receiver coordinates saved in the file 

header at the time of acquisition. If there are errors, correct them here by entering the correct 

values for Shot coordinate and Group interval. Press Set to apply the new Group interval and to 

recalculate the Geophone coordinates. Press OK when done.  
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In the waveform view, the settings can be modified to optimize the display. All these settings are 

in common with SeisImager/2D for refraction data processing; refer to the SeisImager/2D 

manual for a complete explanation.  

The main functions needed are the Waveform amplitude  buttons, the Horizontal scale 

 buttons, the Vertical scale  buttons, and the Normalize  button.  

 

When done, press the Enter key to continue.  
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Figure 20: Waveform view. 

 

Press Yes when ready to proceed.  
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Next, set the parameters for calculation of phase velocity. Set Phase Velocity End to suit the 

maximum velocity you expect for your site.    

 

The default value for Frequency End suits most cases. To see the extent of fundamental mode 

velocity on the high frequency end, a higher value can be entered. Press OK when done.  
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Next, set the parameters for picking the maximum amplitudes, which define the dispersion curve 

on the phase velocity-frequency plot. The Minimum Frequency default value is 5 Hz if 4.5 Hz 

geophones were used. If other geophones were used, their natural frequency can be entered, or 

use the default value to allow the software to attempt to pick amplitude maxima toward that end 

(any bad picks can be manually deleted later).  

 

The Maximum Frequency reflects the value entered in the previous dialog box. Press OK when 

done.  
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Once the calculations are complete, a phase velocity-frequency plot is displayed with the 

automatically determined maximum amplitudes, shown as red points:  

 

 
 

Figure 21: Phase velocity-frequency plot with picks. 

 

The default display settings for the phase velocity-frequency plot are Wiggle trace  Shaded 

black . Usually, the dispersion curve is more obvious in color contours. Select the Fine color 

contour  button to switch to a color plot and use the Waveform amplitude  buttons, the 

Horizontal scale  buttons, and the Vertical scale  buttons to optimize the display.   

 

If you need to manually make or edit picks, you can do so by clicking at the desired pick 

location. To help identify maxima, as you drag the mouse over the plot, the actual amplitude 

values can be read on the taskbar , where the value preceding the colon is the 

frequency and the value following is the amplitude. To restore the automatically determined 

picks, open the Surface wave analysis menu and select Pick phase velocity (1D). 
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Figure 22: Color phase velocity-frequency plot with picks. 

 

Save the dispersion curve picks if you would like to be able to input them again later. To do so, 

open the File menu and select Save pick file.  

 

 
 

Assign a file name with the extension .pvs and press Save.  
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Once the file is saved, press OK.  

 

 
 

After the file is saved, the dispersion curve is displayed with a pink line connecting the picks. 

Refer to Section 6.1.3, Page 216, on how to re-input saved picks. 

 

Press the Enter key to continue.  
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Figure 23: Phase velocity-frequency plot with picks connected by line. 

 

Press Yes when ready to proceed.  

 

 
 

 

You will be prompted for Rayleigh wave or Love wave. (The vast majority of surface wave work 

uses Rayleigh waves.) 
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Next, the WaveEq module launches, and the dispersion curve is displayed. Note that in WaveEq, 

Phase velocity is plotted on the vertical axis and Frequency is plotted on the horizontal axis. 

From this point on, the wizard calls functions from the Dispersion curves and MASW (1D) 

menus. 

 

 

Figure 24: Dispersion curve plot. 

 

If the plotting scales need adjustment, open the View menu and select Axis configuration.  

 

 
 

Enter the desired values for the X-axis and Y-axis Maximum scale and Interval. Press OK when 

done.  
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Next, edit the dispersion curve as needed. Commonly, there are noisy picks on the low and high 

frequency ends of the curve; a gate provides easy editing.  

 

Follow the instructions in the upper left-hand corner of the window. The red gate is the active 

gate. Use the right and left arrow keys to position the gate at the frequency up to which you want 

to delete. Press the Enter key to activate the right-hand side gate and position it the same way 

using the arrow keys. Press the Enter key when done, and the unwanted data will be deleted.  

 

 

Figure 25: Dispersion curve plot with gate. 

 

In addition to noisy picks on the ends of the curve, there may be outliers within the curve. 

Outliers can be deleted by pressing the Selection  button, selecting the outlying points on the 

curve, then pressing the Delete key. When done, press  again to disable the Selection button.  

 

If the curve has noisy jitter, it can be smoothed by opening the Dispersion curves menu and 

selecting Smoothing (individual curves). Upon selection, the curve will automatically be 

smoothed.  
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Figure 26: Smoothed dispersion curve. 

 

If necessary, use the right and left arrow keys to position the left-hand gate at the frequency 

below which you wish to delete data. Then press the Enter key to activate the right-hand gate and 

position it the same way using the arrow keys. 

  

When done, press the Enter key to continue.  

 

Press Yes when ready to proceed.  

 

 
 

Next, set up the initial model of VS with depth. The software default setting is to calculate the 

initial model from the one-third-wavelength approximation. For the Depth value, a good estimate 

to start with is one-half the spread length. The default value for the Number of layers is suitable 

for most cases. Press OK when done.  
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The initial model is displayed. Press the Enter key to continue.  

 

 

Figure 27: Initial velocity model. 

 

Press Yes when ready to proceed.  
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Next, set the number of iterations for the inversion. The software will iterate the number of times 

indicated to converge on the best fit of the modified initial model data with the observed data. 

The default value of 5 for Iteration is suitable for most cases (generally, no more than 10 

iterations are needed). Press OK when done. 

 

 
 

 

Once the inversion is complete, the final VS curve is displayed: 
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Figure 28: Final VS curve. 

 

Press the Show apparent velocity model  button to overlay the one-third-wavelength 

approximation (red points), which is the best indicator of the actual depth range of penetration. 

By default, the shade of the model changes to light grey, starting at the deepest apparent velocity, 

to call attention to the limits of the data. 

 

 

Figure 29: Final VS curve with apparent velocity overlay. 
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If there is good control to a depth of 30 m (100 ft), open the View menu and select Show AVS for 

IBC to calculate and display the average VS value.  

 

 
 

 
When done, press the Enter key to continue.  
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Press Yes when ready to proceed.  

 

 
 

Lastly, save the result. Assign a file name with the extension .rst and press Save.  
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After the file is saved, check the fit of the calculated and observed dispersion curves. Press the 

Show one dispersion curve  button to display the original dispersion curve. Press the 

Comparison  button to overlay the calculated dispersion curve (black line) and visually assess 

the degree of mismatch. The matching error between the two curves in units of time (ms) and as 

a percentage is also saved to a file called RMSE.txt in the dataset directory. The error should be 

less than about 5% but will vary depending on the dataset.  

 

If there is a high degree of mismatch, it is likely due to dispersion curve anomalies, such as sharp 

changes and/or outliers, or due to low quality, noisy picks on the low and high frequency ends of 

the curve. The mismatch will also be evident in the final VS curve, usually as an unrealistic 

velocity inversion or gradient. Although the mathematical inversion may be able to model these 

aspects of the dispersion curve, surface waves, by their physical nature, cannot resolve relatively 

abrupt or small-scale velocity anomalies. The dispersion curve should be double-checked and the 

process re-run to improve the match.  

 

 

Figure 30: Comparison between calculated (black) and observed (red) dispersion curves. 
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4.1.2  PASSIVE-SOURCE (MICROTREMOR) 1D MAM WIZARD 
 

The  passive-source 1D MAM Wizard process is essentially the same as for the Active-source 1D 

MASW Wizard (Section 4.1.1, Page 55), with additional steps for setting up the MAM survey 

geometry. This section assumes that you have already worked through the Active-source 1D 

MASW Wizard and are familiar with the steps and general functionality of the wizard. The new 

parts of the process are covered in detail, but Section 4.1.1 should be referred to for complete 

explanation of the common steps. The main difference between the two processing flows is the 

number of data files and how they are input.  

 

Double-click on the Surface Wave Analysis Wizard icon. Select  passive-source (Microtremor) 

1D MAM and press OK.  

 

 
 

The main Pickwin window appears. Press the Enter key to begin.  
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The first step is to input the dataset; all the data files are input at one time. Use the Shift key to 

highlight the first through last file in the dataset and press Open. 
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Once the selected files are open, press OK.  

 

The first in the group of waveform files is displayed. Set the units if necessary.  

 

 

Figure 31: MAM record. 

 

Unlike most active-source data, it is usually difficult to evaluate the quality of  passive-source 

data by viewing the shot record in the time domain. You can quickly transform the data into the 

frequency domain by pressing the Frequency domain  button. The view will change to a plot 

of the frequency content or spectrum for each trace.   

After pressing the Frequency domain button, press the right Horizontal scale  button or press 

the right arrow key a few times to expand the frequency scale. What is ideal is similar frequency 

content from trace-to-trace and dominant energy in the lower end of the frequency scale. The 

example spectrum plot shown in Figure 32 indicates high-quality passive-source data.  

To toggle back to the waveform view, press the Time domain  button.  

 

To scroll through the files, use the Show previous waveform  and Show next waveform  

buttons. 

When done, from the waveform view, press the Enter key to continue.  
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Figure 32: Example spectrum plot. 

 

Press Yes when ready to proceed.  

 

 
 

Next, set the array geometry for the SPAC calculation. Select which 2D array type was used and 

the Array size or select Linear array and enter the Receiver spacing and Number of receivers. 

This example is based on a Triangle 10 array with an Array size of 50 meters. Press OK when 

done.  
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The rest of the steps are identical to the Active-source 1D MASW Wizard. Proceed to calculate 

phase velocity and pick the dispersion curve.  

 

Set the Phase Velocity End to suit the maximum velocity you expect for your site.  passive-

source energy is generally traveling deeper and thus at higher velocities, so you will likely want 

to set a higher Phase Velocity End than what was used in the active-source wizard.  

 

The default value for Frequency End suits most cases. To see the extent of fundamental mode 

velocity on the high frequency end, a higher value can be entered. Press OK when done. 

 

 
 

The Minimum Frequency default value is 2 Hz. If 4.5 Hz geophones were used, energy below 4.5 

Hz may have been recorded, though dampened according to the characteristics of the geophone. 
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It is suggested to leave the default value of 2 Hz to allow the software to attempt to pick the 

amplitude maxima to this end (any bad picks can be manually edited later).  

 

 
 

Convert the phase velocity-frequency plot to fine color contours, adjust the gain, and check the 

automatically determined dispersion curve picks. Save the dispersion curve picks if desired.  
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Figure 33: Phase velocity-frequency plot with dispersion curve picks. 
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Once the dispersion curve is imported to WaveEq, edit the curve as necessary using the gates, the 

Selection button, and/or Smoothing (individual curves). 

 

 

Figure 34: Dispersion curve and gate for removing spurious or noisy picks at the ends of the curve. 

 

 

 

 

Figure 35: Trimmed and smoothed dispersion curve. 

 

Set the maximum depth for the initial VS model. A good Depth estimate to start with is the 

length of the array. Accept the default value or increase as desired for Iteration.  
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Figure 36: Initial VS model. 
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Once the inversion is complete, the final VS curve is displayed. For an indication of the actual 

depth range of penetration, press the Show apparent velocity model  button to overlay the 

one-third-wavelength approximation. If there is good control to a depth of 30 m (100 ft), open 

the View menu and select Show AVS for IBC to calculate and display the average VS value. 

 

 

 

Figure 37: VS curve with VR shown (red dots). 

 

Lastly, complete the wizard by saving the results and check the fit between the calculated and 

observed dispersion curves.  

 

Refer to Section 4.2, Page 156, on how to combine active- and  passive-source dispersion curves 

from a given site and obtain one high-resolution VS curve over the entire sampled depth range. 
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4.1.3 ACTIVE-SOURCE 2D MASW WIZARD 
 

The Active-source 2D MASW Wizard process is essentially the same as for the Active-source 1D 

MASW Wizard (Section 4.1.1, Page 55) and  passive-source 1D MAM Wizard (Section 4.1.2) 

with additional steps for setting up the 2D MASW survey geometry. This section provides a 

complete treatment of the 2D MASW wizard process covering Pickwin, WaveEq, and GeoPlot, 

so much of the detail will be familiar if you have already run the other processing flows. Note 

that GeoPlot is its own standalone module for general data visualization. In this manual, in 

Section 4.1.3.1 (Page 119), only the GeoPlot functions needed for viewing 2D MASW initial and 

final VS cross-sections are covered. See the GeoPlot manual for full documentation of GeoPlot. 

 

Double-click on the Surface Wave Analysis Wizard icon.  

 

 
 

The SeisImager/SW Analysis of Surface Waves dialog box appears. Select Active-source 2D 

MASW and press OK.  

 

 
 

The Pickwin module will be launched.  
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The main Pickwin window appears. The wizard calls functions from the File and Surface Wave 

Analysis menus. Press the Enter key as instructed in the upper left-hand corner of the window to 

begin. 

 

 
 

The first step is to input the dataset; all the data files are input at one time. This is done by 

making a new file list. Select Yes: make new file list.  
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Use the Shift key to highlight the first through last file in the dataset and press Open.  

 

 
 

Once the selected files are open, press OK.   

 

 
 

Next, indicate whether the source and receiver coordinates stored in the file headers should be 

used for the geometry. Explanation of the wizard assumes that the correct source and receiver 

coordinates were saved to the file headers; working on that assumption, check Source position 

and Receiver position to apply the header information to the geometry. Press OK when done.  
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A list of the files is presented in the File list dialog box. Note that if the coordinates from the 

header are to be applied, they will not be reflected here in the Source, 1st Receiver, and Receiver 

int. columns; the Apply source coordinates from file header and Apply receiver coordinates from 

file header boxes will be checked. (If coordinates need to be entered manually, press Set up to 

enter the pattern that describes the geometry. Refer to Page 223 for a full explanation of how to 

enter coordinates manually.) Press OK when done.  

 

 
 

Next, assign the file list a unique line name: 
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The first in the group of waveform files is displayed: 

 

 

Figure 38: Waveform plot, 2D active-source, fixed spread. 

 

Check the units. If the unit labels are incorrect, open the Edit/Display menu and select Edit 

source/receiver locations.  
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The Geometry dialog box will appear and the Units setting allows selection between meters and 

feet. The Units setting will affect the unit labels shown in the dialog boxes as well as update the 

minimum phase velocity default value, which is 35 m/s or 150 ft/s. Once set (and Pickwin is 

closed), the assigned units will be recalled for subsequent uses of the wizard.  

 

 

 

 
 

Note: Assigning the wrong units will cause errors in the calculations of dispersion curves, so it 

is important to make sure they are correct. 
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At the end of the Pickwin wizard (when WaveEQ opens), simply close Pickwin to register the 

new Units setting.  

 

In the waveform view, the settings can be modified to optimize the display. All these settings are 

common with SeisImager/2D for refraction data processing; refer to the SeisImager/2D manual  

for complete explanation. The main functions needed are the Waveform amplitude  

buttons, the Horizontal scale  buttons, the Vertical scale  buttons, and the 

Normalize  button.  

 

To scroll through the files, use the Show previous waveform  and Show next waveform  

buttons.  

 

When done, press the Enter key to continue.  

 

 

Figure 39: Waveform plot, 2D active-source, fixed spread. 

 

Press Yes when ready to proceed with calculation and assignment of the geometry. 
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Once the geometry calculation is complete, the file list with geometry assignments is saved as an 

.xml file named with the tag set earlier in the process. Press OK. This list can later be opened 

directly without having to reassign the geometry.  

 

 
 

A plot of the geometry will be displayed. Press the Enter key to continue.  

 

 

 

 

Figure 40: Geometry plot, 2D active-source, fixed spread. 

 

Press Yes when ready to proceed.  
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Next, calculate the CMP cross-correlation gathers. The First distance and Last distance are taken 

from the first and last coordinates of the geophone spread, and the Bin size is automatically 

calculated as two times the geophone interval. The default value for Bin size is recommended. 

The effect of increasing the Bin size is to reduce the resolution of the final VS cross-section.  

 

Check the Use variable spacing box if your source interval is not a constant – you will be 

prompted for the “minimum spacing difference” in percent. The meaning of this parameter is 

best illustrated by example: 

 

Assume your receiver spacing varies about a nominal spacing of 3 meters. If this parameter is set 

to 10%, then a spacing of 3.2 meters or 2.9 meters would be considered to be 3 meters. However, 

a spacing of 3.4 meters would be considered to be 3.4. 

 

In general, we recommend you use a constant source interval that is a multiple of the geophone 

interval. 
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If you check Show option menu, you will be prompted to supply a minimum and maximum 

offset:  

 

 
 

The most common Method used is the Cross-correlation average. The main difference between 

Cross-correlation average and Coherence average is that the former is a time domain 

calculation, and the latter is frequency domain. The outcome is essentially the same 98% of the 

time, and Cross-correlation average is the recommended method. 

 

Press OK when done. 
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Next, set the parameters for calculation of phase velocity for the CMP cross-correlation gathers. 

Set the Phase Velocity End to suit the maximum velocity you expect for your site.    

 

The default value for Frequency End will suit most cases. To see the extent of fundamental mode 

velocity on the high frequency end, a higher value can be entered. Press OK when done.  
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Next, set the parameters for picking the maximum amplitudes, which define the dispersion curve 

on the phase velocity-frequency plot. The Minimum Frequency default value is 5 Hz, if 4.5 Hz 

geophones were used. If other geophones were used, their natural frequency can be entered or 

use the default value to allow the software to attempt to pick amplitude maxima toward that end 

(any bad picks can be manually deleted later).  

 

The Maximum Frequency reflects the value entered in the previous dialog box. Press OK when 

done.  

 

Once calculation of phase velocity and picking of dispersion curves is complete, the picks are 

automatically saved as a .pvs file named with the applicable tag. Press OK. Refer to Section 

6.1.2, Page 215, on how to re-input saved picks.  
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The first in the group of CMP cross-correlation gathers is displayed. To scroll through the files, 

use the Show previous waveform  and Show next waveform  buttons.  

 

 

Figure 41: CMP cross-correlation gather. 

 

To display a file with a specific geometry, press the Geometry  button to toggle to the 

geometry view. The geometry of the waveform file currently displayed in the waveform view is 

highlighted in red.  
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Figure 42: Geometry plot. Trace locations of Figure 41 shown in red. 

Use the Show previous waveform  and Show next waveform  buttons to select the 

geometry of a waveform file to display.  

 

 

 

Figure 43: Paging through the geometry file.  

 

Toggle back by pressing the Waveform  button to display the selected file.  
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Figure 44: Pressing waveform button to display the file corresponding to red dots in Figure 43. 

 

Press the Enter key to continue.  

  

Press Yes when ready to proceed.  

 

 
 

Next, the WaveEq module launches, and the dispersion curves are displayed. From this point on, 

the wizard calls functions from the Dispersion curves and MASW (2D) menus.  
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Figure 45: Dispersion curves. 

 

If the plotting scales need adjustment, open the View menu and select Axis configuration.  

 

 
 

Enter the desired values for the X-axis and Y-axis Maximum scale and Interval. Press OK when 

done.  

 

 
 

Press the Enter key to continue.  

 

Next, there is a series of three dispersion curve editing functions to remove low quality, noisy, 

and higher mode picks that are typically present on dispersion curves and can skew or cause 
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instabilities in the inversion. The default settings for these functions are suitable for most cases. 

Any of the editing steps can be skipped by pressing No. Refer to Section 7.5, Page 433, for a 

complete explanation of the dispersion curve editing functions.  

 

Select Yes.  

 

 
 

The edited dispersion curves are displayed. Press the Enter key to continue.  

 

 

Figure 46: Filtered dispersion curve; low-quality, higher mode data removed. 

 

Press Yes when ready to proceed.  
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Select Yes.  

 

 
 

Follow the instructions in the upper left-hand corner of the window. The red gate is the active 

gate. Use the right and left arrow keys to position the gate at the frequency-phase velocity point 

up to which you want to delete. Press the Enter key to activate the right-hand side gate and 

position it the same way using the arrow keys. When done, press the Enter key to delete the 

picks outside of the gates.  

 

 

Figure 47: Editing the dispersion curves using gate. 

 

The edited dispersion curves are displayed. Press the Enter key to continue.  
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Figure 48: Trimmed dispersion curves. 

 

Press Yes when ready to proceed.  

 

 
 

Select Yes. 

 

 
 

The edited dispersion curves are displayed. 
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Figure 49: Smoothed dispersion curves. 

 

This is the last editing step. Press the Enter key to continue.  

 

Press Yes when ready to proceed.  

 

 
 

Next, set up the initial models of VS with depth. These individual curves are used to interpolate 

an initial cross-sectional model. The software default setting is to calculate the initial models 

from the one-third-wavelength approximations. For the Depth value, a good estimate to start 

with is one-half the spread length. The default value for the Number of layers is suitable for most 

cases. Press OK when done.  
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Once the initial cross-sectional model is calculated, the number of curves used in the model is 

reported. Press OK.  

 

 
 

The initial model file is automatically saved. Press OK. 

 



Data Analysis Using the Wizard 
 

 

111 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 
 

The first in the group of individual initial models is displayed.  

 

 

Figure 50: One of several initial velocity models. 

 

To control the velocity curve display, use the Velocity section 1  and Velocity section next 

 buttons to view one, or three curves at a time, respectively. With either setting, the Show 

previous  and Show next  buttons and the Home  and End  buttons allow you to 

move through displays. The Velocity section all  button displays all velocity curves.  
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Figure 51: Display of several initial velocity models. 

 

Press the Show apparent velocity model  button to overlay the one-third-wavelength 

approximation (red points), which is the best indicator of the actual depth range of penetration. 

By default, the shade of the model changes to light grey, starting at the deepest apparent velocity, 

to call attention to the limits of the data. 

 

 

Figure 52: Velocity model showing 1/3 wavelength approximation. 
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For the dispersion curves, the Dispersion curve 1  and Dispersion curve next  buttons, the 

Show previous  and Show next  buttons, the Home  and End  buttons, and the 

Dispersion curve all  button, function the same as described for the velocity curve display.  

 

 
 

 

 
 

Select No: show initial model to display the initial cross-sectional model in GeoPlot (to skip this 

step, select Yes: perform inversion).  

 

The GeoPlot module launches. Press OK. Refer to Section 4.1.3.1, Page 119, for an explanation 

of the GeoPlot functions used for viewing initial VS cross-sections.  
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Figure 53: Initial model. 

 

 

When done viewing the initial model in GeoPlot, press the Enter key to save the file and then 

return to WaveEq to run the inversion.  

 

In WaveEq, press the Enter key and press Yes when ready to proceed.  
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Select Yes: perform inversion.  

 

 
 

Set the number of iterations for the inversion. The software will iterate the number of times 

indicated to converge on the best fit of the modified initial model data with the observed data. 

The default value of 5 for Iteration is suitable for most cases. Press OK when done.  

 

 
 

Note that depending on the dataset size, the inversion can be computationally intensive and may 

take some time to complete. Also, the higher the Iteration value, the longer the process will take. 

In the Windows Task Manager, WaveEq may report as “Not Responding”, but if the memory 

usage is dynamically changing, this indicates the process is running properly. 

 

Once the inversion is completed, press OK.  
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Once the final cross-sectional model is calculated, the number of curves used in the model is 

reported. Press OK.  

 

 
 

The final model file is automatically saved. Press OK. 

 

 
 

The first in the group of individual final models is displayed.  
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Figure 54: Plot of several individual final models. 

 

Check the fit of the calculated and observed dispersion curves. Press the Show one dispersion 

curve  button to display one of the original dispersion curves. Then press the Comparison  

button to overlay the calculated dispersion curve (black line) and visually assess the degree of 

mismatch. The matching error between the two curves in units of time (ms) and as a percentage 

is saved to a file called RMSE.txt in the dataset directory. The error should be less than about 5% 

but will vary depending on the dataset. You can page through the various dispersion curve 

comparisons by using the  buttons. 

 

If there is a high degree of mismatch, it is likely due to dispersion curve anomalies such as sharp 

changes and/or outliers or due to low quality noisy picks on the low and high frequency ends of 

the curve. The mismatch will also be evident in the final VS curve, usually as an unrealistic 

velocity inversion or gradient. Although mathematical inversion may be able to model these 

aspects of the dispersion curve, surface waves, by their physical nature, cannot resolve relatively 

abrupt or small-scale velocity anomalies. The dispersion curves should be double-checked and 

the process re-run to improve the match. 
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Figure 55: Original (red) vs. calculated (black) dispersion curve. 

 

Press the Enter key to continue.  

 

Press Yes to proceed.  

 

 
 

The GeoPlot module launches again to display the final VS model. Press OK. Refer to the next 

Section (4.1.3.1) for an explanation of the GeoPlot functions used for viewing final VS cross-

sections.  
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Figure 56: Final Vs model. 

 

 

 

Refer to Section 4.2, Page 156, on how to combine active and  passive-source dispersion curves 

for a given site and maximize the depth range of the cross-section.  

 

4.1.3.1 THE GEOPLOT MODULE SURFACE WAVE ANALYSIS FUNCTIONS 
 

After the Surface Wave Analysis Wizard launches GeoPlot, the main GeoPlot window appears, 

and the subject model is displayed. The subject model may be an initial or final model. The 

model is outlined in red to indicate is it active for editing.  
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Figure 57: 2D velocity model. 

 

To optimize the display of the model, first select the Scale menu and select Fit in window to 

maximize the display area.  
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Press Yes to auto-scale the display.  

 

 
 

Use the Enlarge scale  and Reduce scale  buttons to further adjust the plot size.  
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Figure 58: Re-scaled 2D velocity model. 

 

 

If the axes need adjustment, open the View menu, and select Axis configuration.  
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Enter the desired values for the X-axis and Y-axis Min, Max, and Interval. The unit label fields 

reflect the units imported with the model from WaveEq. To make changes to the labels, enter the 

desired text in the Unit fields.  

 

 
 

When Show grid lines is checked, blue horizontal and vertical lines will be displayed at each tick 

mark. Checking Set Interval (and Max) automatically will allow the tick intervals to dynamically 
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increase when the scale is reduced to prevent the axis labels from overlapping; the Max values 

cannot be fixed in this mode. Reverse X-axis direction causes the horizontal scale to decrease to 

the right. Decimal places 0 (None) or 1 sets the number of significant digits for the axis tick 

interval values. When Depth (the default) is selected for the Vertical axis, the values are positive 

below zero; conversely, when Elevation is selected, the values are negative below zero. 

 

 
 

 

If you wish, you may indicate the approximate depth of penetration along the cross-section. 

Refer to Figure 52. Note that according to the 1/3 wavelength rule, penetration at that location 

(left end of section) is significantly less than is shown above in Figure 58. In general, penetration 

tends to be deepest near the center of the spread, tapering off toward the ends. This is because the 

frequency range toward the ends of the line is relatively narrow, limiting depth penetration.  
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Figure 59: All 11 VS profiles plotted side-by-side. 

 

Figure 59 shows each VS profile along the survey line. Note the tapering of max VR (max depth 

of red dots, marked by a transition from dark to light grey) toward the ends. Max VR is a measure 

of data “reliability” and is a good estimate of the depth of penetration. If we select View | 

Advanced options | Show reliability (this is toggle switch), we can see this reflected in the cross 

section: 
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Figure 60: S-wave velocity section with Show reliability enabled. Compare to Figure 59. 

 

 

The pale-colored zone is the “zone of unreliability”. The top of this zone represents the 

approximate depth of penetration based on the 1/3 wavelength approximation (max VR). 

 

If you wish, you may remove the unreliable data and only display the zone of reliability. To do 

so, select Edit | Advanced options | Delete unreliable data: 
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Figure 61: S-wave velocity section with unreliable data deleted. 

 

 

Next, if you wish, open the View menu and select Contour interval | Automatic | Linear scale to 

automatically adjust the contour interval.  
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Figure 62: 2D velocity model, coarse velocity contours. Red outline and red-circled number indicate that section is 

active and available for editing. 

 

 

Press the Fine color contour  button to increase the display resolution.  
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Figure 63: 2D velocity model, fine velocity contours. 
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Repeating Figure 59 for convenience, we can compare the series of 1D VS curves to the 2D 

velocity section: 

 

 

 

Figure 64: Comparison of 1D VS curves to S-wave velocity section with unreliable data deleted. 
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Adjusting the axes and rescaling, we get the following: 

 

 

Figure 65: Final S-wave velocity section. 

 

 

This would be a good time to save your velocity section. 

 

To save a custom contour file so that it can be applied again later, open the View menu, and 

select Contour | Save contour file.  
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Assign a file name and press Save.  
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Next, edit the title of the cross-section by opening the View menu and selecting Labels.  

 

 
 

Enter the desired text in the Title, Scale, and Units fields and press OK when done.  
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If you do not want to display the Title, open the View menu, select Labels to display, and 

uncheck Title.  

 

 
 

Now is a good time to save the GeoPlot file. If you are running the wizard, press the Enter key, 

and the file will be automatically named and saved with the extension .geo. Press OK and return 

to WaveEq to continue the wizard.  

 

To save the file manually, open the File menu and select Save GeoPlot file as.  
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At this point you may be asked if you wish to add latitude and longitude coordinates to your 

survey line: 

 

 
 

If you answer Yes, the following dialog will appear: 

 

 
 

Enter the coordinates and press OK. If you choose UTM coordinates, be sure to indicate the 

correct UTM Zone. 

 

Assign a file name with the extension .geo and press Save. 
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When you are done editing, open the Edit menu and choose Select section to edit | none to 

deactivate the cross-section and turn off the red outline. 
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Figure 66: Deactivated velocity section (red outline removed). 

 

To capture an image of the cross-section for report graphics, open the Edit menu, select Copy to 

clipboard, and then paste the image into the program of choice.  
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Copy to clipboard (option) allows you to select which features are included with the image 

capture.  

 

 
 

To output the cross-section data in text format for input into other data visualization programs, 

open the File menu and select Save (x, z, variable) formatted file (.txt).  
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Assign a file name with the extension .txt and press Save. You will be given the option to save 

gridded data: 

 

 
 

If you choose Yes, you will be presented with the following dialog box: 
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Enter the minima, maxima, and interval and whether you wish to apply interpolation. Press OK. 

The effect of interpolating is to smooth the VS model. To see the effect, try it both ways. 

 

 

 
 

 

The file has a space-delimited format with the x-value, z-value, and velocity at that z-value listed 

in rows.  
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Some other useful GeoPlot functions include the following:  

 

• opening and appending other cross-sections. 

• applying a saved contour file.  



Data Analysis Using the Wizard 
 

 

142 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

• displaying the contour interval values. 

• inverting and reversing the velocity scale.  

• applying settings from one cross-section to others. 

 

More than one cross-section may be displayed at one time: for example, the initial and final 

models for a given dataset. With one cross-section already open, open the File menu and select 

Open GeoPlot file to open and append another cross-section to the display.  

 

 
 

Select Append to present data and press OK.  
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Figure 67: Appending a velocity cross-section to display more than one at once. The circled number and red outline 

indicate which section is active now. 

 

To select between cross-sections, click on the cross-section number. When selected, the circle 

around the cross-section number and the cross-section outline turns red. When there is more than 

one cross-section displayed, open the View menu and choose Select section(s) to display should 

you wish to uncheck a cross-section to remove it from the display.  
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To change the vertical separation between the cross-sections, Open the View menu and select 

Vertical section spacing. 
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Enter the desired spacing and press OK.  

 

 
 

To apply a saved custom contour file to another cross-section, open the View menu and select 

Contour interval | Open contour file.  
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Highlight the contour file and press Open.  

 

 
 

To overlay the values of the contour intervals, open the View menu and select Contour interval 

values | Show values.  
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Figure 68: Displaying contour interval labels. 

 

If the font size of the contour interval values needs to be increased, open the View menu and 

select Contour interval values | Set up. 
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Increase or decrease the Font size as desired. The default Minimum separation at which the 

values appear suits most displays. If No fill is checked (the default), there will be no background 

behind the values.  
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Figure 69: Modifying contour interval labels to make them more visible by increasing font size. 

 

Uncheck No fill to turn on a white background: 

 

 

Figure 70: Modifying contour interval labels to make them more visible by adding a white background. 

 

The colors and contours used in the above section are “standard” surface wave colors. These can 

be changed if you like. A quick way to do so is to open the View menu and select Contour 

interval | Automatic | Linear scale. 
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Figure 71: Cross-section displayed with non-standard colors. 
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To invert the color gradient of the scale, open the View menu and select Invert scale.  

 

 
 

Note: This function does not work on standard surface wave contours and colors (Figure 69 and 

Figure 70). 
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Figure 72: Inverting the velocity color scale (compare to Figure 71: Cross-section displayed with non-standard 

colors.). 

 

To flip the direction of the scale so that it increases downwards, open the View menu, and select 

Reverse scale.  
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Figure 73: Reversing the polarity of the velocity scale bar (compare to Figure 72). 

 

To apply the settings for a given cross-section to the current display, open the Edit menu and 

select Apply settings to other sections.  

 

 
 

Check the Settings to be applied from the active Section No. to indicate which attributes should 

be applied to other cross-sections checked under Sections to be applied.  
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4.2 COMBINING ACTIVE AND  PASSIVE-SOURCE RESULTS 
 

Typically, MASW datasets will have higher frequency content and MAM datasets will have 

lower frequency content. Once the active- and  passive-source dispersion curves are picked for a 

given site, it is simple to combine the curves to obtain the highest resolution over the entire 

sampled depth range. This section assumes that you have already worked with the wizard and are 

familiar with the processing flow.  

 

4.2.1 COMBINING 1D MASW AND MAM RESULTS 
 

Double-click on the WaveEq icon: 

 

 
 

 

Open the dispersion curve result file for either the 1D MASW active- or MAM  passive-source 

dataset by opening the File menu and selecting Open 1D phase velocity curve or H/V spectrum 

file (.rst).  

 

 

 
 

For this example, the  passive-source result file is opened first. In general, it is best to input raw 

dispersion curves so that any smoothing is applied to the composite curve. Highlight the file and 

press Open.  
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Use the same File menu function to open the result file for the 1D MASW dataset.  

 
 

To combine the 1D MASW dispersion curve with the MAM curve, select Append to present 

data. Press OK when done. 

 

 
 

If you have more dispersion curves to append, say from additional active-source shots for the 

same spread, repeat these steps.  

 

The dispersion curves will typically have some overlap. If the curves are not aligned, double-

check the picks. Usually, the problem lies in noisy or spurious picks on the high frequency end 

of the  passive-source dispersion curve and/or the low frequency end of the active-source 

dispersion curve. 
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Figure 74: Combined 1D MASW and MAM dispersion curve. 

 

Open the File menu and select Save 1D phase velocity curve or H/V spectrum file (.rst) to save 

the combined results as a new file.  

 

 
 

Assign a file name with the extension .rst and press Save.  
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Edit the dispersion curve as needed and save the edited results as a new file if desired.  

 

 

Figure 75: Edited combined dispersion curve. 

 

Generate an initial model by opening the MASW (1D) menu and selecting Initial model.  

 

 
 

Set the maximum depth for the initial model.  
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Run the inversion by opening the MASW (1D) menu and selecting Inversion (LSM).  

 

 
 

Accept the default value or increase as desired for Iteration. 
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Once the inversion is complete, the final VS curve is displayed.  

 

 

Figure 76: Final VS curve. 

 

In the dispersion curve view, compare the observed and calculated dispersion curves.  

 

 

Figure 77: Observed vs. calculated dispersion curves. 
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Save the final result by opening the File menu and selecting Save 1D phase velocity curve file 

(.rst).  

 

4.2.2 COMBINING 2D MASW AND MAM RESULTS 
 

Double-click on the WaveEq icon.  

 

 
 

Open the dispersion curve result file for a 2D MASW dataset by opening the File menu and 

selecting Open 2D/3D phase velocity curve file (.pvs).  

 

 
 

In general, it is best to input raw dispersion curves so that any smoothing is applied to composite 

curves. Highlight the file and press Open.  
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The number of imported dispersion curves is shown. Press OK.  

 

 
 

The first in the group of dispersion curves is displayed.  

 

 

Figure 78: One of a group of raw, unedited 2D MASW dispersion curves. Note higher modes. 

 

Edit the dispersion curves as needed. 

 

Open the dispersion curve from the MAM dataset by opening the File menu and selecting Open 

1D phase velocity curve or H/V spectrum file (.rst). 

 

 
 

Highlight the file and press Open.  

 



Data Analysis Using the Wizard 
 

 

165 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 
 

Select Append to present data to combine the MAM dispersion curve with the 2D MASW 

dispersion curves. Press OK when done. 

 

 
 

 

If a velocity model is detected, it is recommended that you append it as well: 

 

 

 
 

 

 

Next, a prompt asks whether the MAM dispersion curve should be appended to only the 

currently displayed 2D MASW dispersion curve or to all the 2D MASW curves. The MAM 

dispersion curve should be appended to each MASW curve. If it is only appended to one MASW 

curve, it will create a velocity anomaly at depths with no adjacent data. Note that appending the 
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MAM dispersion curve to all MASW curves effectively extrapolates the MAM dispersion curve 

across the 2D MASW survey line. Considering that the horizontal resolution of MAM data is 

approximately equal to the sampled depth, extrapolating MAM results across a 75 or 100 m long 

2D MASW survey line is reasonable. However, as this is an extrapolation, it should be done with 

care and is not recommended where large variations in velocity are thought to exist. 

 

Press Yes to append the MAM dispersion curve to each of the 2D MASW dispersion curves.  

 

 
 

 

The first in the group of composite dispersion curves is displayed. The MAM and MASW 

dispersion curves will typically have some overlap. If so, you may see the following message:  

 

 
 

 

If the curves are not well-aligned, double-check the picks. Usually, the problem lies in noisy or 

spurious picks on the high frequency end of the  passive-source dispersion curve and/or the low 

frequency end of the active-source dispersion curve. If they are essentially aligned, the most 

common course of action is to take the average by answering Yes to the prompt above. 
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Figure 79: Combined 2D MASW and MAM dispersion curves. 

 

Open the File menu and select Save 2D/3D phase velocity curve file (.pvs) to save the combined 

results as a new file.  

 

 

 
 

Assign a file name with the extension .pvs and press Save.  
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Edit the dispersion curves as needed and save the edited results as a new file if desired.  

 

 

Figure 80: Edited and combined 2D MASW and MAM dispersion curves. 

 

Generate an initial model by opening the MASW/MAM (2D/3D) menu and selecting Initial 

model. 

 

 
 

Set the maximum depth for the initial model.  
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Run the inversion by opening the MASW/MAM (2D/3D) menu and selecting Inversion (2D/3D: 

All data).  

 

 
 

Accept the default value or increase as desired for Iteration. 
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Since you are working with a line of 1D VS models that can vary significantly, you will be 

prompted for a “regularization weight”: 

 

 
 

This sets the degree of “smoothness” of the resultant 2D section. In most cases, the default value 

of 0.5 will suffice. 

 

Note that depending on the dataset size, the inversion can be computationally intensive and may 

take some time to complete. Also, the higher the Iteration value, the longer the process will take. 

In the Windows Task Manager, WaveEq may report as “Not Responding”, but if the memory 

usage is dynamically changing, this indicates the process is running properly. 

 

Once the inversion is complete, the first in the group of individual final models is displayed. 
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Figure 81: First in the group of final VS models. 

 

Display the final cross-sectional model in GeoPlot by opening the MASW/MAM (2D/3D) menu 

and selecting Show 2D velocity model.  
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Figure 82: Final velocity cross-section. 

 

Save the final model display as a .geo file by opening the File menu and selecting Save GeoPlot 

File.  

 

 
 

Assign a file name with the extension .geo and press Save.  
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In the dispersion curve view, compare the observed and calculated dispersion curves.  

 

 

Figure 83: Observed and calculated dispersion curves. 

 

Save the final result by opening the File menu and selecting Save 2D phase velocity curve file 

(.pvs).  
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5 SEISIMAGER/SW- PRO: FEATURES AND CAPABILITIES 
 

SeisImager/SW-Pro adds  

 

1) The ability to invert H/V data for S-wave velocity (next sections). 

2) Include higher mode data in the analysis (Section 5.2, Page 192). 

3) Joint inversion of H/V and dispersion curve (Section 5.3, Page 212). 

 

These features are described below. 

 

 

5.1 INVERSION OF H/V 
 

In SeisImager/SW-Pro, an H/V curve can be used for inversion of S-wave velocity similar to 

using a dispersion curve. Currently, H/V curve processing is only available for one dimensional 

analysis. It should be noted that inversion of the H/V curve for VS is not as robust as inversion of 

dispersion curve data. So, it is difficult to obtain accurate S-wave velocity models from H/V data 

alone. However, prior information may be used to estimate an appropriate initial model and to 

increase inversion accuracy. H/V data can also be integrated with dispersion curve data to carry 

out a joint inversion. Integrating H/V data can increase the accuracy and penetration depth in the 

dispersion curve inversion. See Section 5.1.1, beginning on Page 174. 

 

5.1.1 H/V DATA ACQUISITION AND PROCESSING 
 

Continue. 

 

5.1.1.1 THEORY OF THE H/V SPECTRUM 
 

A three-component microtremor measurement at a single station has been widely used for 

estimating site characterization of earthquakes. The method has been referred to as the Nakamura 

method, HVSR (Horizontal Vertical Spectral Ratio) or simply H/V. In the SeisImager/SW 

application and this manual the word “H/V” is used for referring to the three-component 

microtremor measurement.  

 

Over the last few decades, the theory of H/V has been the subject of controversy. Conventional 

theory of H/V was that microtremors mainly consisted of body waves and a peak frequency of 

H/V corresponded to the resonant frequency of site. Based on this theory, the depth to bedrock 

(D2) is calculated from the peak frequency of H/V (f) as follows: 

 

�� � Vs� � � � 4 

 

 

Here, VS1 is the S-wave velocity of the first layer. 
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Recently, it is generally agreed that microtremors mainly consist of surface waves and the H/V 

corresponds to ellipticity of the Rayleigh waves. SeisImager/SW assumes the latter theory and 

has introduced an inversion of H/V in which observed H/V data is compared with theoretical 

ellipticity of Rayleigh waves. In a calculation of theoretical H/V, higher modes of Rayleigh and 

Love waves can be considered. The conventional and latest theories of H/V are comparatively 

illustrated in Figure 84. 

 

 

Figure 84: Conventional (top) and latest (bottom) theories of H/V. 

 

5.1.1.2 H/V DATA ACQUISITION 
 

 

A typical H/V Spectrum dataset is shown below: 
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Figure 85: Typical H/V dataset. 

 

An H/V analysis uses three-component ambient vibrations generated by cultural noise, traffic, 

factories, wind, wave motions, etc. The ideal vibration sources are steady and at a constant level. 

The fundamental assumption of the H/V analysis is that sources are located at an infinite 

distance, and seismic energy is stable and isotropic (coming from all directions). To best 

accommodate and approximate this assumption, the H/V analysis requires a long record length. 

The required record length depends on the depth of investigation. The greater the depth of 

investigation, the longer the required record length. Table 5 shows typical required record length 

versus depth of investigation.  

 

 

Depth of 

Investigation 

(m) 

Required 

Total 

Record 

Length 

(min) 

Sample 

Interval 

(ms) 

Number of 

Samples 

File 

Record 

Length 

(sec) 

Number of 

Files 

<5 5 2 16384 32 10 

2-30 10 4 16384 64 10 

30-100 20 8 16384 128 10 

100+ 30 8 16384 128 15 

Table 5: Typical required record length vs. depth of investigation. 

 

Depth of investigation relates to a frequency range of processing. Deeper investigation requires 

long-period geophones or seismometers. The required frequency range and sensor depending on 

the depth of investigation is shown in Table 6.  
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Maximum Depth of 

Investigation (m) 

Minimum Frequency 

(Hz) 

Sensor 

100 0.5  4.5Hz 

1000 0.2 1Hz or 2Hz 

> 1000 < 0.2 Long-period 

seismometer 

Table 6: Required frequency range and sensors based on desired depth of investigation. 

 

5.1.1.3 H/V DATA ANALYSIS  
 

This section provides a description of the H/V Spectrum Data Analysis Wizard and associated 

functions. The wizard automatically calls on specific functions from the Pickwin and WaveEq 

modules to walk you through the analysis process. The H/V wizard and associated functions are 

included in both the SeisImager/SW-1D and SeisImager/SW-2D packages.  

 

Some theory is touched on, but this manual is not meant to be a treatise on the H/V Spectrum 

(Nakamura) method. It is assumed that the user has a reasonable grasp of the main principles of 

seismology and mathematics to understand the principles behind the analysis techniques 

employed by the software. See Appendix F for a recommended reading list. 

 

5.1.1.4 H/V SPECTRUM DATA ANALYSIS WIZARD 
 

Double-click on the Surface Wave Analysis Wizard icon: 

 

 

 
The SeisImager/SW Analysis of Surface Waves dialog box appears. Select HVSR Analysis and 

press OK: 

 

 
 

The Pickwin module is launched: 
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The main Pickwin window appears. The wizard calls functions from the File and Surface Wave 

Analysis menus. Press the Enter key as instructed in the upper left-hand corner of the window to 

begin. 
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The first step is to input the dataset; all the dataset files are input at one time. Use the Shift key to 

highlight the first through last file in the dataset and press Open.  

 

 
 

 

Once the selected files are open, press OK.  

 

 
 

 

The first in the group of waveform files is displayed. In this example, a 24-channel seismograph 

was used, and the files contain 21 traces of system noise in addition to the traces from the two 

horizontal and one vertical geophone components. The noise traces will be deleted at a later 

stage of the wizard.  
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Figure 86: MAM waveform file. 

 

If the unit labels displayed are incorrect, open the Edit/Display menu and select Edit 

source/receiver locations: 
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The Geometry dialog box appears and the Units setting allows selection between meters and 

feet. The Units setting will affect the unit labels shown in the dialog boxes. Once set (and 

Pickwin is closed), the assigned units will be recalled for subsequent uses of the wizard. (It is 

necessary to close Pickwin to register the new Units setting. At the end of the wizard, simply 

close Pickwin to register the new Units setting.)  

 

The Geometry dialog box also reports the source and receiver coordinates saved in the file 

header at the time of acquisition. This is not applicable for H/V spectrum datasets. Press OK 

when done. 
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In the waveform view, the settings can be modified to optimize the display. All these settings are 

common with SeisImager/2D for refraction data processing; refer to the SeisImager/2D manual  

for complete explanation. The main functions needed are the Waveform amplitude  

buttons, the Horizontal scale  buttons, and the Vertical scale  buttons. When done, 

press the Enter key to continue.  
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Figure 87: MAM waveform file. 

 

Press Yes when ready to proceed. 

 

 
 

Next, the Fourier spectrum is calculated. To run this function outside of the wizard, select 

Surface wave analysis | Calculate Fourier spectrum: 
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Once the calculation is complete, the spectrum is displayed. Press the Enter key to continue.   

 

 

Figure 88: Frequency domain view of waveform view of Figure 87. 

 

Press Yes when ready to proceed. 
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If there are more than 3 traces, the following message will appear. In H/V analysis, only three 

traces (two horizontal components and one vertical component) are used. Unnecessary traces 

must be deleted as follows: 

 

 
 

Press OK and all traces will be selected (colored red).  
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Figure 89: Spectrum plot, all traces selected. 

 

Deselect (click on) the three traces you wish to keep (they will turn black). 

 

 

Figure 90: Spectrum plot, three traces selected. 
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Press the Delete key to delete the remaining red traces. Three traces will remain. 

 

 

 

Figure 91: Spectrum plot, all selected traces deleted. 

 

Press the Enter key to continue. Press Yes when ready to proceed.  

 

 
 

The H/V calculation dialog box appears. Set each component using the Up and Down buttons. 

The index of the channel number must start at 0 and it must be 0, 1 or 2 when three traces 

remain. Press OK when ready to proceed. 
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Once the Fourier spectrum is calculated in Pickwin, the spectrum is held in memory for import to 

WaveEq. WaveEq is used for detailed editing, analysis and making figures for the final report. 

WaveEq can be opened separately and can read in the text file that contains the 3-component 

spectrum data. But this single step is the easiest way to automatically launch WaveEq and import 

a spectrum just calculated in Pickwin. In this step, H/V is automatically calculated and shown in 

WaveEq. 

 

Below is an example of an H/V curve shown in WaveEq. The peak frequency of H/V is marked 

as an orange circle, and the value of the peak frequency is shown in the bottom left corner of the 

window: 
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Figure 92: H/V plot showing peak frequency. 

 

If the plotting scales need adjusment, select View | Axis configuration or press Ctrl+A. 

 

Enter the desired values for the X-axis and Y-axis Minimum, Maximum scales, and Interval. Both 

axes can be plotted in linear or log scale. Press OK when done. 

 

 
 

 



SeisImager/SW- Pro: Features and Capabilities 
 

 

190 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

Figure 93: H/V plotted with log scale. 

 

Next, edit the H/V curve as needed. In the H/V curve, lower frequency data contains information 

of deeper structure and higher frequency data contains information of shallower structure. Table 

7 summarizes the general guideline of frequency and depth of interest. 

 

 

Frequency (Hz) Depth of interest (meters) 

0.1 to 0.5 > 100 

0.5 to 2 20 to 100 

2 to 10 2 to 20 

> 10 < 2 

Table 7: Frequency vs. depth of interest. 

 

H/V data outside of the depth of interest is meaningless and it is better to remove it. Follow the 

instructions in the upper left-hand corner of the window.  
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Figure 94: Final H/V plot. 

 

Press Yes when ready to proceed. 

 

 
 

Lastly, save the result. Assign a file name with the extension .rst and press Save. 
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5.2 INVERSION USING HIGHER MODES 
 

Traditional analysis of surface wave data generally assumes that a dispersion curve mainly 

consists of a fundamental mode. Higher modes may dominate in several types of velocity 

structures, such as a model in which a high-velocity layer overlays a low-velocity layer or a 

model in which a high-velocity layer is embedded in low-velocity layers. To include higher 

modes in inversion, SeisImager/SW-Pro introduced several new algorithms, such as a Genetic 

Algorithm (GA) and inversion with variable layer thickness. Figure 95 below shows a phase 

velocity-frequency plot that includes higher modes. 

 

 

Figure 95: Fundamental mode (dots) along with higher modes. 
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SeisImager/SW (Pro only) allows users to include higher modes in the inversion and therefore to 

analyze complex velocity structures more accurately. Observed and theoretical phase velocity 

modes are not identified by SeisImager/SW-Pro analysis. 

 

In an active surface wave method, observed data is defined as the maximum amplitude phase 

velocity calculated at each frequency using the multi-channel analysis of surface waves (MASW) 

method (Park et al., 1999). In the passive surface wave method, observed data is defined as the 

phase velocity that yields the minimum error between observed coherence and the Bessel 

function calculated through the Spatial Autocorrelation (SPAC) method (Aki, 1957). Examples 

of phase velocity images for active and passive surface wave data are shown in Figure 96 below.

 

Figure 96: Examples of phase velocity images for active (top) and passive (bottom) surface wave data. 
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In calculation of higher mode phase velocities, both phase velocity and its relative amplitude 

(medium response) are calculated simultaneously. Theoretical phase velocity is defined in the 

following two ways. First, the phase velocity is defined as the velocity that has the maximum 

relative amplitude at each frequency. Secondly, the phase velocity is defined as the weighted 

average of all modes. The relative amplitude is used for calculating weighted average data. 

“Maximum” will correspond to phase velocities calculated with the first method, and “averaged” 

will refer to phase velocities calculated with the second method. In WaveEq, in the case of 

Rayleigh waves, maximum amplitude-calculated phase velocities are shown as light blue circles, 

and averaged phase velocities are shown as yellow circles. They are shown as blue and green, 

respectively, in the case of Love waves. Figure 98 shows an example of theoretical “maximum” 

and “averaged” phase velocities for the velocity model shown in Figure 97. See Hayashi (2012) 

for some examples of higher modes. 

 

 

Figure 97: Example velocity model. 
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Figure 98: Example of theoretical “maximum” (top) and “averaged” (bottom) phase velocities for the velocity 

model shown in Figure 97. Medium response curves shown in the top image correspond to the relative amplitude of 

the designated mode with respect to the fundamental mode. 

 

There is no established rule for how to calculate theoretical phase velocities including higher 

modes. In observed data, different modes can be isolated if the geophone array size is relatively 

bigger than the wavelength of interest. Generally speaking, active surface wave methods use 

relatively larger arrays in terms of wavelength of interest compared to passive methods. 

Therefore, we propose using “maximum” phase velocity for active method processing and 

“averaged” phase velocity for passive surface wave data. 
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Figure 99 shows theoretical phase velocity images for the velocity model shown in Figure 97. 

The top and bottom figures correspond to the dispersion curve calculated with Multichannel 

Analysis of Surface Waves (MASW) and the passive method (SPAC) respectively. The MASW 

data was acquired with a 96m linear array, and the SPAC data was acquired with a 10m 

triangular array. It is clear that MASW dispersion curves appear similar to “maximum” phase 

velocities and SPAC results are more similar to “averaged” phase velocities. Figure 100 shows 

an example of phase velocity change due to array size or geometry. In the example, synthetic 

data for the velocity model shown in Figure 97 is used. It is obvious that an increase in array size 

results in clear separation of different mode phase velocities. 

 

 

Figure 99: Theoretical phase velocity images for the velocity model shown in Figure 97. Top image corresponds to 

phase velocity curve derived from the active method (MASW) and bottom is that of passive method (SPAC). 
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Figure 100: Change of phase velocities calculated by MASW and SPAC due to array sizes or geometry. Synthetic 

data for the velocity model shown in Figure 97 is used in the calculation. 

 

Higher mode data is also important in the calculation of theoretical H/V. In SeisImager/SW, 

theoretical H/V is defined in two ways. The first definition of H/V corresponds to the Rayleigh 

wave fundamental mode, and the second method assumes Rayleigh and Love wave higher 

modes. In the higher order method, the ellipticity of the Rayleigh wave and medium response 
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(relative amplitude) of Rayleigh and Love waves are calculated for each mode. Horizontal and 

vertical amplitudes are calculated from the ellipticity and medium response values. Figure 101 

shows an example of theoretical H/V. The solid black line indicates an H/V of Rayleigh wave 

fundamental mode, and the yellow circles indicate Rayleigh and Love wave higher modes. 

 

 

Figure 101: Example of theoretical H/V for the velocity model shown in Figure 97. 

 

 

5.2.1 HOW TO HANDLE HIGHER MODES IN SEISIMAGER/SW 
 

Calculation of the fundamental and higher modes can be activated by selecting the  and  

buttons on the tool bar. Once the fundamental mode or higher mode button is activated, select the 

Calculate Theoretical Dispersion Curves button  and WaveEq calculates the designated mode. 

Note that the setting for the calculation of theoretical dispersion curves is applied to forward 

modeling the theoretical data used in inversion processing as well. The detailed setting of higher 

modes calculation can be changed under Options | Settings:  
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5.2.1.1 MAXIMUM AND AVERAGE VALUE 
 

As mentioned earlier, the theoretical phase velocity may be calculated under “averaged” or 

“maximum” dispersion curve assumptions. Activate Maximum value or Average value in the 

Settings sub-menu to switch methods. We recommend using Maximum value or Average value 

for MASW and SPAC respectively. 

 

5.2.1.2 SETUP (PHASE VELOCITY CALCULATION) 
 

Select Options | Settings | Setup (Phase velocity calculation) to change the settings for higher 

mode calculations of phase velocity. The following dialog box appears when the fundamental 

mode calculation is selected (press  on the tool bar). Note that the Number of modes is 

hardwired to one.  

 

When  is selected, the Number of modes is changeable and will be a larger number. Use 5 to 

20 for the number of modes. The computation time is proportional to the number of modes 

integrated. Calculating five to ten modes is suitable for most cases. Use 20 to 50 if the data 

includes significant higher modes that are due to a high-velocity thin layer underlying a low-

velocity layer. 
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5.2.1.3 INVERSION WITH CHANGING THICKNESS 
 

In SeisImager/SW, S-wave values are calculated while assuming a fixed number of layers and 

thicknesses. Inversion requires many layers, typically 10 to 20, and the flexibility of the 

inversion is somewhat restricted. In SeisImager/SW-Pro, the thickness of each layer can also be 

optimized in the inversion. Parameterizing layer thickness allows you to use a velocity model 

with a smaller number of layers, such as 2 to 5. You can choose an appropriate velocity model 

parameterization and inversion method depending on the data characteristics and purpose of 

investigation. Table 8 summarizes the suggested selection of model parameterization and 

inversion methods. 
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  Model Parameterization 

  Small layer number 

(<7 layers) 

Multi-layer model (>10 

layers) 

 

 

 

 

Data 

1D dispersion 

curve 

VS and thickness VS only 

1D H/V VS and thickness 

Thickness only 

VS only 

1D dispersion 

curve and H/V 

VS and thickness VS only 

2D dispersion 

curves 

VS only VS only 

Table 8: Suggested selection of unknowns in inversions depending on model parameterization. 

 

5.2.1.4 INVERSION USING GENETIC ALGORITHM 
 

 

As mentioned before, in complex velocity structures, higher modes may dominate in a particular 

frequency range and cause dispersion curves to look discontinuous. Higher modes can be 

represented as “maximum” and “averaged” phase velocities. As shown in Figure 99, “averaged” 

phase velocity is generally smooth and continuous while “maximum” phase velocity is 

discontinuous. SeisImager/SW uses a non-linear least squares method (LSM) for inversion and 

cannot handle discontinuous dispersion curves, such as those in “maximum” phase velocity 

curves, which may contain higher modes. It is generally difficult to separate the fundamental 

mode and the higher modes correctly, and traditional inversion methods based on the Jacobian 

matrix cannot be applied.  

 

To overcome these difficulties, SeisImager/SW-Pro introduced a new inversion method using a 

Genetic Algorithm (Yamanaka and Ishida, 1995). Genetic Algorithm (GA) 17 is a search method 

that mimics the process of natural evolution and is routinely used to generate useful solutions to 

optimization and search problems. The method is characterized as a global search method and 

can mitigate convergence upon local minima. One clear disadvantage of GA is that the method 

requires a large amount of forward modeling compared to the conventional iterative non-linear 

least squares method.  

 

Computation time of inversion generally increases as the amount of data increases, the number 

of layers increases, whether GA is used, and higher modes are included. Select the appropriate 

inversion method depending on character of data, model parameterization, and purpose of 

investigation. Summary of calculation methods of dispersion and H/V curves are shown in Table 

9. General guidelines for selection are summarized in Table 10. 
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Table 9: Calculation methods of dispersion and H/V curves. 

 

 

Table 10: Selection of inversion methods depending on model parameterization and higher modes. 

 

 

5.2.1.4.1 PARAMETERS FOR INVERSION USING GENETIC ALGORITHM 
 

The following dialog box appears when carrying out inversions using the Genetic Algorithm 

(GA). The GA is a random search in which many models are randomly created. The degree to 

which the final model fits the observed data depends on how many models were used in the 

inversion and several other factors. The total number of models calculated in the GA is equal to 

the number of “iterations” times the “population”. Computation time of the GA is directly 

proportional to the total number of models incorporated. Both the number of iterations and the 

number of populations can be between 20 and 100. Default values (50) are suitable for most 

cases. 
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5.2.1.4.2 CONSTRAINTS FOR INVERSION USING GENETIC ALGORITHM 
  

After the initial GA parameter setup, the following dialog appears: 
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A) Constraint 

 

Four different velocity models can be assumed. Typical dispersion curve and velocity models 

considered are summarized in the figures shown below. Note that the bottom layer (the deepest 

layer) must have the highest velocity in all models. 

 

A.1) No constraint 

 

The velocity of each layer can be of any value except that of the bottom layer. The inversion 

with no constraint tends to be unstable and it is advised to use this option with caution. 
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Figure 102: S-wave velocity model with no constraint. 

 

 

A.2) Setup allowed velocity reversal 

 

Define the total velocity reversal (inversion) against the maximum velocity in percent. The total 

velocity reversal (inversion) is the summation of the velocity decrease (a+b+c). The Allowed 

velocity reversal (P) is expressed by the following equation using the maximum velocity d. 

 

 
 

The Allowed velocity reversal (P) option allows a percentage of velocity inversion. Natural 

ground may have a slight velocity reversal, particularly in the shallow (shallower than 100 m) 

region. So, a default value of 20% of the Allowed velocity reversal is selected. S-wave velocity is 

generally increasing at greater depths, and it is recommended to use the Increasing with depth 

option if the investigation depth is greater than 100 m. 
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Figure 103: S-wave velocity model with allowed velocity inversion. 

 

 

A.3) Increasing with depth 

 

Velocity must increase with depth with this option. This option is suitable when the phase 

velocity smoothly increases as frequency decreases or if the depth of investigation is greater than 

100 m. 

 

 

Figure 104: S-wave velocity model having increasing velocity with depth. 
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A.4) Decreasing with depth 

 

Velocity must decrease with depth with this option except for the bottom layer. Use this option 

when phase velocity increases as frequency increases. S-wave velocity generally increases with 

depth in the natural ground, so phase velocity is usually inversely proportional to frequency. The 

dispersion curves and S-wave velocity structures associated with this option are quite unusual. S-

wave velocity values that decrease with depth are usually associated with artificial structures 

such as paved surfaces, embankments, soil modification, etc. 

 

 

 

Figure 105: S-wave velocity model having decreasing velocity with depth. All methods assume the bottom layer has 

the highest S-wave velocity. 

 

 

5.2.1.5 2D INVERSION INCLUDING HIGHER MODES USING GENETIC 

ALGORITHM 
 

The Genetic Algorithm is the recommended inversion procedure for incorporating higher mode 

data. As mentioned in Section 5.2.1.4 (Page 201), higher mode dispersion curves are 

discontinuous and may not be handled optimally by traditional inversion procedures. A Genetic 

Algorithm approach may handle discontinuous, higher mode data more optimally. Since the 

Genetic Algorithm is time consuming compared to the non-linear least squares method, 

SeisImager does not simply apply it to all dispersion curves. The Genetic Algorithm is only 

applied to one location – one dispersion curve and associated 1D model – out of all data along a 

survey line. Velocity models at other locations are modified with the calculation result of the 

Genetic Algorithm applied to one location. For this reason, it is better to call the inversion a 

“pseudo 2D inversion”. Figure 106 below shows the processing flow of a 2D inversion using the 

Genetic Algorithm. The inversion procedure is summarized as follows: At first, theoretical phase 

velocities are calculated for dispersion curves and associated 1D velocity models at all locations 

(Figure 107). Observed and theoretical phase velocities are compared and residuals (RMSE: 
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root-mean-square error) are calculated for all locations. A dispersion curve and an associated 1D 

velocity model that has the largest residual (RMSE) is selected. An inversion using the Genetic 

Algorithm is applied to the 1D model that has the largest residual. The Genetic Algorithm 

randomly generates many velocity models and calculates theoretical phase velocities for the 

models. All velocity models and associated theoretical phase velocities are stored in memory 

during the inversion (Figure 108). The result of the Genetic Algorithm for the 1D model that has 

the largest residual is used for that location. For other locations, memorized theoretical phase 

velocities are compared with each observed dispersion curve and a 1D model that yields 

minimum error is used for the model at each location (Figure 109). Refer to Section 5.2.1.4 on 

Page 201 for further details of inversion using Genetic Algorithm. 

 

 

Figure 106: Processing flow of a 2D inversion using Genetic Algorithm. 
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Figure 107: Selection of dispersion curve and velocity model for Genetic Algorithm in 2D. 

 

 

 

Figure 108: All velocity models and associated theoretical phase velocities are kept in memory during inversion 

using Genetic Algorithm. 
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Figure 109: Memorized theoretical phase velocities are compared with each observed dispersion curve and a 1D 

model that yields minimum error is used for the model at each location. 

 

5.2.1.6 HIGHER MODES OF LOVE WAVES 
 

The higher modes of Love waves can be calculated and used in inversions. Rayleigh and Love 

waves can be switched by buttons on the toolbar (  for Rayleigh waves and  for Love 

waves). In Figure 110, the fundamental mode of Love waves is shown as a blue line. For higher 

mode calculation, “maximum” and “averaged” modes are shown as blue and green respectively. 
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Figure 110: Display of theoretical dispersion curve for Love waves. 
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5.3 JOINT INVERSION OF DISPERSION CURVE AND H/V 
 

Phase velocity data and H/V data can be used in an inversion simultaneously to further constrain 

the model (Suzuki and Yamanaka, 2010). As mentioned before, it is difficult to obtain an 

accurate velocity model from H/V data alone. Dispersion curve inversion solutions are generally 

non-unique and may not always be accurate. Incorporating H/V and phase velocity data in a joint 

inversion scheme allows for the production of a more constrained final model and may also 

increase depth of investigation. Generally speaking, information contained in H/V data is limited 

compared to dispersion curve data. Therefore, if there are both phase velocity and H/V data, it is 

better to use phase velocity data to construct the S-wave velocity model, until data misfit is 

sufficiently low. Once the error between observed and theoretical phase velocities is deemed 

small enough, H/V data may be incorporated into the inversion process. The suggested 

processing flow is shown below (Figure 111). See Section 7.7.4.3 on Page 493 for an example of 

a joint inversion. 
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Figure 111: Suggested processing flow for joint inversion. 

 

 

6 THE PICKWIN MODULE SURFACE WAVE ANALYSIS FUNCTIONS 
 

Continue. 

 

6.1 FILE MENU 
 

The File menu functions essential or uniquely used for surface wave data processing are covered 

in this section. For a complete description of the File menu functions common to SeisImager/SW 

and SeisImager/2D, please refer to the separate SeisImager/2D manual. 
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6.1.1 OPEN WAVEFORM (SEG2) FILE [CTRL+O]  

 

 

 
 

 
 

 

To open a 1D MASW active-source data file in SEG-2 format, select Open Waveform (SEG2) 

file.  

 

Depending on the model of seismograph used to collect the data, the Files of type setting may 

need adjustment for SEG-2 formatted files. Geometrics seismographs use the file extension .dat 

and OYO seismographs use the extension .sg2.  

 

After setting the Files of type, highlight the file and press Open. 

 

See Section 6.1.1, Page 

214 

See Sections 6.1.2, 

6.1.3, and 6.1.4 

(starting on Page 215) 

See Section 

6.1.5, Page 219 
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6.1.2 OPEN SYNTHETIC WAVEFORM (.8HD) FILE 
 

 

 
 

 
 

 

To open a waveform file generated from a synthetic velocity model, select Open synthetic 

waveform (.8hd) file. Highlight the file and press Open.  
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6.1.3 OPEN PICK FILE 
 

 

 
 

 
 

To use this function properly you should start with a new instance of Pickwin, not one in which 

data has already been processed. Double-click on the Pickwin icon to start a new instance; you 

need not close any other open Pickwin windows beforehand.  

 

Open pick file is used to open a file of saved dispersion curve picks with the file extension .pvs. 

First the waveform file(s) from which the dispersion curve picks were derived should be opened 

by selecting the applicable Open <___> file function or the Open file list function. Next, select 

Open pick file. Adjust the Files of type setting to show Phase velocity data (*.pvs) types, 

highlight the file, and press Open. 
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The dispersion curve picks will not be visible until the phase velocity is recalculated. Refer to 

Section 6.2.2, Page 254, on how to calculate phase velocity.  

 

6.1.4 SAVE PICK FILE 
 

 

 
 

 
 

To save dispersion curve picks, select Save pick file. Assign a file name with the extension .pvs 

and press Save.  
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Confirmation that the file has been saved is displayed. Press OK.  

 

 
 

In the phase velocity-frequency plot view, the picks will be connected by a pink line.  
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Figure 112: Phase velocity-frequency plot. 

 

6.1.5 GROUP (FILE LIST) 
 

The functions included in Group (File List) allow processing of a range of records, as with a 

MAM or 2D MASW dataset.  
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6.1.5.1 MAKE FILE LIST 
 

 

 
 

 
 

 
 

A File list is an inventory of data files from any given survey, and includes essential information 

for each waveform trace, such as the associated field file identification number and source and 

receiver locations. For surveys where multiple files are processed together, such as MAM or 2D 

MASW, the dataset must be input by making a file list.  

 

To make a list of files, select Make File List. After setting the Files of type, highlight the set of 

data files to be opened by using the Shift key to select a range of files or the Control key to select 
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individual files. If All files is showing for the Files of type setting, take care not to inadvertently 

select non-data files as this will cause an analysis error.  

 

 
 

Confirmation that the files are input is displayed. Press OK.  

 

 
 

Next, you will be prompted to set up the geometry. For MAM datasets, the source locations are 

not applicable, and the geometry of the spread/array is set in a separate dialog box. Any 

coordinates saved in the file headers are not needed, so leave the boxes for Source position and 

Receiver position unchecked and press OK.  
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Next, the File list dialog box presents the data files listed by file ID. No action is needed for 

MAM datasets. Press OK to proceed to viewing the waveform files.  

 

 
 

For 2D MASW datasets, if the geometry was saved in the file headers during acquisition, check 

Source position and Receiver position to apply those coordinates and press OK.  

 

 
 

Next, the File list dialog box presents the data files listed by file ID. Even if Source position and 

Receiver position were checked in the previous dialog box, note that the actual values from the 

file headers will not yet be shown here in the Source, 1st Receiver, and Receiver int. columns. 

Checking Source position and Receiver position in the previous dialog box activates the Apply 

source coordinates from file header and Apply receiver coordinates from file header options in 

this dialog box. If those options are checked, the coordinates from the file headers will be 

applied.  
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If coordinates are to be imported from the file headers, confirm that Apply source coordinates 

from file header and Apply receiver coordinates from file header are checked. Press OK to 

proceed to viewing the waveform files.  

 

If coordinates are not to be imported from the file headers, coordinate values can be entered here 

in the Source, 1st Receiver, and Receiver int. columns individually or by setting up and applying 

a geometry pattern via the Set up button. The default setup parameters are as shown below.  

 

 
 

1st Source is the location of the first shot. The Source interval is the spacing between each shot.  

 

For a dataset collected with a rolling spread, that is, the geophone locations were not fixed, check 

the Variable receiver option. The Offset from source to 1st receiver is the distance from the shot 

to the nearest live geophone (the near offset). It is assumed that the line has been shot from 
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lowest to highest channel number, indicated by a positive number for the Source interval. If the 

data was shot toward the lowest channel number, the Source Interval should have a negative 

number to indicate that the source rolled in this direction. This case can occur when using a 

Geometrics seismograph where the channel nearest the seismograph (and PC controller) is the 

highest by default, and the first shot was located at this end of the line.  

 

For a dataset acquired with a fixed receiver spread, where the shot was moved through the 

spread, check the Fixed Receiver option. The First receiver position is the location of the first 

live geophone.  

 

The Receiver interval is the spacing between geophones. 

 

Example 2A: Set up a Fixed receiver geometry for the sample 2D MASW dataset with no file 

header coordinates. The dataset consists of 97 shots with the first and last shots off-end at 0.5 m 

near offsets, 24 geophones located at 0 to 23 m, and equal source and receiver intervals of 1 m. 

 

Starting at the geometry prompt, Source position and Receiver position are left unchecked.  

 

 
 

The File list dialog box shows the file IDs, but only default values for the Source, 1st Receiver, 

and Receiver int. columns. Also, Apply source coordinates from file header and Apply receiver 

coordinates from file header are unchecked.  

 

 
 

Through the Set up dialog box, enter and apply the applicable geometry values.  
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The File list dialog box now reflects the geometry pattern.  

 

 
 

End Example 2A. 
 

Example 2B: Set up a Variable receiver geometry for a sample 2D MASW dataset with no file 

header coordinates. The dataset consists of 25 shots with a near offset of 4 m, 24 geophones 

located at 0 to 46 m, and equal source and receiver intervals of 2 m. 

 

Starting at the geometry prompt, Source position and Receiver position are left unchecked.  
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The File list dialog box shows the file IDs, but only default values for the Source, 1st Receiver, 

and Receiver int. columns. Also, Apply source coordinates from file header and Apply receiver 

coordinates from file header are unchecked. 

 

 
 

Enter and apply the applicable geometry values in the following dialog box:  
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The File list dialog box now reflects the geometry pattern.  

 

 
 

End Example 2B. 

Additional functions in the File list dialog box include the Next and Back buttons, which allow 

scrolling through the next, or last, ten file IDs, respectively. For users of OYO seismographs, an 

auxiliary channel is automatically recorded; the number of the auxiliary channels can be 

indicated by pressing on the Set # of Aux. button. If any file needs to be deleted from a list, check 

the Edit box next to that file ID and press the Delete button.  

 

Once the geometry assignment in the File list dialog box is complete, press OK to save the 

changes and proceed to viewing the waveform files.  

 

To view the assigned geometry again, the File list dialog box can be directly accessed at any 

time through the Show File List function.   

 

6.1.5.2 MAKE FILE LIST (SELECT A FOLDER) 
 

 
 

 
 

 
 

This feature is identical to Make File List above, except that in this case, all you must do is 

choose the folder that the seismic waveform files are in. You do not need to choose the files – all 

the waveform files in the folder will be read in. This is convenient when you have a large 

number of waveform files in a folder. 
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6.1.5.3 OPEN FILE LIST 
 

 
 

 
 

 
 

 

 

To open an existing file list that was previously saved in a .txt or .xml format, select Open File 

List. Highlight the file list and press Open.  

 

 
 

The waveform files with assigned geometry are displayed.  
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Figure 113: Waveform display. 

 

6.1.5.4 SAVE FILE LIST (TEXT) 
 

 

 
 

 
 

 
 

Once a file list has been generated, it can be saved as a text file by selecting Save file list (text). 

File lists should always be saved in the dataset directory.  

 

Assign a file name with the extension .txt and press Save.  
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The file is formatted in space-delimited columns by file ID, shot location, geophone location, 

receiver interval, and auxiliary channel number.  
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6.1.5.5 SAVE FILE LIST (XML) 
 

 

 
 

 
 

 
 

Once a file list has been generated, it can be saved as an .xml file by selecting Save file list (xml). 

File lists should always be saved in the dataset directory. The XML format and the dataset 

directory are the default format and file location used by the 2D MASW wizard.  

 

Assign a file name with the extension .xml and press Save.  

 

 
 

The file is formatted in XML with general line information at the top followed by the shot 

location, geophone location, receiver interval, and auxiliary channel number for each file ID. 
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6.1.5.6 SHOW FILE LIST [CTRL+G] 
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To open the File list dialog box, select Show file list. The File list dialog box is displayed and 

reflects the current geometry assignment for the subject dataset.  

 

 
 

6.1.5.7 SET UP GEOMETRY 
 

 

 
 

 
 

 
 

In SeisImager/SW, the 2D MASW process requires calculation of CMP locations (refer to 

Section 3.3.1, Page 40, for explanation) before the dispersion calculation. The 2D MASW file 

list with source and receiver locations is used to find the CMP locations.  

 

To calculate CMP locations for a 2D MASW file list, select Set up geometry. First, the number 

and location of CMPs are calculated using the source and receiver coordinates. A report of the 

number of sources and receivers detected in the file list and the number of CMPs calculated from 

the source and receiver coordinates is displayed. Press OK.  
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Next, the total number of waveform traces and the maximum range of the survey geometry are 

calculated and reported. Press OK. 

 

 
 

Up to this point, the waveforms have been handled as an assembly of traces as opposed to 

individual traces. Obviously, at the time of acquisition, traces are assembled in a shot record (or 

“shot gather”) by common shot location. At this point, the waveform for each trace will be 

individually assigned a CMP coordinate so that at a later step the traces can be assembled into 

CMP cross-correlation gathers by CMP location. If no errors were detected in the previous 

calculations, press OK to Input waveform data.  

 

 
 

The number of traces assigned a CMP coordinate is reported and should equal the Total number 

of shot gather traces reported previously. Press OK.  
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Once complete, a plot of the source-receiver geometry is displayed.  

 

 

Figure 114: Source-receiver geometry. 

 

Table 11 summarizes all the attributes used in geometry plots. The horizontal axis –  Distance – 

is the distance along the survey line. The vertical axis – Shot No. – is the number of the shot as 

the data was sequentially collected. 
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Circle/Dot Color 

 

Meaning 

 

 

Teal blue 

 

Shot point. 

 

 

Yellow  

 

Receiver for which a trace has been read. 

 

 

Dark blue 

 

Receiver for which no trace has been read. 

 

Red  

 

Receiver for which traces are selected and 

can be viewed in the waveform display.  

 

 

Black  

 

Grid point (no meaning in actual geometry). 

 
 

Table 11: 2D MASW Geometry Plot Attributes. 

 

The Show previous waveform  and Show next waveform  buttons can be used in the 

geometry view to select a waveform shot record to display; these buttons can also be used to 

scroll through waveform files in the waveform view. Press the Waveform  and Geometry  

buttons to toggle between the views.  

 

If there is an error and no waveform data is input, the geometry plot will appear with a dark blue 

circle for each receiver missing a waveform trace. If an input error occurs, double check that all 

the dataset files are in one directory and that the geometry assignment is correct; then start over 

with the Set up geometry process.  
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Figure 115: Source-receiver geometry. Blue circles indicate missing traces for those points. 

 

 

6.1.5.7.1 VERTICAL STACK 
 

 
 

 
 

 
 

 
 

Vertical stacking is most employed after MASW data acquisition using Atom or McSeis-MT 

Neo acquisition units, both of which record continuously. Vertical stacking is part of a process 

leading up to MASW inversion. The general process is as follows: 

 

1. Detect events in Atom files (SPACPlus). 

 

2. Cut out shot gathers and save them as SEG-2 files (SPACPlus). The files are saved as a file 

list. 

 

3. Use the file list created by SPACPlus or create a file list of the SEG-2 files in Pickwin. 

 

4. Stack the shot gathers in Pickwin.  

 

5. Set up acquisition geometry. 
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6. Process as usual (Section 4, Page 54). 

To stack the data, you must first assign source indices to the shot gathers. Each set of shot 

records to be stacked must have the same source index: 

 

 

 

Figure 116: Setting up source indices prior to vertical stacking. 

 

Once the source indices have been updated, simply select File | Group (File List) | Edit | Vertical 

stack. The records will be stacked and displayed, and the path and file name of the stacked 

record will be displayed beneath the waveform display. 

 

6.1.5.7.2 IMPORT CTB RECEIVER POSITION FILE 
 

 

 
 

 
 

 
 

 
 

 

As mentioned above, Atom and McSeis MT Neo seismographs record continuously. Each 

seismic sample is tagged with a GPS-referenced UTC time. In the process of setting up a survey 

using these single- or three-channel modules, the modules are powered up asynchronously, with 

some beginning data recording earlier than others. Once all modules are up and recording, actual 
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data acquisition may start. This means that much of the data on each module is garbage, and to 

varying degrees from module to module. 

 

This is much different from the conventional method using a seismograph like a Geode, where 

all the channels begin recording simultaneously and are often referenced to a source trigger. 

 

Before Atom or McSeis MT Neo data can be processed, it must be pre-processed and saved to a 

conventional SEG-2 format, as if it were acquired using a Geode or other conventional 

seismograph. 

 

SPACPlus reads raw Atom or McSeis MT Neo files. It then automatically examines the data 

from all the modules and divides it into “common time blocks”. In a typical MASW survey, 

there are three common time blocks: one for the “huddle test” (see the Atom/SPACPlus manual), 

one for active data, and one for passive data. These common time blocks can then be saved in 

SEG-2 format for MASW processing using SeisImager/SW and WaveEQ. 

 

 

6.1.5.8 ATOM/MCSEIS-MT(NEO) 
 

 
 

 
 

 
 

 

Continue. 

 

6.1.5.8.1 OPEN ATOM/MCSEIS (NEO) FILES AND MAKE FILE LIST 
 

 
 

 
 

 
 

 
 

Note: This feature is included here for convenience, but it is recommended that you use 

SPACPlus to pre-process the data into “common time blocks” and save them to SEG-2 files. 

SPACPlus provides useful tools, including tools to remove noise events from passive data, such 

as passing vehicles. Those tools are not available here (see the SPACPlus manual).  
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This feature opens a group of raw Atom or McSeis MT Neo files and creates a file list, which is 

automatically saved as a series of SEG-2 files.  

 

Select the folder containing the files. You will be presented with the following screen: 

 

 

 
 

Choose which seismograph’s data you wish to read (generally, you will want to read all of them 

at once; this is the default). Next, indicate which component to read. Most often, you will be 

working with single-channel units, in which case the single component detected will be assumed 

to be Z (vertical). 

 

In the process of creating the group file, you may choose to save all the Atom/McSeis data to 

ASCII waveform files – simply check the box. 

 

Pressing OK will reveal the following: 
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This indicates that three blocks of data have been detected – each seismograph was turned on and 

off three times. Each is designated by the date and UTC time at the beginning of the time block. 

In this case, we will begin with the first data block. Press OK, and you will be given the 

opportunity to edit the start time: 

 

 
 

Press OK again, and the following geometry display will be presented.  
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Surface wave files, particularly those for passive data, tend to be very long (and large). It is 

usually desirable to divide each trace up into a series of shorter traces to make them more 

manageable. Before doing so, you are given the opportunity to apply a 0.1 Hz low-cut filter to 

the data: 

 

 
 

In general, a filter is not necessary, and unless you have a strong DC component, you should 

press No here.  

 

The next dialog box allows you to enable/disable “block dividing” and to set the length of each 

“sub” trace. In general, it is desirable to work with traces of 16k or 32k samples (or less); at the 

standard passive data sample interval of 4 msec, this works out to 1 or 2 minutes. 

 

Select a trace length and press OK. 
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Next, you will be asked if you wish to read the source and receiver positions from the file header. 

Do not check the boxes; this information will be incorporated prior to the spatial autocorrelation.  

 

 
 

Press OK. 

 

You will now be presented with the file list. Indicate whether the data is passive or active and 

press OK.  
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The first block of data for each trace will be displayed. In this case, there are 10 Atoms of one 

channel each, and 37 time blocks. You may scroll through the time blocks using the  

buttons. Each time block has already been saved as a SEG-2 file; the path is displayed below the 

trace display. 

 

 

Figure 117: Waveform display from Atom or McSeis. 

  

You may now process as usual. See Step 3 on Page A-5. 

 



The Pickwin Module Surface Wave Analysis Functions 
 

 

245 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

6.1.5.8.2 LAUNCH MT-NEO CONTROLLER 
 

 

 
 

 
 

 
 

 
 

Pickwin can be used as a data acquisition controller for the McSeis MT Neo seismograph from 

OYO Corporation. This feature launches that controller. 

 

6.1.5.9 APPEND FILES (SELECT FILES < 50 FILES) 
 

 
 

 
 

 
 

This feature opens a file-read dialog box and allows you to choose up to 49 SEG-2 files to 

append together. 

 

6.1.5.10 APPEND FILES (SELECT A FOLDER) 
 

 

 
 

 
 

 
 

This feature appends together all the files in the selected folder. It is useful when you have a 

large number of files to append together. 
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6.1.5.11 NEGLECT RECEIVER LOCATION IN TRACE HEADER  
 

 

 
 

 
 

 
 

If you did not record the correct receiver locations in the trace headers while in the field, you can 

choose to ignore the trace headers by choosing this option. 

 

6.1.5.12 OPEN TEXT DATA FILE (MULTI-COLUMN DATA WITH HEADER) 
 

 

 
 

 
 

 
 

Select this option to open a previously saved waveform file that you have saved in ASCII text 

format (see Section 6.1.5.14 below). 
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6.1.5.13 OPEN TEXT DATA FILE (MULTI-COLUMN DATA WITH SETTING 

OPTIONS) 
 

 
 

 
 

 
 

Select this option to open a previously saved waveform file that you have saved in ASCII text 

format (see Section 6.1.5.14 below). In this case, you will be prompted for the following 

parameters: 
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6.1.5.14 SAVE TEXT DATA FILE (MULTI-COLUMN) 
 

 

 
 

 
 

 
 

You may save any waveform file as an ASCII text file. Simply read in the waveform file and 

select Save text data file (multi-column). You will be prompted for a file name. 

 

6.1.5.15 SEGY OPTIONS 
 

 
 

 
 

 
 

Selecting this item will reveal the following dialog: 
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Choose the appropriate header locations for the receiver distances or coordinates. If they were 

not recorded in the field, select None. 

 

 

6.1.6 RECENT FILES 

 

 

The last four files opened in Pickwin will be displayed in the File menu. To open any of these 

files, just click on the file. 
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6.1.7 EXIT 

 

 

To exit the Pickwin module, choose Exit. You will see the following dialog box: 

 

Press OK to exit Pickwin or press Cancel to continue using Pickwin. 
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6.2 EDIT/DISPLAY MENU 
 

The single Edit/Display menu function essential or uniquely used for surface wave data 

processing is covered in this section. For a complete description of the Edit/Display menu 

functions common to SeisImager/SW and SeisImager/2D, refer to the separate SeisImager/2D 

manual.  

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

See next 

Section 

(6.2.1) 
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6.2.1 EDIT SOURCE/RECEIVER LOCATIONS [CTRL+R] 
 

 

 
 

 
 

To change the unit labels shown in the displays and in the dialog boxes, select Edit 

source/receiver locations to open the Geometry dialog box. 

 

The Geometry dialog box allows selection of units and reports the coordinates saved in the file 

header at the time of acquisition or in the file list for a single waveform file currently displayed.  

 

To set the unit labels, select between meters and feet. The unit setting also updates the minimum 

phase velocity default value, which is 35 m/sec or 150 ft/s. Once set (and Pickwin is closed), the 

assigned units will be recalled for subsequent uses of the program (it is necessary to close 

Pickwin to register the new Units setting). 
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The Geometry dialog box can also be used to set up or edit the source-receiver geometry for 

single shot records for 1D MASW. For 2D MASW, the File list and Set up geometry functions 

should be used. 

 

To set up or edit the geometry for a single 1D MASW shot record, enter the location of the shot 

in Shot coordinate. Enter the Group interval and First geophone coordinate, then press Set to 

calculate all the Geophone coordinates. Next and Back can be used to scroll through the 

coordinate values in sets of six channels. Press OK when done to apply the changes. A new SEG-

2 file will need to be saved by opening the File menu and selecting Save SEG2 file to preserve 

the changes, otherwise they will need to be made each time the shot record is input.  
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6.2.2 COPY TO CLIPBOARD 
 

 
 

 
 

This feature copies whatever is on the screen to the clipboard. It can then be pasted into any 

third-party application, such as Microsoft Word
®

. 
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6.2.3 SAVE DISPLAY IMAGE TO A FILE [CTRL+I] 
 

 
 

 
 

This feature saves whatever is on the screen to a PNG, JPG, BMP, or GIF file. 
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6.2.4 SAVE ALL DISPLAY IMAGES TO A FILE 
 

 
 

 
 

If you are working with a file list, this feature saves all shot gathers (or phase velocity images) in 

the file list to a PNG, JPG, BMP, or GIF file. 

. 

6.3 SURFACE WAVE ANALYSIS MENU 
 

The Surface wave Analysis menu contains the functions needed for calculating phase velocity 

and picking dispersion curves. The menu is divided into five sections, the top for functions that 

pertain to 1D MASW (active) and MAM (passive) data processing, the second for 1D MAM 

(passive) data processing (SPAC), the third for 2D/3D MASW (active) and MAM (passive) data 

processing, the fourth H/V data processing, and the fifth for advanced options. For purchases of 

SeisImager/SW-1D, the third section is greyed out. For purchases of SeisImager/SW-2D, all five 

sections are active. 
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1D functions (active 
and passive) 

1D functions (passive)  

2D/3D functions 
(active/passive) 

H/V functions  
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6.3.1 PHASE VELOCITY-FREQUENCY TRANSFORMATION [CTRL+D] 
 

 

 
 

 
 

To transform one MASW shot record or CMP cross-correlation gather from the time to 

frequency domain and to calculate the phase velocity for each frequency, select Phase velocity-

frequency transformation.  

 

For a MAM dataset, the same function is used to generate a phase velocity-frequency plot, but 

first the dataset must be processed by the 2D Spatial Autocorrelation function. Refer to Section 

6.3.6, Page 276, for a complete explanation. 

 

Once selected, set the boundaries for the phase velocity calculation in the Phase velocity-

frequency transformation dialog box. The radio buttons can be ignored as they only apply 

when using the software on a seismograph with integrated PC.  
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The Start Phase Velocity and Start Frequency are set fixed at 0.  

 

For End Phase Velocity, enter the approximate maximum velocity expected for the site. If you 

find that the end velocity in the calculated phase velocity-frequency plot is too low or too high, 

the calculation can simply be re-run. 

 

For End Frequency, adjust the default value to capture the bandwidth of fundamental mode 

surface wave signal. The default value of 30 Hz is suitable for most cases. Again, it is simple to 

adjust this value and re-run the calculation if you want to experiment with this setting.   
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The default dialog box format hides the Advanced menu. Pressing on Advanced menu reveals 

the rest of the parameters with default values for active-source (shown on left) and  passive-

source (shown on right) processing. These parameters are automatically updated by the software 

depending on the type of data being processed. Typically, none of the settings need to be 

changed.   

 

 
 

The Phase Velocity Interval defines the resolution at which the calculation steps through the 

range of velocities indicated. Increasing this value reduces the resolution. During the picking 

stage, if the phase velocity-frequency plot lacks resolution, the resolution can be improved by 

reducing this value.  

 

Mode of Shot gather or CMP gather applies to 2D MASW processing where shot gather traces 

are assembled into CMP gathers. This parameter is automatically updated by the software 

depending on the type of data being processed.  

 

Direction of Forward means that the shot coordinate is less than the coordinate of the first 

geophone. Backward means the shot coordinate is greater than the coordinate of the first 

geophone. The software assumes that the same gain was used on all traces and automatically 

attempts to determine the direction. This is done by comparison of the amplitudes of the first and 

last traces. If the last trace amplitude is smaller, the software assumes a Forward direction and 
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vice-versa for Backward. If you have recorded with individual gain settings, you may want to 

check that the software correctly determined the direction.  

 

The Frequency resolution controls how finely phase velocity is calculated. If this value is 

increased, the resolution will be reduced. This value cannot be less than 1 and must be an integer.  

 

The Offset range used in transformation sets the range of traces used in the transformation. This 

is a difference, not actual coordinates. Offset is the distance from the shot to any given receiver. 

This is mainly used for muting out near-source effects in 2D MASW data processing and is not 

applicable for 1D MASW.  

 

Method indicates what procedure will be used. This parameter is automatically updated by the 

software depending on the type of data being processed. For active-source data processing, the 

Method is Phase shift. For  passive-source data processing, the Method is SPAC by 2D. The 

Wave number limit is the high frequency limit used to avoid aliasing when fitting Bessel 

functions in the SPAC process. The default value of 100 is relatively large and suitable for most 

cases. 

 

Upon completion of the transformation, a phase velocity-frequency plot is displayed. A trend of 

peak “amplitudes”, which corresponds to the degree of fit for each frequency, should be obvious. 

It is typical for the widths of the peaks to broaden as the frequency decreases because the signal-

to-noise ratio tends to decrease with frequency.  

 

 

Figure 118: Phase velocity-frequency plot. 



The Pickwin Module Surface Wave Analysis Functions 
 

 

262 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

6.3.2 STACK AS SHOT CROSS-CORRELATION (SCC) GATHERS (1D ACTIVE 

DATA) 
 

 
 

 
 

 

In 1D MASW processing, shots having different shot locations cannot be stacked in the time 

domain. For example, two opposite end-shots, as shown below, cannot processed together as raw 

data. SeisImager first must calculate Shot Cross-correlation (SCC) gathers and then stack the 

SCC gathers. The phase velocity image can then be calculated from the stacked SCC gathers. 

 

 

Figure 119: Shot cross-correlation gathers. 

 

 

The concept of an SCC is illustrated below: 
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Figure 120: The Shot Cross-Correlation Gather (SCC). 

 

The above schematic is summarized below using two shot gathers: 

 

Figure 121: Stacked SCC from two shot gathers. 

 

The processing flow is shown in Figure 122. 
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Figure 122: Processing flow from raw shot gathers to phase velocity image using stacked shot-correlation gathers. 
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To calculate and stack the SCCs, use the following procedure: 

 

1. Make a list file of raw shot gathers: 
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2. Confirm the number of files: 

 

 
 

3. Check the source and receiver position boxes (assuming they are correct in the header): 

 

 
 

4. Confirm the file IDs and update the source and receiver locations if necessary: 

 

 
 

5. In the Surface wave analysis menu, select Stack as Shot Cross-correlation (SCC) gathers (1D 

active data): 
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6. If each file contains the correct shot location, press Yes. If not, choose No and the program will 

infer the shot locations based on trace amplitude. 

 

 
 

The calculated SCC gathers will appear. Make sure there is no time-shift among files (traces). 
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Figure 123: Calculated SCC gathers. 

 

Now you must stack the SCC gathers.  

 

7. In the Surface wave analysis menu, select Calculate Shot Cross-correlation (SCC) gathers | 

Stack SCC gathers: 

 

 

 
 

The stacked SCC gather will appear: 
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Figure 124: Stacked SCC gather. 

 

You are now ready to calculate the phase velocity image. 

 

8. In the Surface wave analysis menu, select Phase velocity-frequency transformation: 

 

 

 
 

9. Set up the display parameters and press OK: 
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The phase velocity image will appear: 

 

 

Figure 125: Phase velocity-frequency plot. 

 

  



The Pickwin Module Surface Wave Analysis Functions 
 

 

271 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

6.3.3 PICK PHASE VELOCITIES (1D) 
 

 
 

 
 

 

To automatically pick the maximum amplitudes on the phase velocity-frequency plot which 

define the dispersion curve, select Pick Phase Velocity (1D).  

 

Set the frequency bounds for automatic picking in the Min. and Max. Frequency dialog box. 

For active-source data processing (shown on left), the Minimum Frequency default value is 5 

assuming that 4.5 Hz geophones were used. 

 

For  passive-source data processing (shown on right), the Minimum Frequency default value is 2 

assuming that 2 Hz seismometers were used. If the dataset was acquired with 4.5 Hz geophones, 

the Minimum Frequency can be increased to 5 if desired; however, there may be signal below 5 

Hz and any spurious picks made between 2 and 5 Hz can easily be deleted manually. It is not 

crucial that this value be precisely correct.  

 

The value shown for the Maximum Frequency reflects in Fourier space the value closest to that 

set in the Phase velocity-frequency transformation dialog box.  
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The default dialog box format hides the Advanced menu. Pressing on Advanced menu reveals 

the rest of the parameters with default values for active-source (shown on left) and  passive-

source (shown on right) processing. These parameters are automatically updated by the software 

depending on the type of data being processed. Typically, none of the settings need to be 

changed.  

 

 
 

After the dispersion curve is automatically picked, if Use Median filter is checked, a median 

filter is applied to remove noisy picks. The median filter is a moving window filter sized by the 

number of samples for the median filter. For high tolerance of noisy picks, a large number would 

be set for the number of samples. The default value of 5 is suitable for most cases.  

 

The Wavelength limitation defines the wavelength (phase velocity divided by frequency) 

boundaries for picking. If this option is checked, the limits as defined will be used for picking. 

The Maximum wavelength limit is calculated by the total offset or array length multiplied by the 

scalar value entered. The Minimum wavelength limit is calculated by the geophone interval 

multiplied by the scalar value entered. For active-source processing, the default value is 2 and for  

passive-source processing the default value is 4.  

 

On the phase velocity-frequency plot, the Maximum wavelength setting controls the slope (x/y) 

of the upper blue line (nearly parallel to the x-axis) and the Minimum wavelength controls the 

slope of the lower blue line (nearly parallel to the y-axis). To widen the limits of picking, that is, 

the separation between the blue lines, enter a value greater than 4 for the Maximum wavelength 

and a value less than 4 for the Minimum wavelength. Refer to Page B-8 for more information on 

the Maximum wavelength and Minimum wavelength.  
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The Minimum phase velocity is the lowest phase velocity for which a pick will be made. For 

active-source data, depending on whether the units are set to meters or feet, the default value is 

35 m/s or 150 ft/s, respectively. For  passive-source data, it is 70 m/s or 70 ft/s. The Maximum 

phase velocity is the highest phase velocity for which a pick will be made. For all types of data 

and regardless of units, the default value is 1000 m/s or ft/s.  

 

On the phase velocity-frequency plot, a trend of peak amplitudes should be obvious. If it appears 

that there is only noise below a particular phase velocity on the lower frequency end, that 

velocity should be entered for the Minimum phase velocity to focus the picks to the velocity 

range of the amplitudes associated with the dispersion curve. Otherwise, noise with amplitudes 

larger than those for signal will be picked. On the higher frequency end, if there is a higher 

mode(s), the velocity between it and the fundamental mode can be entered for the Maximum 

phase velocity to help prevent the amplitudes associated with the higher mode from being picked 

(even with these limits set, further editing of the dispersion curve will likely be required in 

WaveEq).  

 

Upon completion of picking, the phase velocity-frequency plot with dispersion curve picks (red 

points) is displayed.  

 

 

Figure 126: Phase velocity-frequency plot with peak frequency picks. 

 

Picks are automatically made at the mathematical maximum amplitude for each frequency. The x 

and y-pairs of phase velocity and frequency define the dispersion curve. The automatic picks can 

be manually edited with the mouse by individually clicking on a new point or by dragging the 

mouse over a range of frequencies to set a range of new picks. Manual picking is facilitated 
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using the Fine color contour  button to switch to a color plot and the Waveform amplitude 

, Horizontal scale , and Vertical scale  buttons to optimize the gain and 

scale. (These functions are common with SeisImager/2D; refer to the SeisImager/2D manual for 

a complete explanation.) To help identify maxima, as you drag the mouse over the plot the 

amplitude values can be read on the bottom bar , where the value preceding the 

colon is the frequency and the value following is the amplitude.    

 

Any picks lying on the y-axis have a phase velocity value of zero and are automatically excluded 

from further analysis.  

 

6.3.4 SHOW PHASE VELOCITY CURVE (1D) 
 

 

 
 

 
 

Once the dispersion curve is picked in Pickwin, the picks are held in memory for import to 

WaveEq. WaveEq is used for detailed editing, inversion, and additional analysis. WaveEq can be 

opened separately and a .pvs file read in, but this single step is the easiest way to automatically 

launch WaveEq and import a dispersion curve just picked in Pickwin.   

 

To automatically launch WaveEq and import the dispersion curve from Pickwin, select Show 

phase velocity curve (1D).   

 

WaveEq is launched and the dispersion curve plot is displayed. The unit labels set in Pickwin 

carry over. Note that in WaveEq, Phase velocity is plotted on the vertical axis and Frequency is 

plotted on the horizontal axis. Refer to Section 7.3.2, Page 344, for a complete explanation of 

this plot. 
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Figure 127: Dispersion curve. Includes quality plot. 

 

6.3.5 CALCULATE SHOT CROSS-CORRELATION (SCC) GATHERS 
  

                                

                                  
 

 
 

The functions in this menu are identical to those described in Section 6.3.2 above below. The 

only difference is that in this menu, the functions work on individual shot gathers, whereas the 

menu item described in Section 6.3.2 works on file lists. However, the process is the same. In 

general, it is uncommon to apply these functions to individual shot gathers, and the items in this 

menu are rarely used. 
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6.3.5.1 CALCULATE SCC GATHER 
  

 
 

 
 

 
 

 

See Section 6.3.2 above below. 

 

6.3.5.2 STACK SCC GATHERS 
  

 
 

 
 

 
 

See Section 6.3.2 above below. 

 

6.3.6 SPATIAL AUTOCORRELATION (SPAC) FOR 1D PASSIVE DATA 
 

For MAM datasets, the function 2D Spatial autocorrelation uses the SPAC method to analyze 

the signal coherency between multiple observation points in a receiver array (independent of 

source location). Once the signal coherency spectrum is known, phase velocity can be 

determined by finding the best fit between theoretical and observed coherency. A tutorial on 

using the SPAC method in SeisImager/SW method can be found here. 
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Once selected, set the geometry of the  passive-source array in the 2D SPAC dialog box. Refer 

to Section 3.2 , Page 26, for an explanation of the different array types and Array size.  
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The default dialog box format hides the Advanced menu. Pressing Advanced menu reveals 

options to define a Manual array, Open array file, Save array file, and to set Data storage 

parameters.  

 

 
 

Data storage allows a particular array geometry to be applied to other data. Reverse cable 

direction will flip the channel order, Start channel sets the new start channel number, and 

Unused channels allows dead or unused channels to be deleted.  

 

If your array does not conform to one of the standard geometries, a Manual array can be defined 

in a simple space-delimited text file where each row is a pair of x- and y-coordinates.  
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Once the Array file is prepared, press Open array file, highlight the file, and press Open. 

 

 
 

If changes are made to an existing Array file, press Save array file to revise the file or to save a 

new file with a different name.  
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Once the 2D Spatial autocorrelation process is complete, a signal coherency plot is displayed.  

 

 

Figure 128: Signal coherency plot. 

 

Coherence is the similarity between all possible pairs of geophones, in this case in a triangle 

array with 10 geophones, with an array size of 50 m. The separation between each geophone pair 
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is plotted on the y-axis as Distance and the coherence between each of those two traces is plotted 

as a function of Frequency on the x-axis.  

 

Consider the geophone separation of zero, the coherence is 1 shown by a bar, or horizontal line 

shaded black, across all frequencies. At a distance of zero, a trace is compared with itself and 

there is 100% similarity or coherence of 1. Generally, as geophone separation increases, 

coherence decreases. Coherence also tends to be higher at lower frequencies and decreases with 

higher frequencies.  

 

The shape of a coherency curve by nature is a Cosine function with 1D arrays and a Bessel 

function (decaying Cosine function) with 2D arrays (shown above). The coherency curve for 

each separation is well shaped (calculated from what is considered an ideal dataset). Compare 

this with the coherency plot for a 60-foot L11 array that shows poor coherence for all separations 

greater than zero (shown below).   

 

 

Figure 129: Coherency plot showing poor coherence for non-zero separations. 

 

In the field, coherence is a quick calculation and can be readily performed to confirm that MAM 

datasets will yield good results. 
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6.3.7 CALCULATE CMP CROSS-CORRELATION (CMPCC) GATHERS 
 

 
 

 

 
 

Once a 2D MASW dataset has a file list and its geometry has been assigned, the traces can be 

assembled into CMP cross-correlation gathers. The steps include calculation of cross-

correlations between every pair of traces in each shot record, gathering of correlation traces by 

CMPs, and time domain stacking of correlation traces having equal spacing. The effect is to 

improve the lateral resolution and accuracy over what is normally achieved with conventional 

2D MASW. Refer to Hayashi and Suzuki (2004) for a complete explanation of the process.  

 

First, a file list with assigned geometry is opened using the Group (File List) menu, Open File 

List or Make File List and Set up Geometry, as applicable. Once opened, select Surface Wave 

Analysis | Calculate CMP Cross-correlation (CMPCC) Gathers. 

  

You will be prompted to make a new (and different) file list. The new file list is built using the 

existing file list held in memory; the original file list itself is not overwritten. For the new file 

list, the source and receiver locations in the existing file list are replaced with CMP locations and 

CMP cross-correlation gather names. Press OK. 

 

 
 

Next, set the parameters for organizing the CMPs for the phase velocity calculation. The Bin size 

is automatically calculated as two times the receiver interval. In this application, a bin is a 

discrete length that divides the survey line. Within one bin, traces are sorted based on mid-point 

locations and then stacked to obtain one output trace with increased signal-to-noise ratio. The 

effect of increasing the Bin size is to reduce the resolution of the final VS cross-section. The 
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default value for Bin size is suitable for most cases. The First distance and Last distance are 

taken from the first and last coordinates of the receiver spread in the file list. Press OK.  

 

 
 

CMP cross-correlation traces are calculated, and CMP cross-correlation gathers are assembled. A 

new set of CMP cross-correlation gather SEG-2 files are written to the dataset directory with the 

name cmp_XXXXX.sg2 where the X values are the CMP locations.  

 

 
 

Confirmation that the CMP cross-correlation gathers are calculated and assembled is displayed; 

press OK.  

 

 
 

The number of CMP gathers is reported; press OK. 
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Once calculation of the CMP cross-correlation gathers is complete, a plot of the CMP cross-

correlation gather geometry is displayed. Refer to Table 5 in Section 6.1.5.7, Page 233, for 

explanation of the geometry plot attributes and display functionality.  

 

The horizontal axis, Spacing, is the separation or spatial distribution of the cross-correlation 

traces. The vertical axis, CMPCC Gather No., is the number of the CMP cross-correlation 

gather.  

 

This example shows the highest fold occurs for the center shots which have the most traces.  

 

 

Figure 130: CMP cross-correlation gather geometry. Highest fold occurs in center shots where trace counts are the 

highest. 
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6.3.8 PHASE VELOCITY-FREQUENCY TRANSFORMATION AND PICKING 

(2D/3D) 
 

 
 

 
 

Once CMP cross-correlation gathers are assembled, select Phase velocity-frequency 

transformation and picking (2D/3D) to transform the time domain gathers to the frequency 

domain, to calculate the phase velocity for each frequency, and to pick the maximum amplitudes 

which define the dispersion curves. For 2D MASW, the transformation and picking are 

combined into this one function.  

 

The Phase velocity-frequency transformation dialog box (shown on left and Advanced menu 

shown on right) is the same as that explained in Section 6.3.1 on Page 258. Press OK when done. 

 

 



The Pickwin Module Surface Wave Analysis Functions 
 

 

286 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 
 

Next, the Min. and Max. Frequency dialog box (shown on left and Advanced menu shown on 

right) is automatically displayed so the amplitude maxima for each curve can be automatically 

picked. The Min. and Max. Frequency dialog box is the same as that explained in Section 6.3.3 

on Page 271. Press OK when done. Advanced features are rarely altered and can generally be left 

to the default settings. Contact support@seisimager.com for assistance if necessary. 
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Upon completion of picking, because 2D MASW datasets include many files, all the individual 

dispersion curves are not shown in Pickwin. The picks are automatically saved as a .pvs file in 

the dataset directory and held in memory for import to WaveEq. 
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6.3.9 SHOW PHASE VELOCITY CURVES (2D/3D) <LAUNCHES WAVEEQ> 
 

 
 

 
 

Once the dispersion curves are picked in Pickwin, the curves are held in memory for import to 

WaveEq. WaveEq is used for detailed editing, inversion, and additional analysis. WaveEq can be 

opened separately and a .pvs file read in, but this single step is the easiest way to automatically 

launch WaveEq and import dispersion curves just picked in Pickwin.   

 

Select Show phase velocity curves (2D/3D) to automatically launch WaveEq and import the 

dispersion curves from Pickwin. 

 

WaveEq is launched and the dispersion curve plot is displayed. The unit labels set in Pickwin 

carry over. Note that in WaveEq, Phase velocity is plotted on the vertical axis and Frequency is 

plotted on the horizontal axis. Refer to Section 7.5, starting on Page 433, for a complete 

explanation of this plot. 
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Figure 131: Dispersion curves. 

 

6.3.10 CALCULATE FOURIER SPECTRUM 
 

 
 

 
 

To transform your data into the frequency domain (prior to calculating the H/V spectrum, for 

example, see next section), first create a file list by selecting File | Group (File list) | Make file 

list and choosing the time domain waveform files to be transformed. Alternatively, if the folder 

only contains the waveform files you wish to transform, select File | Group (File list) | Make file 
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list (select a folder). All of the waveform files will be automatically read in (Section 6.1.5.2, 

Page 227). 

 

The first of your waveform files will be displayed; you may scroll through them using the 

 buttons on the tool bar. 

 

 

Figure 132: 3-componenet time domain plot. 

 

In this example, we have 13 three-component files (only one file is shown above); two horizontal 

and one vertical. Each trace is one minute long. 

 

Now would be a good time to save your file list for later use. XML is the most convenient 

format. Select File | Group (File list) | Save file list (XML). You will be prompted for a file name. 

 

Next, select Surface wave analysis | Calculate Fourier spectrum: 
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Figure 133: Three-component passive data displayed in the frequency domain. 

 

The data has been transformed into the frequency domain. 

 

6.3.11 SHOW H/V SPECTRUM 
 

 
 

 
 

 



The Pickwin Module Surface Wave Analysis Functions 
 

 

292 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

To view the H/V spectrum, select Surface wave analysis | Show H/V spectrum. This will 

automatically launch WaveEQ. 

 

 
 

 

Edit the component numbers and drawing order if necessary, and press OK: 

 

 

Figure 134: H/V spectrum. 

 

The H/V spectrum will be displayed. 
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6.3.12 ADVANCED OPTIONS 
 

 
 

Continue. 

 

 

6.3.12.1 SETUP MAXIMUM FREQUENCY FOR H/V 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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6.3.12.2 SETUP PHASE VELOCITY-FREQUENCY VIEW 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

6.3.12.3 NORMALIZE COHERENCE 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

6.3.12.4 REMOVE DC BEFORE CALCULATING FOURIER SPECTRUM 
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This is a toggle switch; enable it if you wish to remove any DC component in your data prior to 

calculation the Fourier spectrum. 

 

6.3.12.5 REMOVE LINEAR TREND BEFORE CALCULATING FOURIER 

SPECTRUM 
 

 
 

 
 

 
 

This is a toggle switch; enable it if you wish to remove any linear trend in your data prior to 

calculation the Fourier spectrum. 

 

6.4 PROCESSING MENU 
 

 

The Processing menu includes various data processing tools that can be useful for both 

refraction and surface wave data. 

 

6.4.1 BPF (COS FUNCTION TAPER) 
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This is a bandpass filter for which you can set the specific filtering parameters: 

 

You must filter each waveform file individually. To disable the bandpass filter, press the Undo 

 button.  

Note: If you filter your data and save it, it will be saved in a filtered state.  

 

6.4.2 REMOVE DC 
 

 
 

 
 

This feature removes any DC offset that might be present in your traces. 

 

6.4.3 VERTICAL STACK 
 

 
 

 
 

You may vertically stack (sum) two or more records together. This is handy if stacking was not 

done in the field. Simply append (Section 6.1.5.9 , Page 245) two or more files together, then 

select Processing | Vertical Stack. 
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6.4.4 CROSS-CORRELATION 
 

 
 

 
 

You may cross-correlate all the traces against any one trace. To do so, you must select an 

operator by pressing the  button and clicking on the desired trace: 

 

 

Figure 135: Operator (red) selected for cross-correlation. 

 

The selected trace will turn red; this is your operator. Now select Cross correlation, and all of 

the traces in the record will be cross correlated with the operator.  
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6.4.5 AUTO-CORRELATION 
 

 
 

 
 

This feature auto correlates each trace with itself. 

 

6.4.6 MUTE 
 

                                       
 

 
 

 

You may mute the record on the basis of picked arrivals or velocity. 

 

6.4.6.1 MUTE (PICKED ARRIVAL) 

 

 

 

To mute based on first arrivals, pick the arrivals and then select Mute (picked arrivals). 
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Figure 136: MASW record with first arrival picks. 

Set your mute parameters (see above) and press OK. Your record will be muted according to 

these parameters. In this example, we chose to mute the traces before and after the first breaks: 

 

Figure 137: Refraction record muted on basis of the first arrivals. 

 

  



The Pickwin Module Surface Wave Analysis Functions 
 

 

300 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

6.4.6.2 MUTE (APPARENT VELOCITY) 

 

 
 

 
 

You may also mute traces based on apparent velocity. This is most useful when working in the 

frequency domain (such as surface wave analysis) but can be applied to refraction data as well. 

Enter the range of velocities you wish to preserve:  

 

Figure 138: Unmuted refraction record. 

Press OK. 
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Figure 139: Refraction record muted on basis of velocity. 

 

In general, muting is rarely applied to refraction data. 

 

6.4.7 CONNECT (CONCATENATE) 
 

 
 

 
 

You may concatenate files together end-to-end in time using the “concatenate” feature. This can 

be useful if your data is broken up into many small files, perhaps from numerous shot records 

with a common shot point. The process is as follows: 

 

1) Open a waveform file. 

2) Open a second waveform file and choose Append to present data instead of New. 

3) Repeat #2 up to eight more times – you may append up to 10 files together in a single step. 

4) Select Processing | Connect (concatenate) 

5) You will be prompted for a file name for the concatenated file. 

 

This is best illustrated by an example. 



The Pickwin Module Surface Wave Analysis Functions 
 

 

302 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

Open a waveform file: 

 

 
 

 

Figure 140: Waveform file. 

 

We have a typical single-shot 24-channel MASW file, with 1024 samples/trace. 

 

Open a second waveform file: 

 

 
 

Append it to the first: 
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Make any necessary adjustments: 

 

 

 
 

Press OK. 
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Figure 141: Two waveform files appended together. 

 

The two files have been appended together. 

 

Repeat as necessary until all files to be concatenated have been appended together. 

 

Select Processing | Connect (concatenate): 

 

 
 

Provide a file name for the concatenated file when prompted. 

 

Now the appended files have been concatenated together in time. Each trace is 2048 samples. 
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Figure 142: Concatenated waveform files. 

 

Note: If you have more than 10 files to append/concatenate, see Section 6.1.5.9, Page 245. 

 

6.4.8 BLOCK DIVIDING 
 

 
 

 
 

This feature is the opposite of concatenation and is useful if your files are too long to be 

manageable. This is very common when using Atom or McSeis MT Neo seismographs, 

particularly when recording passive surface wave data. 
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This is best illustrated by an example. The next dialog box allows you to enable/disable “block 

dividing” and to set the length of each “sub” trace. In general, it is desirable to work with traces 

of 16k or 32k samples (or less); at the standard passive data sample interval of 4 msec, this 

works out to 1 or 2 minutes. 

 

Select a trace length and press OK. 

 

 
 

6.5 OPTION MENU 
 

The Option menu includes program controls and display settings.  

 

 
 



The Pickwin Module Surface Wave Analysis Functions 
 

 

307 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

 

 

6.5.1 DIMENSION SIZE 
 

 
 

 
 

To view or change the program data input allowances, select Dimension size.  

 

Present size reflects the current dimensions for Maximum samples and Maximum traces and 

Maximum shows the largest possible dimensions. Typically, it is unnecessary to change the 

number of Maximum samples. It can be useful to change the number of Maximum traces to 64 

from 128 to speed up processing, but this will also reduce the resolution of the phase velocity 

plot. The number of Maximum traces may need to be increased if you are processing a  passive-

source dataset with a large number of traces, for example, greater than 48.  

 

 
 

To change the dimensions, enter the new value(s), check Change dimension size, and press OK. 
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Press OK and restart the program.  

 

 
 

If a very large value is entered, such as 1024 for Maximum traces, a warning message will 

appear before you are allowed to restart the program. It is recommended that you do not proceed; 

select No and reduce the dimensions.  
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If you proceed and indeed the PC has insufficient memory, the program will no longer be able to 

open. To lower the values and recover the program, open the Dimension size dialog box directly 

by pressing the Shift key while double-clicking the program icon.  

 

Note: Sometimes the program will simply crash rather than post the above message. If that 

happens, use the procedure outlined on Page 3 to restore the system defaults. 

 

The wizard automatically defaults to standard dimensions to run efficiently. To use non-standard 

dimensions, you will need to process data manually.  

 

If a program upgrade is purchased, the new registration password can be directly entered in the 

Dimension size dialog box in the Password for upgrade field; however, it is strongly 

recommended to upgrade via the SeisImager Registration program instead. 

 

 

 

 

 

 

6.5.2 ATOM 
 

                                            
 

 
 

Continue. 

 

6.5.2.1 SET UP COMPONENTS 
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The Atom and McSeis Neo include three-component modules to work with three-component 

geophones. There are many makes and models of 3C geophones, all of which are wired 

differently. For this reason, it is necessary to define which component is EW, which is NS, and 

which is vertical. 

 

The default values are for the make and model sold by Geometrics (as of this writing), which is 

the SunfullTM PS-2B 3C geophone. If you use a different geophone, you will need to get the 

component and polarity information from the manufacturer. 

 

 
 

6.5.3 METERS AND M/SEC AND FEET AND FT/SEC 
 

 
 

 
 

Select the desired unit labels by choosing meters and m/sec or feet and ft/sec. The setting is 

reflected in the display labels, dialog box labels, and default values where applicable. 
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6.5.4 LANGUAGE 

                                                    

 

Choose your preferred language. At the time of this writing (July 2024), Chinese and Spanish 

were in development. 

 

6.5.5 MENU TYPE 

 

SeisImager includes advanced options for very special applications that are only available if 

Simple is unchecked. These are undocumented and should only be used under supervision from 

Geometrics. If Simple is unchecked, you will see the following warning: 
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Pressing OK above will give you access to these features (mainly processing). Contact 

support@seisimager.com for assistance. To return to the Simple menu, select Option | etc. | 

Menu type | Simple.  

 

6.6 TOOL BUTTONS 
 

 

Figure 143: Pickwin Tool Buttons 

 

The button bar functions essential or uniquely used for surface wave data processing are covered 

in this section. For a complete description of the button bar functions common to SeisImager/SW 

and SeisImager/2D, please refer to the separate SeisImager/2D manual.   

 

6.6.1 UNDO  AND REDO  
 

After the phase velocity-frequency transformation has been calculated for a given waveform file 

or dataset, press the Undo button to cancel the phase velocity plot.   

 

 

Figure 144: Phase velocity-frequency plot. 

 

For a single file (shot or CMP cross-correlation gather), after pressing the Undo button, the 

waveform file will appear.  
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Figure 145: Waveform file after pressing Undo button. 

 

For a  passive-source dataset, after pressing the Undo button, the coherency plot will appear.  

 

 

Figure 146: Coherency plot after pressing Undo button. 

 

To return to the phase velocity plot in either case, press the Redo button. Note that the Undo and 

Redo functions run only one cycle, so if Undo is pressed again, the waveform and coherency 

files will not be found, and it will be necessary to restart the program.  

 

The Undo button is very useful when the optimal analysis parameters are not yet known, and 

iterative testing is required.  

 

6.6.2 NORMALIZE  
 

When traces are normalized, the maximum amplitude of each trace will be equalized. Lower 

amplitude traces (those farther from the source) will be “turned up” so that their maximum 

amplitude is equal to that of higher-amplitude traces. This has the effect of equalizing the 
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appearance of all the traces across the record and allows viewing of the active-source surface 

wave train.  

 

With Normalize off, the signals on traces distant from the source are not visible.  

 

 

Figure 147: Waveform file with Normalize disabled. 

 

With Normalize on, signals on traces at all distances are visible.  

 

 

Figure 148: Waveform file with Normalize enabled. 

 

To observe trace-to-trace variations with  passive-source surface wave data, Normalize should be 

turned off. With Normalize on, note the appearance of traces 4 through 7.  
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Figure 149: MAM record with Normalize enabled. 

 

With Normalize off, traces 4 through 7 are slightly higher amplitude.  

 

 

Figure 150: MAM record with Normalize disabled. 

 

6.6.3 SHOW PREVIOUS WAVEFORM FILE  AND SHOW NEXT WAVEFORM 

FILE  
 

When more than one waveform file (shot or CMP cross-correlation gather) is input, the files can 

be scrolled through using the Show previous waveform file and Show next waveform file buttons.  

 

6.6.4 COARSE CONTOUR COLOR  
 

The phase velocity-frequency plot display is enhanced with color gradients. To apply a coarse 

contour color scale, press the Coarse contour color button.  
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Figure 151: Phase velocity-frequency plot with coarse color contours. 

 

6.6.5 FINE CONTOUR COLOR  
 

The phase velocity-frequency plot display is enhanced with color gradients. To apply a fine 

contour color scale, press the Fine contour color button. The fine setting takes slightly longer to 

paint on the screen, but gives a smoother gradient compared to Coarse contour color.  

 

 

Figure 152: Phase velocity-frequency plot with fine color contours. 

 

6.6.6 WIGGLE LINE  AND SHADED BLACK  
 

The default trace display for the phase velocity-frequency plot is a black line with the positive 

side shaded corresponding to the Wiggle line and Shaded black buttons, respectively.  
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Figure 153: Waveform plot displayed with Wiggle trace and Shaded black enabled. 

 

6.6.7 SHOW WAVEFORMS  AND SHOW GEOMETRY  
 

After the geometry has been calculated and applied to a given dataset, the Show waveforms 

button and the Show geometry button are activated and allow toggling between the two views. In 

the Show geometry view, the Show previous waveform file and Show next waveform file buttons 

allow selection of a shot or CMP cross-correlation gather’s geometry.  

 

 

Figure 154: Geometry plot. 
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Press the Show waveforms button to display the gather associated with the selected geometry. 

 

 

Figure 155: Waveform plot. 

 

6.6.8 FREQUENCY DOMAIN  
 

The Frequency domain button transforms a time domain waveform file to the frequency domain. 

Pressing the Frequency domain button will change the view from the waveform record to a plot 

of the frequency content or spectrum for each trace. It will be necessary to press the right 

Horizontal scale  button or the right arrow key to expand the frequency scale and zoom in on 

the lower end.   

 

Unlike most active-source data, it is usually difficult to evaluate the quality of  passive-source 

data by viewing the waveform record in the time domain. Similar frequency content from trace-

to-trace indicates higher-quality data.  

 

 

Figure 156: Coherency plot. 

 

Uneven frequency content from trace-to-trace indicates lower-quality data.  
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Figure 157: Coherency plot of Figure 156 stretched horizontally. 

 

6.6.9 TIME DOMAIN  
 

The Time Domain button toggles out of the Frequency domain view.  
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7 THE WAVEEQ MODULE FUNCTIONS 
 

Continue. 

 

7.1 FILE MENU  
 

The File menu includes functions for opening WaveEq result files, importing and exporting 

various files, and printing. 
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7.1.1 OPEN 1D PHASE VELOCITY CURVE OR H/V SPECTRUM FILE (.RST) 
 

 

 
 

 
 

 

To open a single dispersion curve, VS curve, or H/V spectrum file previously saved with the 

extension .rst, select Open 1D phase velocity curve or H/V spectrum file (.rst). 

 

Highlight the file and press Open.  

 

 
 

7.1.2 SAVE 1D PHASE VELOCITY CURVE OR H/V SPECTRUM FILE (.RST) 
 

 
 

 
 

 

To save a single dispersion curve, VS curve, or H/V spectrum file, select Save 1D phase velocity 

curve or H/V spectrum file (.rst). A curve file can be saved at any time in the processing flow 

and will reflect the extent of results at the time of save. If you have not yet entered latitude and 

longitude, you may do so here by answering yes: 
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The following dialog will appear. The parameters should be self-evident. 

 

 
 

 

Assign a file name with the extension .rst and press Save.  
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7.1.3 IMPORT 1D PHASE VELOCITY CURVE OR H/V SPECTRUM FROM 

DATABASE 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.1.4 UPDATE 1D PHASE VELOCITY CURVE OR H/V SPECTRUM IN 

DATABASE 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.1.5 UPLOAD 1D PHASE VELOCITY CURVE OR H/V SPECTRUM TO 

DATABASE 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.1.6 OPEN 1D PHASE VELOCITY CURVE OR H/V SPECTRUM FILE (.XML) 
 

 
 

 
 

 

To open a single dispersion curve, VS curve, or H/V spectrum file previously saved with the 

extension .xml, select Open 1D phase velocity curve or H/V spectrum file (.xml). 

 

Highlight the file and press Open.  
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7.1.7 SAVE 1D PHASE VELOCITY CURVE OR H/V SPECTRUM FILE (.XML) 
 

 
 

 
 

To save a single dispersion curve, VS curve, or H/V spectrum file in xml format, select Save 1D 

phase velocity curve or H/V spectrum file (.xml). A curve file can be saved at any time in the 

processing flow and will reflect the extent of results at the time of save.  

 

Assign a file name with the extension .xml and press Save.  

 

7.1.8 OPEN 2D/3D PHASE VELOCITY CURVE FILE (.PVS)  
 

 

 
 

 
 

To open a set of dispersion curves previously saved with the extension .pvs, select Open 2D 

Phase Velocity Curve File (.pvs). Highlight the file and press Open.  
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7.1.9 SAVE 2D/3D PHASE VELOCITY CURVE FILE (.PVS)  
 

 
 

 
 

To save a set of dispersion curves, select Save 2D Phase Velocity Curve File (.pvs). A curve file 

can be saved at any time in the processing flow and will reflect the extent of results at the time of 

save. 

 

Assign a file name with the extension .pvs and press Save.  
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7.1.10 PRINT [CTRL+P]   
 

 
 

 
 

To print the current WaveEq display, choose Print, press Ctrl+P, or press the Print  button. 
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7.1.11 PRINT PREVIEW 
 

 
 

 
 

To preview the WaveEq display before printing, select Print preview (V).  
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Figure 158: WaveEQ display, read for printing. 

  

7.1.12 PAGE SETUP 
 

 
 

 
 

To set up a page for printing, select Page set up.  
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7.1.13 IMPORT ELEVATION DATA FILE  
 

 
 

 
 

Survey line elevations can be imported and plotted on 2D MASW initial and final cross-sections. 

Note that elevations are not incorporated into the data analysis, they are only used for plotting. 

For this reason, it is recommended that surveys be conducted on generally flat ground. Some 

variation in elevation can be tolerated and would be averaged, especially for the  passive-source 

surveys, but flat ground is best.  

 

Create an elevation file as a simple space-delimited text file where each row is a pair of x- and z-

coordinates. At a minimum, two coordinates are required; the values in between will be 

interpolated. The coordinates need not exactly match the geophone and shot locations and can 

extend off the ends of the survey line.  
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To open an elevation file, select Import elevation data file, highlight the file, and press Open.   
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If not imported here, elevation data can also be imported into GeoPlot by opening the File menu 

and selecting Open topography data file.  

 

7.1.14 SAVE 1D ANALYSIS RESULT IN TABULAR FORM (.TXT) 
 

 
 

 
 

To save the final results of a 1D MASW or MAM dataset analysis in tabular form, select Save 

1D analysis result in tabular form (.txt).  

 

Assign a file name with the extension .txt and press Save.  

 



The WaveEq Module Functions 
 

 

333 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 
 

The file is a simple text file with Depth, S-wave velocity, p-wave velocity, Density, and N (blow 

counts). Refer to Section 7.6.13.1, Page 464, for more information on the relationships used for 

calculating the equivalent p-wave velocity, Density, and N. 

 

 
 

Table 12: 1D results file. 
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7.1.15 FOLDER PATH 
 

 
 

 
 

WaveEQ generates some files automatically while producing a velocity model. In most cases, 

you will never refer to these files. The path for these automatically generated files defaults to the 

folder from which you read the original data. If you would like to avoid clutter in the data file, 

create (outside of WaveEQ) and separate folder, select Folder Path, and then choose the new 

folder as the path for automatically generated files.  
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7.1.16 ADVANCED OPTIONS 
 

 
 

Some of the items in the following sub-menus are subject to change and are undocumented. They 

are rarely used, and when they are, support from Geometrics is generally required. 

 

7.1.16.1 OPEN 1D ANALYSIS RESULT FILES (.RST OR .XML) FOR 2D/3D 

ANALYSIS 
 

 
 

 
 

 
 

If you have a series of 1D VS profiles, you may open all of them at once to conduct a 2D or 3D 

analysis.  

 

7.1.16.2 OPEN H/V FILE 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.1.16.3 OPEN DEPTH PROFILE 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.1.16.4 OPEN UCLA DATABASE FILES 
 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.1.16.5 SAVE DEPTH PROFILE 
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This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.1.16.6 SAVE SELECTED DISPERSION CURVES IN CSV FORMAT FILE (.CSV) 
 

 
 

 
 

 
 

 
 

This function lets you save individual dispersion curves into separate CSV files for import into 

Excel
®

 or other third-party software. 
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7.1.16.7 XML OPTIONS 
 

                                               
 

                                  
 

 
 

Continue. 

 

7.1.16.7.1 SELECT SURVEY TYPE 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.1.16.8 NIED 
 

                                         
 

                           
 

 
 

Continue. 

 

7.1.16.8.1 OPEN FOLDER 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.1.16.8.2 CONVERT SUB-FOLDERS TO XML 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.1.17 EXIT 

 

 

To exit the WaveEQ module, choose Exit. You will see the following dialog box: 

 
 

Press OK to exit WaveEQ or press Cancel to continue using WaveEQ. 
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7.2 EDIT MENU 
 

The Edit menu contains functions for making and reversing edits and copying graphical displays 

to the clipboard.  

 

 
 

7.2.1 UNDO  
 

 
 

 
 

The Undo function can be used to reverse the deletion or repositioning of a point on a dispersion 

curve using the Select dispersion curve  or Correct dispersion curve  buttons, 

respectively. Undo does not apply to all functions.  

 

7.2.2 DELETE 
 

 
 

 
 

The Delete function or Delete key becomes active when a point on the dispersion curve has been 

selected using the Select dispersion curve  button. To delete a point on a dispersion curve, 

activate editing with the Select dispersion curve button, then use the mouse to select the point(s) 

on the dispersion curve to be deleted. The selected points are highlighted in red. Select Delete or 

press the Delete key to remove the selected points.  
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7.2.3 COPY TO CLIPBOARD [CTRL+C] 
 

 
 

 
 

To copy the current display to the clipboard for pasting into Microsoft Word or other application, 

select Copy to clipboard.  

 

7.2.4 SAVE DISPLAY IMAGE TO A FILE [CTRL+I] 
 

 
 

 
 

This feature saves whatever is on the screen to a PNG, JPG, BMP, or GIF file. 

 

7.2.5 SAVE ALL DISPLAY IMAGES TO FILES  
 

 
 

 
 

If you are working with a file list, this feature saves all shot gathers (or phase velocity images) in 

the file list to a PNG, JPG, BMP, or GIF file. 
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7.3 VIEW MENU 
 

The View menu includes functions to configure scales, alter displays, and overlay or import 

other types of data.  
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7.3.1 AXIS CONFIGURATION [CTRL+A] 
 

 
 

 
 

To configure the axis scales on a dispersion curve(s) or velocity curve(s) plot, select Axis 

configuration. The Minimum values for the X-axis and Y-axis are fixed at zero. The Maximum 

values set the outer limits. The Interval is the size of the sub-divisions.  

 

 
 

 

7.3.2 DISPERSION CURVES 
 

 
 

 
 

The Dispersion curves dialog box controls how dispersion curves are displayed. The Plot curve 

options allow Single, Next (three) curves, or All curves to be displayed. These settings 

correspond to the Show one dispersion curve , Show next dispersion curve , and Show all 

dispersion curves  buttons, respectively.  
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The Single and the Show one dispersion curve buttons display one dispersion curve in red. Next 

(three) curves and the Show next dispersion curve button display one curve in red with the down-

line adjacent curve in green and the up-line adjacent curve in blue for a total of three curves. The 

All curves and the Show all dispersion curves buttons display all curves starting with red, blue, 

and green, with the rest unique in color but undefined. They are undefined since with all curves 

displayed, it is the overall trend that is meant to be discerned, not the individual curves. 

 

You may also set a customized number of curves by checking the Option radio button and 

entering a number. You may scroll through the curves using the  buttons. 

 

Shift allows the curves to be bulk shifted by the value entered.  

 

If Show quality is checked (the default), a dashed quality curve is displayed with each dispersion 

curve. The quality curve is a relative indicator of the quality of the data points that define a 

dispersion curve and corresponds with data point circle size as shown below. If all data points 

are high quality (large circles), the curve is predominantly flat. However, due to variation in the 

signal-to-noise ratio, the quality curve will have peaks and valleys correlating with the relatively 

higher and lower quality data points (smaller circles), respectively.   
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Figure 159: Phase velocity plot with quality curve. 

 

For display of a Single, Next (three) curves, or All curves, the quality curve has the same colors 

as the associated dispersion curves. Refer to Sections 7.5.8 and 7.5.10 starting on Page 444 for 

more information on quality.   

 

7.3.3 FREQUENCY/PERIOD  
 

 
 

 
 

The function Frequency/period and the Frequency/period  button allow toggling the view of 

the dispersion curve between frequency (cycles per second) and period (seconds), the inverse of 

frequency.  

 

 

Figure 160: Phase velocity vs. frequency (left) and phase velocity vs. period (right). 
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It may be more intuitive to think in terms of seconds, which directly relates to the natural period 

of buildings, etc.  

 

7.3.4 3D GRID/RANDOM 
 

                          
 

 
 

 

Items in this menu are covered in this tutorial. If your question is not covered in the tutorial, 

please contact us at support@seisimager.com. 

 

7.3.4.1 GEOMETRY 
 

 
 

 
 

 
 

 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.2 GEOMETRY WITH PHASE VELOCITY 
 

 
 

 
 

 
 

 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 

 

7.3.4.3 GEOMETRY WITH S-WAVE VELOCITY 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.4 GEOMETRY WITH AVS30M (100 FT) 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 

 

7.3.4.5 GEOMETRY WITH RMSE 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.6 GEOMETRY WITH HVSR PEAK FREQUENCY 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 

 

7.3.4.7 GEOMETRY WITH HVSR PEAK AMPLITUDE 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.8 GEOMETRY WITH HVSR PEAK CLARITY 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 

 

7.3.4.9 GEOMETRY WITH ELEVATION 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.10 GEOMETRY WITH J-SHIS GEOMORPHOLOGIC CLASSIFICATION 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.11 GEOMETRY WITH AVS30M BASED ON J-SHIS GEOMORPHOLOGIC 

CLASSIFICATION 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.12 GEOMETRY WITH GSI GEOMORPHIC CLASSIFICATION 
 

 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 

 

7.3.4.13 BACKGROUND 
 

 

                                   
 

                       
 

 
 

Continue. 
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7.3.4.13.1 NONE 
 

 
 

 
 

 
 

 
 

 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 

 

7.3.4.13.2 ELEVATION (GSI) 
 

 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.13.3 GSI GEOMORPHOLOGIC CLASSIFICATION 
 

 

 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 

 

7.3.4.13.4 J-SHIS GEOMORPHOLOGIC CLASSIFICATION 
 

 
 

 
 

 
 

 
 

 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.14 SET UP COLOR 
 

 
 

 
 

 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.15 SHOW SITE NAME 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.16 SAVE GEOMETRY TO A KML FILE 
 

 
 

 
 

 
 

See tutorial. If your question is not covered in the tutorial, please contact us at 

support@seisimager.com. 
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7.3.4.17 ADVANCED OPTIONS 
 

                                                  
 

                                      
 

 
 

Continue. 

 

7.3.4.17.1 CIRCLE SIZE 
 

 
 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.3.4.17.2 CIRCLE OUTLINE 
 

 
 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.3.5 SHOW ONE , NEXT , AND ALL  DISPERSION CURVES 
 

 
 

 
 

Show one dispersion curve, Show Next (three) dispersion curves, and Show all dispersion curves 

are the menu items associated with the button bar functions described in Section 7.3.2, Page 344. 

Choosing these menu items overrides the settings in the menu described in Section 7.3.2. 

 

7.3.6 SHOW DISPERSION CURVES (OPTION) 
 

 
 

 
 

If you set a custom number of dispersion curves to be displayed (see Section 7.3.2, Page 344), 

choose Show Dispersion Curves (Option) to display the custom number of curves. 
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7.3.7 SHOW AMPLIFICATION  
 

 
 

 
 

 

When displaying the H/V curve, you may show the ground amplification curve by choosing 

View | Show Amplification or by pressing the  button: 

 

Figure 161: H/V curve (purple) with ground amplification plot (dark green).  
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7.3.8 SHOW P-WAVE VELOCITY 
 

 
 

 
 

This toggle switch enables the display of the p-wave velocity profile.  A green curve is displayed 

for Vp and the horizontal axis will include a second scale corresponding to the Vp values. 

 

7.3.9 SHOW CONVERTED N-VALUE 
 

 
 

 
 

To display the converted N-value, click on Show converted N-value. A red curve is displayed for 

the N-values and the horizontal axis will include a third scale corresponding to the N-values. 
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Figure 162: Vs curve with p-wave velocity (green) and blow count overlain. 

 

The Vp values and N-values are calculated using the equations defined in the Velocity model 

menu, under Advanced options | Vp and VS relationship and Advanced options | N and VS 

relationship. Refer to Section 7.6.13.2 on Page 465 for more information.  
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7.3.10 OPEN N-VALUE FILE 
 

 
 

 
 

Measured N-values can be used to define the initial VS model used for inversion. The values are 

formatted in a space- or tab-delimited text file with a depth and corresponding N-value in each 

row. The file can have the extension .n or .txt.  
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Once the file is prepared, select Open N-value file, highlight the file, and press Open. If it has the 

extension .txt, you will need to choose All files under Files of type, so it is shown in the list.  
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The N-values are stored in memory until the initial VS model is created, at which time the initial 

model will be displayed with the N-values. When an N-value file has been opened, by default the 

initial model will be based on the N-values. Refer to Section 7.7.1, Page 479, for more 

information. 

 

 

Figure 163: Initial VS model with N-values. 
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7.3.11 SHOW N-VALUE 
 

 
 

 
 

To toggle between viewing the VS curve with and without N-values, select Show N-value.  
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7.3.12 OPEN PS RESULT FILE 
 

 
 

 
 

Once a velocity model exists, measured Vp and VS values can be input for comparison or to 

refine the model. The values need to be formatted in a space- or tab-delimited text file with a 

depth and corresponding Vp and VS values in each row. The file can have any extension. 

 

 

Table 13: PS result file. 

 

Once the file is prepared, select Open PS result file, highlight the file, and press Open.  
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7.3.13 SHOW PS RESULT 
 

 
 

 
 

To toggle between viewing the model with and without the measured Vp and VS data, select 

Show PS result.  
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7.3.14 SHOW AVS FOR IBC 
 

 
 

 
 

To calculate the average VS as defined by the 2000 and 2003 International Building Code (IBC) 

in Section 1615.1.5, Equations 16-22 and 16-44, respectively, select Show AVS for IBC. The 

calculated average VS is shown at the bottom of the velocity model in the applicable units.  



The WaveEq Module Functions 
 

 

372 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

Figure 164: VS model with AVS shown at bottom. 

 

The result is saved to a text file with the name AVS.txt in the dataset directory. The first row 

reports the applicable units and maximum depth used for the calculation. Following are six 

columns of data, one row for each layer. The columns from left to right are: layer number (No.), 

shear-wave velocity (VS), slowness (sl) (the inverse of velocity), layer thickness (d), layer 

thickness divided by VS (Tot. VS), and total thickness (Tot. d). The last row reports the IBC 

VS100/UBC VS30 value. In this example, the second layer (No. 1) is 3.132-feet thick (d) with a 

layer thickness-to-VS ratio of 13.024 seconds (Tot. VS), and the total depth at the base of this 

layer is 7.692 feet (Tot. d). 
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Table 14: AVS.txt. 
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The average N as defined by the 2000 and 2003 International Building Code (IBC) in Section 

1615.1.5, Equations 16-23 and 16-45, respectively, will also be calculated if you have opened an 

N-value file.  

 

 

Figure 165: VS model with N-values. 

 

The result is saved to a text file with the name AN.txt in the dataset directory. There are five 

columns of data, one row for each layer. The columns from left to right are: layer number (No.), 

the N-value (N), layer thickness (d), total thickness (Tot. d), and layer thickness divided by the 

N-value (Tot. d/n). The last row reports the IBC N100/UBC N30 value. In this example, the 

second layer (No. 1) is 0.2 meters thick (d) with a layer thickness-to-N ratio of 0.1 (Tot. d/n), and 

the total depth at the base of this layer is 0.4 meters (Tot. d). 
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Table 15: AN.txt. 

 

If the average VS and N are to be calculated, it is recommended that there be reliable information 

to 30 m or 100 ft. Although the VS model may extend to 30 m or 100 ft depth, the recorded 

surface waves may not have actually sampled to that depth. Refer to Section 7.3.15 on how to 

estimate the depth of penetration.   
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7.3.15 SHOW WATER TABLE DEPTH 
 

 
 

 
 

To show the depth of the water table on a velocity model, select Show water table depth. A blue 

line with the standard water table symbol will appear as shown below. If there is no water table 

depth established, the line will plot at a depth of zero. The depth of the water table is set in a 

separate menu explained in Section 7.6.8, Page 454. 
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Figure 166: Velocity model showing water table. 
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7.3.16 SHOW LAYER BOUNDARY  
 

 
 

 

Selecting Show layer boundary or pressing the Correct velocity model  button will outline the 

layers in the profile with horizontal black lines. Using the mouse, the vertical edge of any of the 

layers can be dragged to a new position to modify the VS curve. In the dispersion curve view, the 

dispersion curve calculated for the altered model can be viewed by pressing on the Comparison 

 button. The VS curve can be manually fitted to the observed data in this manner.  
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Figure 167: Vs model with layer boundaries highlighted for editing. 
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7.3.17 SHOW APPARENT VELOCITY MODEL (VR)  
 

 
 

 

Selecting Show apparent velocity model (VR) or pressing the Apparent velocity model  button 

will plot in red points the one-third-wavelength approximation. Using each set of dispersion 

curve points (phase velocity, frequency), the wavelength is calculated (phase velocity divided by 

frequency), and then multiplied by one-third from the empirically determined estimate of depth 

of penetration. At that calculated depth, the associated phase velocity is plotted. This 

approximation is the best indicator of actual depth range of penetration. 
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7.3.18 SHOW EFFECTIVE DEPTH (VR MIN.)  
 

 

 
 

 
 

 

 

Show effective depth (VR min) shades the profile light grey from the surface down to the 

shallowest red point. This setting is on by default to call attention to the limits of the data.  
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7.3.19 SHOW EFFECTIVE DEPTH (VR MAX.) 
 

 
 

 
 

Show effective depth (VR max) shades the profile light grey from the deepest red point downward. 
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7.3.20 SHOW VS AND DEPTH 
 

 
 

 
 

Show VS and depth overlays the layer information used to calculate the IBC VS100/UBC VS30 

value.  
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Figure 168: Vs model of Figure 167 with layer information shown along right axis. 
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7.3.21 SET UP CONSTANT WAVELENGTH LINES 
 

 
 

 
 

If you would like to show lines of constant wavelength on the dispersion curve plot, open the 

View menu and select Setup constant wavelength lines. You will be presented with the following 

dialog: 
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Use the defaults or type in the desired wavelengths in meters, and check the appropriate boxes. 

To set the color of a particular line, press the corresponding  button to display the color 

pallette: 
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Once you are finished setting it up, the lines of constant wavelength will appear on the dispersion 

curve plot: 

 

 

Figure 169: Dispersion curve showing lines of constant wavelength. 
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7.3.22 SHOW STANDARD DEVIATION (H/V) 
 

 
 

 
 

To display the standard deviation of the H/V curve, select View | Show Standard Deviation 

(H/V): 
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Figure 170: H/V plot with standard deviation lines included. 

 

The standard deviation is represented by the grey dotted line above and below the H/V curve. 
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7.3.23 SHOW STANDARD DEVIATION (H/V PEAK) 
 

 
 

 
 

You may display the standard deviation of the H/V peak in a similar fashion: 
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Figure 171: Standard deviation of H/V peak. 

 

Refer to the red arrows in the above figure. The peak of the H/V curve is represented by the thick 

green line. The standard deviation is represented by the thin green lines on either side. 
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7.3.24 SHOW UNCERTAINTY (VELOCITY MODEL) 
 

 
 

 
 

If you have used a Genetic Algorithm to create your model, you may show the uncertainty in the 

VS profile with this feature, as shown below. 
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Figure 172: VS model showing uncertainty in velocities. 
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7.3.25 SHOW REFERENCE VELOCITY MODEL 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.3.26 TRUNCATE BOTTOM LAYER 
 

 
 

 
 

Oftentimes, the bottom layer of the velocity model is much thicker than necessary. Choosing the 

option will reduce the thickness to a more reasonable value. 

  



The WaveEq Module Functions 
 

 

396 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

7.3.27 ADVANCED OPTIONS 
 

                                       
 

 
 

Many of the items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.3.27.1 SHOW VR40 (M) 
 

 
 

 
 

 
 

VR40 approximates VS30 but is based on wavelength rather than depth in meters. 

 

7.3.27.2 OPEN BORING XML 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.3.27.3 SHOW SOIL COLUMN 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.3.27.4 SHIFT BORING DEPTH 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.3.27.5 SHOW BEDROCK VELOCITY 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.3.27.6 SHOW DISPERSION CURVE QUALITY 
 

 
 

 
 

 
 

This is the same as described in Section 7.3.2 on Page 344. See Figure 159: Phase velocity plot 

with quality curve. 

 

7.3.27.7 MONOCHROME BACKGROUND 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.3.28 ALMIGHTY 
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The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

 

7.3.28.1 SHOW SPAC 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.3.28.2 SHOW REGRESSION LINE 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

 

 

 

 

 

 

 

  



The WaveEq Module Functions 
 

 

400 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

7.4 H/V CURVES MENU 
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7.4.1 SMOOTHING 
 

 
 

 
 

The theoretical H/V curve is generally smooth. Observed data is, however, noisy and, as such, it 

is often difficult to define a peak frequency of H/V. Smoothing can help to define a stable peak 

frequency. WaveEq can apply a Parzen window to smooth the observed H/V curve. Select 

Smoothing to apply the Parzen window. Set the window band for the Parzen window. A larger 

window band yields a smoother H/V curve. The default value is suitable for most cases. 

 

 

Figure 173: Raw H/V data. 

 

 
 

Below is an example of H/V curve using a Parzen window with a bandwidth of 0.5 Hz. 
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Figure 174: Smoothed H/V data. 

 

7.4.2 RESAMPLING (EVERY OTHER) 
 

 
 

 
 

Use this function when an inversion of H/V will be done. The frequency interval (∆f) of H/V 

data is defined by the length of the time domain waveform data used for calculation of the FFT. 

The equation is: 

 

 , 

 

where T is the length of the FFT calculation (in seconds) and is the same as the data length of 

one file (discontinuously recorded data as a SEG2 file) or one block (continuously recorded 

data).  

 

The number of H/V data points is half of the number of data samples of one file or one block. 

 

The number of observed data is generally more than several hundred and is too large to apply an 

inversion. You must therefore resample the data before applying the inversion. Keep the number 

of samples to less than 100 if an inversion will be applied. 

 

To resample the H/V data, select Resampling (every other). You may do this several times. 

Below is an example of resampled data after being resampled several times: 
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Figure 175: Resampled H/V curve. 

  

7.4.3 DELETE DATA POINTS OUTSIDE OF GATE 
 

 
 

 
 

H/V data outside of the frequency of interest is meaningless and it is better to remove it. To 

remove the unwanted H/V data, select Delete data points outside of gates or press Ctrl+X. 

 

Follow the instructions in the upper left-hand corner of the window. The red gate is the active 

gate.  
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Figure 176: Using gate to trim H/V curve. 

 

Use the right and left arrow key to position the left-hand gate at the frequency below which you 

wish to delete data. Then press the Enter key to activate the right-hand gate and position it the 

same way using the arrow keys. 

  

 

Figure 177: Using gate to trim H/V curve. 

 

Press the Enter key to delete the data.  
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Figure 178: Trimmed H/V curve. 

 

7.4.4 SET MIN. AND MAX. FREQUENCY TO PICK PEAK H/V [CTRL+H] 
 

 
 

 
 

This defines the frequency range in which the H/V peak frequency will be picked. Set the gate as 

described above for deleting data. The frequency range will be indicated by two orange vertical 

lines: 

 

 

Figure 179: Defining frequency range of H/V peak. 
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7.4.5 INTERPOLATION 
 

 
 

 

 
 

Interpolation is just another way of reducing the number of data points making up the H/V curve. 

Unlike resampling (described above), interpolation does not preserve the original frequency 

content. Generally, this is not important, but some practitioners prefer to do so. Either way is 

acceptable in most cases. 

 

When you choose Interpolation, you will be asked for an integer. This is the number of data 

points that will be left in the H/V curve after interpolating. 

 

 

Figure 180: Raw, un-interpolated H/V curve. 
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Figure 181: Interpolated H/V curve. 

 

7.4.6 AVERAGE SAME FREQUENCY DATA 
 

 
 

 

 
 

When doing a site assessment, it is not uncommon to conduct multiple soundings. It is 

sometimes desirable to take the average of all those soundings, particularly if they are relatively 

close to each other. To do so, read in the first H/V curve. When prompted, select New data: 
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Next, read in the rest of the curves that you would like to average together, but select Append to 

present data for each one. The various H/V curves will be displayed together on the same plot: 

 

 

Figure 182: Two H/V curves plotted together. 

 

In the above plot, two H/V curves have been read in. To average them, select H/V curves | 

Average same frequency data. The various curves will be averaged, and the average curve will 

be displayed: 

 

 

Figure 183: Average of H/V curves shown in Figure 182. 
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7.4.7 MHVR TO EHVR 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.4.8 INITIAL MODEL (2 LAYER MODEL) 
 

 
 

 
 

To make an initial velocity model for the H/V analysis, select H/V Curves | Initial model (2 

Layer Model). The initial model is a two-layer velocity model. Set the S-wave velocity for the 

first layer (VS1).  

 

 
 

Depth to a second layer (D2) is calculated with a peak frequency of H/V (f) as follows: 
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. 

 

The S-wave velocity for the second layer (VS2) is automatically set to triple that of VS1. Press OK 

and the initial S-wave velocity model is displayed. 

 

 

Figure 184: Initial S-wave velocity model. 

 

Note: If you only see a single layer, you may need to adjust the vertical axis. Click on View | 

Axis configuration and increase the Y-axis maximum. 

 

Note that an inversion using only H/V data is essentially non-unique and unstable. Do not rely on 

the inversion of H/V data alone; we recommend incorporating other information, such as phase 

velocity data, drilling logs, and geological information. 
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7.4.9 INITIAL MODEL (FROM 3D MODEL DATABASE) 
 

 
 

 
 

This creates an initial model based on the 3D community velocity models. It is only available in 

Japan and in the San Francisco Bay and Los Angeles areas of the United States. Contact 

support@seisimager.com for assistance.  

 

7.4.10 INITIAL MODEL (FROM K-NET/KIK-NET DATABASE) 
 

 
 

 

 
 

This creates an initial model based on K-Net/KiK-net Database developed by Kyoto University. 

Contact support@seisimager.com for assistance.  
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7.4.11 INITIAL MODEL (FROM DOWNHOLE SEISMIC) 
 

 
 

 

 
 

To make an initial velocity model for H/V analysis based on seismic logging, select H/V Curves | 

Initial model (from downhole seismic). An XML file saved by SeisImager/DH (PSLog) can be 

used as a velocity model. Highlight the file and press Open. 

 

 
 

The number of layers in the model will be displayed. Press OK to confirm. 
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The velocity model will be displayed. 

 

 

Figure 185: Initial velocity model from downhole survey. 
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7.4.12 COMPARISON  
 

 
 

 

 
 

To calculate and overlay a theoretical H/V curve over an observed H/V curve, select H/V Curves 

| Comparison or press the Calculate theoretical dispersion curves  button. The calculated 

curve is shown as a black line. To remove the calculated H/V curve from the display, press the 

Calculate theoretical dispersion curves button again.  
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Figure 186: Theoretical (black) vs observed H/V curve. 

 

7.4.13 COMPARISON (FOR ALL DATA) 
 

 
 

 

 



The WaveEq Module Functions 
 

 

416 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.4.14 CALCULATE THEORETICAL EHVR 
 

 
 

 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.4.15 INVERSION 
 

                                       
 

 

 
 

H/V Curves | Inversion includes functions for the inversion of H/V data. There are several 

different inversion methods to choose from. Use an appropriate method depending on observed 

data, site conditions, and investigation purposes. Remember, the inversion of H/V data is 

unstable compared to the inversion of dispersion curve data. We suggest using a small number of 

iterations and checking the validity of the results carefully.  

All inversion functions may be carried out with data from the fundamental mode only or the 

fundamental and higher mode H/V curves. Inversions use only the fundamental mode when the 

 button is selected and use both fundamental and higher modes when the  button is 

selected. 

 

Joint inversions of a dispersion curve and an H/V spectrum may be performed if the user has 

phase velocity and H/V measurements. Use functions in MASW (1D) | Advanced inversion to 

perform the joint inversion functions.  

 

An example of observed and theoretical H/V data (left) and initial velocity model (right) will be 

used in the following discussion. The initial model (Model A) is a six-layer model. The 

theoretical H/V data is calculated for the initial model. 

 

 

Figure 187: Observed and calculated H/V curve (left) and initial velocity model. 
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7.4.15.1 PEAK ADJUSTMENT 
 

 
 

 

 
 

 

 
 

You may fine-tune the VS model by adjusting it so that the calculated H/V peak is equal to the 

observed peak. To do so, read in the H/V curve. Press  to display the velocity model: 

 

 

Figure 188: VS model. 

 

Note that in this case the layer boundary before adjustment is at 15.6 meters. Now, press  to 

display the measured H/V curve: 
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Figure 189: H/V curve for velocity model shown in Figure 188. 

 

Next, press  to display the theoretical H/V curve: 

 

Figure 190: Measured and calculated H/V peaks. 

 

Note the frequency offset between the calculated and measured peaks. Now, select H/V Curves | 

Inversion | Peak adjustment. You will be presented with the following dialog:  
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While this number may range from ~20-40 meters, the default value of 30 meters will be 

sufficient for 90% of cases. Contact support@seisimager.com if you need assistance with this 

parameter. 

 

Press OK and the VS model will be modified such that the calculated H/V peak matches the 

measured H/V peak: 

 

 

Figure 191: Adjusted H/V curves. 

 

The adjusted VS model is displayed below. Compare to the original above. 

 



The WaveEq Module Functions 
 

 

421 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

Figure 192: Adjusted velocity model. 

 

7.4.15.2 LSM (VS ONLY) 
 

 
 

 
 

 
 

An S-wave velocity model is estimated by non-linear least square methods, and layer thickness is 

held constant under this inversion process. Observed data in the inversion is H/V data, and 

unknown parameters in the inversion are S-wave velocity of each layer. 

 

Set the number of iterations for the inversion. The default value of 5 for Iteration is suitable for 

most cases. 
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An example of an inverted result is shown below. Error between observed and thoretical H/V is 

smaller than for the initial model (Model A, Page 417). 

 

 

Figure 193: Measured and calculated H/V peak (left) and Vs model (right). 
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7.4.15.3 INVERSION WITH EHVR 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.4.15.4 GA (VS ONLY) 
 

 
 

 
 

 
 

In this case, the S-wave velocity model is estimated by a Genetic Algorithm (See Sections 

5.2.1.4 through 5.2.1.6 starting on Page 201 for a deeper discuss of GA.) Observed data in the 

inversion are absolute H/V values and peak frequency of H/V spectrum. Unknown parameters in 

the inversion are the S-wave velocity of each layer.  

 

Set the parameters for the Genetic Algorithm. The default values (Iteration=50, Population=50, 

Binary digits=5, Crossover probability=0.5, Mutation probability=0.5) are suitable for most 

cases. Press the OK button to proceed. 
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Set the parameters for constraints depending on the site conditions. (Contact 

support@seisimager.com for assistance.) Press the OK button to proceed.  
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Set the weight for observed data. The default value of 0.01 for Peak frequency is suitable for 

most cases. Press OK to start the inversion. 
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An example of the inverted the result is shown below. The error between observed and thoretical 

H/V is smaller than the initial model (Model A, Page 417). 

 

 

Figure 190: Measured and calculated H/V peak (left) and Vs model (right). 
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7.4.15.5 GA (THICKNESS ONLY) 
 

 
 

 
 

 
 

 

Here, the S-wave velocity model is estimated by a Genetic Algorithm. Algorithm (See Sections 

5.2.1.4 through 5.2.1.6 starting on Page 201 for a deeper discuss of GA.) Observed data in the 

inversion are absolute H/V values and peak frequency of the H/V spectrum. Unknown 

parameters in the inversion are thickness of each layer. Thickness of layer is difficult to estimate 

compared with S-wave velocity. Keep the number of layers as small as possible. A two-layer 

model is used as the initial model (Model B).  

 

Figure 194: Measured and calculated H/V peak (left) and Vs model (right). 

 

Set the parameters for constraints depending on the site conditions. Press the OK button to 

proceed. (Contact support@seisimager.com for assistance). 
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An example of the inverted result is shown below. Error between observed and thoretical H/V is 

smaller than the initial model (Model B). 
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Figure 195: Measured and calculated H/V peak (left) and Vs model (right). 

 

7.4.15.6 GA (VS AND THICKNESS) 
 

 
 

 
 

 
 

The S-wave velocity model is estimated by a Genetic Algorithm. Algorithm (See Sections 

5.2.1.4 through 5.2.1.6 starting on Page 201 for a deeper discuss of GA.) Observed data in the 

inversion are absolute H/V values and peak frequency of the H/V spectrum. Unknown 

parameters in the inversion are thickness and S-wave velocity of each layer. Estimating thickness 

and S-wave velocities simultaneously is difficult compared with the inversion estimating S-wave 

velocity only. Keep the number of layers as small as possible. The two-layer model (Model B) 

mentioned in the previous section is used as an initial model.  
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An example of the inverted result is shown below. Error between observed and thoretical H/V is 

smaller than the initial model (Model B). 
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Figure 196: Measured and calculated H/V peak (left) and Vs model (right). 

 

7.4.16 INTERPRETATION 
 

                              
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.4.16.1 EXTRACT BEDROCK DEPTH 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.4.16.2 HVSR AND BEDROCK DEPTH RELATIONSHIP 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.4.16.3 AVERAGE 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.4.17 ADVANCED OPTIONS 
 

                                            
 

 
 

The item in the following sub-menu is rarely used, and when it is, support from Geometrics is 

generally required. 

 

7.4.17.1 SESAME CRITERIA 
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This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.5 DISPERSION CURVES MENU  
 

 

 
 

The Dispersion curves menu allows various editing of dispersion curves, including data point 

deletion and curve smoothing. Editing can be particularly important to remove outlying data 

points, noisy jitter, higher modes, etc. Relatively small-scale anomalies on dispersion curves 

cannot be resolved by the surface wave method, and they can cause instabilities in the inversion 

and/or unrealistic aspects in the final results. The overall trend of the dispersion curve(s) should 

be preserved in the editing process.  

 

 

 

Figure 197: Raw dispersion curve (left) and smoothed dispersion curve (right). 
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7.5.1 SMOOTHING (INDIVIDUAL CURVES) 
 

 
 

 
 

To smooth one dispersion curve, select Smoothing (individual curves). The process recalculates 

one individual dispersion curve using the average of three adjacent data points in the direction of 

frequency. The original dispersion curve (shown on left) is converted to a smoother curve with 

less noisy jitter and the data points evenly distributed (shown on right). 

  

When applied to a 2D dataset with multiple dispersion curves, the process acts on each 

individual curve. All the original curves (shown on left) are converted to smoother curves with 

less noisy jitter and the data points evenly distributed (shown on right). 

 

 

Figure 198: Raw dispersion curves (left) and smoothed dispersion curves (right). 

 

Since Smoothing (individual curves) is applied in the direction of frequency, you may find that 

for some 2D datasets, a smoothing function applied from curve to curve yields preferable results.  

 

7.5.2 SMOOTHING (2D MEDIAN FILTER) 
 

 
 

 
 

To smooth between dispersion curves in a 2D dataset, select Smoothing (2D median filter). This 

process recalculates the set of dispersion curves using the median of five adjacent data points 

from curve to curve. The original dispersion curves (shown on left) are converted to smoother 

curves with fewer outlying data points and the relative difference between individual curves 

preserved (shown on right).  
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Figure 199: Raw dispersion curves (left) and filtered dispersion curves (right). 

 

 

7.5.3 INTERPOLATION 
 

 
 

 
 

If the dispersion curve is oversampled, resulting in a large number of phase velocities, the 

inversion can take a long time. It is sometimes advantageous to resample and interpolate the 

dispersion curve prior to doing the inversion. To do so, read in the dispersion curve. 

 

Figure 200: Raw dispersion curve. 

 

Select Dispersion curves | Interpolation. You will be presented with the following dialog: 
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The smaller the number, the fewer the points in the resampled curve. For instance, in this case, to 

reduce the number of points by ½, enter 100. The resampled dispersion curve is shown below. 

 

 

Figure 201: Interpolated dispersion curve. 
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7.5.4 AVERAGE SAME FREQUENCY DATA 
 

 
 

 
 

You may average dispersion curves together using the following procedure. Read in and display 

a dispersion curve. Next, read in and append the rest of the curves you wish to average together. 

With each appended curve, you will be prompted to average them: 

 

 
 

If you know that you do not want to edit the curves before averaging them, press Yes. On the 

other hand, if you wish to view and/or edit the curves prior to averaging them, press No. 

 

In this example, we have read in two dispersion curves, as shown below. 
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Figure 202: Two dispersion curves to be averaged together. 

 

When asked if we wanted to average them, we chose No. Now we have a chance to edit them if 

necessary. When we are ready to average them together, we select Dispersion curves | Average 

same frequency data and the two curves will be averaged and displayed: 

 

 

Figure 203: Frequency-averaged dispersion curves of Figure 202. 
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7.5.5 DELETE PICKS BY VALUE 
 

 
 

 
 

To set the minimum and maximum gate frequencies by entering specific values, select Delete 

picks by value.   

 

 
 

 

7.5.6 DELETE PICKS OUTSIDE OF GATE [CTRL+X] 
 

 
 

 
 

As an alternative, the frequency range can be set visually. Select Delete picks outside of gate and 

two gates will appear on the dispersion curve plot (shown on left in Figure 204). If needed, press 

the Esc key to exit.  

 

Red indicates which gate is active and green indicates which gate is inactive. Use the right and 

left arrow keys to move the red gate to the new minimum frequency (shown on right in Figure 

204).  
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Figure 204: Using gate to trim ends of dispersion curve. 

 

After the first gate is positioned, press the Enter key and the next gate will become active. Use 

the arrow keys to move the gate to the new maximum frequency (shown on left in Figure 205). 

Press the Enter key when done and the trimmed dispersion curve is displayed (shown on right in 

Figure 205).  

 

 

Figure 205: Trimmed dispersion curve (right). 

 

In setting the gates, exclude only the points that are poor quality or spurious. Commonly, on the 

low frequency end, the phase velocity will begin to decrease, and the dispersion curve will slope 

downward (when phase velocity is plotted on the y-axis). This decrease in phase velocity is 

usually an artifact of difficult picking because the peak amplitudes at low frequencies become 

less distinct.  

 

Note: Hold down the Shift key to fine tune the gate settings. 
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To determine where to set the new maximum frequency on the high frequency end, the quality 

line can be used to assess where the quality starts to decrease (usually due to weak amplitudes at 

higher frequencies). In addition to quality, if the phase velocity starts to increase, that is likely 

related to higher mode energy and those points should be deleted.  

 

7.5.7 DELETE PICKS BETWEEN GATE [CTRL+B] 
 

 
 

 
 

To remove points within a gate, select Delete picks between gate. The gates are positioned as 

described for Delete picks outside of gate, except that the inactive gate is indicated by teal blue.  
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Figure 206: Removing spurious data (in this case, higher mode) from dispersion curve. 

 

7.5.8 DELETE LOW QUALITY DATA  
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To automatically delete low-quality picks, select Delete low quality data. Low quality tolerance 

is set under Advanced options | Setup low quality limit. Refer to Section 7.5.10, Page 444, on 

how to adjust the quality tolerance.   

 

Upon selection, all the points that fall below the quality limit will be deleted (shown on right 

below). To reverse the changes, press the Undo  button.  

 

 

 

Figure 207: Removing low-quality data from dispersion curve. 

 

 

7.5.9 DELETE HIGHER MODE 
 

 

 
 

 
 

If higher mode picks appear in the dispersion curve (shown on left below), select Delete higher 

mode to automatically delete the picks (shown on right below). Higher mode tolerance is set 

Low 

quality 
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under Advanced options | Setup higher mode selection. Refer to Section 7.5.10, Page 444, on 

how to adjust the higher mode tolerance. 

 

 

 

Figure 208: Removing higher mode points from dispersion curve. 

 

 

7.5.10 ADVANCED OPTIONS 
 

                                
 

 
 

Continue. 
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7.5.10.1 SMOOTHING (MULTIPLE CURVES) 
 

 

 
 

 
 

 
 

 

 

To smooth between dispersion curves in a 2D dataset, select Smoothing (multiple curves). The 

process is similar to Smoothing (2D median filter) (Section 7.5.2, Page 434), except that the 

average of five adjacent data points is used instead of the median. The original dispersion curves 

(shown on left below) are converted to smoother curves with fewer outlying data points but the 

relative difference between the individual curves is minimized (shown on right below).   

 

 

Figure 209: Smoothing dispersion curves. 

 

 

7.5.10.2 RESAMPLING (EVERY OTHER) 
 

 

 
 

 
 

 
 

Resampling (every other) is used to speed up processing by decimating the dataset (removes 

every other sample).  
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7.5.10.3 SET UP LOW QUALITY LIMIT 
 

 

 
 

 
 

 
 

 

Setup low quality limit allows the filter limit that is used when the function Delete low quality 

data is selected to be set. Quality is a relative measurement normalized against the highest signal 

for each dataset. Quality is indicated by the quality line and the data point circle size on the 

dispersion curve plot. The largest circle size possible is equal to 1.0 and the smallest circle size 

possible is a dot, which equals zero. The default Quality limit value is 0.7, meaning that where 

the quality line goes below 70% of the relative scale, the associated data points will be deleted. 

The default Quality limit value is suitable for most cases.  
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7.5.10.4 SETUP HIGHER MODE SELECTION 
 

 

 
 

 
 

 
 

 

Setup higher mode selection allows the filter limits used when the function Delete higher mode is 

selected to be set. The default Fundamental mode limit value is 1.2, meaning that where the 

value of any data point is 20% more than adjacent values, those points are deleted. This value 

can be set between 1.0 and 5.0. The Higher mode maximum depth is the depth as determined 

from the one-third-wavelength approximation, below which the associated data points will not be 

allowed.  
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7.6 VELOCITY MODEL MENU 
 

The Velocity model menu allows editing and setting of parameters for calculation of velocity 

models. In addition, it includes display controls and some analyses for interpretation.  

 

 

 
 

 

7.6.1 HORIZONTAL SMOOTHING (2D) 
 

 

 
 

 
 

To horizontally smooth between individual velocity models in a 2D dataset, select Horizontal 

smoothing (2D). The process recalculates the set of velocity models using the average of three 

adjacent data points from model to model. Any sharp lateral velocity gradients between the 

original velocity models are smoothed.  
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7.6.2 HORIZONTAL SMOOTHING (3D) 
 

 

 
 

 
 

 

Horizontal smoothing (3D) is a highly specialized and rarely used feature. Please contact 

support@seisimager.com for assistance. 

 

 

7.6.3 VERTICAL SMOOTHING 
 

 

 
 

 
 

To vertically smooth individual velocity models in a 2D dataset, select Vertical smoothing. The 

process recalculates individual velocity models using the average of three adjacent data points in 

the direction of depth. Any sharp vertical velocity gradients in the original velocity model are 

smoothed. 

 

7.6.4 SHOW VELOCITY MODEL , SHOW THREE MODELS , SHOW 

ALL MODELS   
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Once a velocity model exists, Show velocity model , Show three models , and Show all 

models  are used to control the display.  

 

Show velocity model and the associated button display one velocity model in black with grey 

shading. Show three models and the associated button display one model in red with the down-

line adjacent model in green and the up-line adjacent model in blue for a total of three models. 

Show all models and the associated button display all models starting with red, blue, green, and 

with the rest of the colors unique but undefined. They are undefined since with all models 

displayed, it is the overall trend that is meant to be discerned, not the individual models.  

 

The Show velocity model button is useful for toggling from the dispersion curve to velocity 

model view.  

 

7.6.5 SHOW MODELS (OPTION) 
 

 

 
 

 
 

Section 7.3.2 (Page 344) describes how you may customize the number of dispersion curves that 

are shown at any one time by selecting Option and entering the number of curves. This applies to 

the number of velocity models as well. For instance, if you choose to display five dispersion 
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curves, then selecting Velocity model | Show models (option) will display only the models 

 

Figure 210: Dispersion curves. 

 

for the displayed dispersion curves: 

 

 

Figure 211: Velocity models corresponding to dispersion curves shown in Figure 210. 

 

You may then scroll through the models using the  buttons, the same way you can scroll 

through the dispersion curves. 
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7.6.6 SHOW EQUIVALENT VELOCITY 
 

 

 
 

 
 

You may display the “Equivalent” (average) velocity by toggling this option: 

 

 

 

Figure 212: Velocity model with average velocity curve. 
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7.6.7 EDIT VELOCITY MODEL DATA [CTRL+M] 
 

 

 
 

 
 

If necessary, you may manually edit the velocity model data. Select Velocity model | Edit 

velocity model data: 

 

 
 

Press Refresh depth, Vp and density to update VS and density using the VS-Vp and Vp-density 

relationships. 
 

Check Fix Vp and density to keep Vp and density to the values shown in the dialog. If you 

uncheck this box, Vp and density will be automatically calculated from VS.  



The WaveEq Module Functions 
 

 

454 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

Uncheck Use constant search area in GA if you would like to be able to set the Genetic 

Algorithm search radii individually. This feature is rarely used; contact support@seisimager.com 

for assistance. 
 

Check Velocity increases with depth to force velocities to increase with depth. 

 

Check Initial Model constraints to set the area (+/- 30%) of VS changed in the inversion. 
 

7.6.8 SET UP WATER TABLE 
 

 

 
 

 
 

Once a velocity model exists, the depth of the water table can be set with Setup water table. The 

default Water table value is zero; enter the applicable value and press OK.  

 

 

 
 

The model layer boundaries will be adjusted to place a boundary at the water table depth. Press 

Yes to confirm the change.   

 



The WaveEq Module Functions 
 

 

455 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 
 

The water table is now set. Open the View menu and select Show water table depth to display 

the water table as a blue line with the standard water table symbol on the velocity model.  

 

7.6.9 INSERT NEW LAYER BOUNDARY (BY MOUSE) 
 

 

 
 

 
 

To insert a new layer, select Velocity | Insert new layer boundary (by mouse), and then click on 

the depth at which to insert the layer. Below is an unedited velocity model:  
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Figure 213: VS model. 
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Next is the same model, with a new layer inserted at 14.6 meters:

 

Figure 214: Velocity model of Figure 213 with new layer inserted. 

 

See Section 7.6.7, Page 453, to update the velocity of the new layer. 
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7.6.10 MODIFY VELOCITIES (3D: BY MOUSE) 
 

 

 
 

 
 

This feature allows you to modify velocities in a 3D model. This feature is highly specialized 

and rarely used. Please contact support@seisimager.com for assistance. 

 

7.6.11 SEISMIC INTERPRETATION 
 

                          
 

 
 

Site classification and ground amplification can be displayed for any given velocity model, as 

shown in the following two sections. 
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7.6.11.1 SHOW UBC OR IBC SITE CLASSIFICATIONS 
 

 

 
 

 
 

 
 

In addition to calculating the average VS as described in Section 7.3.14, Page 371, the associated 

site class can also be determined by selecting Show UBC or IBC site classifications. [The UBC is 

the Uniform Building Code (1997) which uses metric units. The IBC (2000, 2003) is based on 

the UBC but uses English units. Refer to Building Seismic Safety Council (1997), International 

Code Council (2000, 2003), and Underwood and Hayashi (2005) for more information.] 

 

Once Show UBC or IBC site classifications is selected, the average VS is calculated and 

displayed with the associated site class (Table 16). 

 

 
 

 

 

Table 16: UBC/IBC Site Classifications. 
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7.6.11.2 1D AMPLIFICATION 
 

 

 

 
 

 
 

 
 

Select Velocity Model | Seismic Interpretation | 1D amplification or press  to calculate the 

amplification of SH waves based on multiple reflections. 

 

An example of amplification for Model B (Page 44) is Model BModel Bshown below. 

Amplification is shown as a thick ocher line on the H/V spectrum display. 

 

 

Figure 215: H/V curve and corresponding amplification curve. 

 

  



The WaveEq Module Functions 
 

 

461 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

7.6.12 VELOCITY MODEL DATABASE 
 

 

                  
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.6.12.1 FIND VELOCITY PROFILE FROM 3D MODEL (JAPAN OR CALIFORNIA) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.12.2 FIND VELOCITY PROFILE FROM 3D MODEL (JAPAN OR CALIFORNIA) 

FOR 2D/3D DATA 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.6.12.3 FIND VELOCITY PROFILE FROM GEOPHYSICAL DATABASE 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.12.4 UPLOAD 1D PHASE VELOCITY CURVE OR H/V SPECTRUM TO 

DATABASE 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.6.12.5 SELECT A SITE FROM GEOPHYSICAL DATABASE 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.12.6 SET UP SEISIMAGER DATABASE 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.6.13 ADVANCED OPTIONS 
 

 
 

7.6.13.1 FIX VP AND DENSITY 
 

 

 
 

 
 

 
 

Fix Vp and Density is rarely used, and when it is, support from Geometrics is generally required. 

Please contact support@seisimager.com for assistance with this function. The same is true for 

the Density option. 
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7.6.13.2 VP AND VS RELATIONSHIP 
 

 

 
 

 
 

 
 

The Vp and VS relationship dialog box allows the equations used for calculating Vp from VS to 

be customized. 

 

To modify the default equations for calculating Vp from VS, select Vp and VS relationship (dialog 

box with metric units selected shown on top, with English units selected shown on bottom). An 

equation may be defined for above and below the water table, with the water table depth set in 

the Velocity model menu in the Setup water table dialog box (Section 7.6.8, Page 454). The 

default equation for above the water table is simply 2VS. The default equation for below the 

water table is from Kitsunezaki (1990). The effect of Vp on phase velocity is typically minimal; 

these relationships are suitable for most models.  
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Relationships can also be manually set by selecting Manual and inputting Vp values through the 

View menu under Open PS result file.  

 

 

 

 

7.6.13.3 DENSITY 
 

 

                                            
 

                                      
 

 
 

This feature defaults to Ludwig (1970) and is rarely changed. Please contact 

support@seisimager.com for assistance. 
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7.6.13.4 N AND VS RELATIONSHIP 
 

 

 
 

 
 

 
 

The N and VS relationship dialog box allows the equations used for calculating N from VS to be 

customized.  

 

To modify the default equations for calculating N from VS, select N and VS relationship (dialog 

box with metric units selected shown on top, with English units selected shown on bottom). The 

default equations are from Imai and Tonouchi (1982). This relationship is suitable for most 

models. 

 

 
 

 
 

Where applicable, the equation used for calculating density is as follows [from Ludwig et al. 

(1970)]. 

 

ρ = 1.2475 + 0.399Vp – 0.026Vp
2 

 

To revert to the default values, press Default.  
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7.6.13.5 SHOW DEPTH AXIS 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.13.6 ADD BOTTOM LAYER 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.6.13.7 DELETE BOTTOM LAYER 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.13.8 SHOW GA SEARCH AREA 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 



The WaveEq Module Functions 
 

 

470 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

7.6.13.9 SET UP GA PARAMETERS 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.13.10 SHOW GA RMSE 
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This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.13.11 TRUNCATE MIN. AND MAX. VELOCITY  
 

 

 
 

 
 

 
 

To set a minimum and maximum velocity for a given velocity model, select Truncate min. and 

max. velocity to reveal the following dialog box. 
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Figure 216: VS model. 

 

To set new boundaries, enter new values as desired and press OK. Note that the value entered for 

Max. velocity will be retained for the WaveEq session unless changed again or a new WaveEq 

instance is opened.  
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Figure 217: Truncated version of velocity model shown in Figure 216. 

 

Typically, Truncate min. and max. velocity is used when building an initial model from scratch.  

 

7.6.13.12 HORIZONTAL AVERAGE (2D) 
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To make a cross-sectional velocity model uniform in the direction of distance, select Horizontal 

average (2D). The process recalculates the velocity model using the average value at each depth. 

The original model (shown on left below) with horizontal variation is converted to a simplified, 

horizontally uniform model (shown on right below).  

 

 

Figure 218: Original velocity model (left) and horizontally averaged model (right). 

 

7.6.13.13 SET UP BEDROCK VELOCITY 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.6.13.14 APPLY STANDARD LAYER BOUNDARIES 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.14 ALMIGHTY 
 

 

                                      
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 
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7.6.14.1 SEISMIC INTERPRETATION 
 

 

                               
 

                               
 

 
 

Continue. 

 

 

7.6.14.1.1 1D AMPLIFICATION 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.14.1.2 1D AMPLIFICATION (WAVEFORM) 
 

 

 
 

 
 

 
 

 
 

 



The WaveEq Module Functions 
 

 

477 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.14.1.3 CALCULATE H OVER V FOR ALL MODELS 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.6.14.2 CALCULATE TRAVEL TIME 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.6.14.3 CALCULATE SMOOTHNESS 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7 MASW/MAM (1D) MENU 
 

The MASW/MAM (1D) menu primarily includes functions for calculating an initial model for a 

1D dataset and running the inversion to find the best fit of the modified initial model data with 

the observed data. Other modeling functions are also included. Although the term MASW refers 

to active-source surveys, the same functions apply for analysis of MAM datasets.  
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7.7.1 INITIAL MODEL 
 

 

 
 

 
 

The initial VS model is the starting point for the inversion. To generate an initial model for a 

single dispersion curve, select Initial model. The Initial model for inversion dialog box shows 

only the Depth and Number of layers by default. In most cases, only the maximum Depth of the 

model needs to be entered and the default value of 15 for the Number of layers is suitable.   
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Pressing on Advanced menu reveals the rest of the parameters with default values. Typically, 

none of these settings need to be changed. For help with these parameters, contact 

support@seisimager.com. 

 

 
 

Initial models are calculated using Based on depth conversion result by default. This method 

uses 1.1 times the phase velocity for an estimate of VS and the one-third-wavelength 

approximation for an estimate of depth. The Minimum (phase) velocity and Maximum (phase) 

velocity are automatically assigned, corresponding directly to the low and high values observed 

on the dispersion curve. The Maximum velocity is automatically assigned to the deepest layer. 

 



The WaveEq Module Functions 
 

 

481 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

Figure 219: Initial VS model. 

 

Alternatively, initial models can be constructed using a Linear model, Homogeneous model, or 

using N-values via Use N-value. A Linear model (shown on left below) is constructed following 

a straight line starting at the Minimum velocity and ending at approximately the Maximum 

velocity (the model may not extend to exactly the Maximum velocity depending on the number 

and configuration of layers). A Homogeneous model (shown on right below) has no velocity 

variation with depth; the Minimum and Maximum velocity have the same value. The Show 

apparent velocity model  button provides a visual comparison of the Based on depth 

conversion result model with the Linear model and the Homogeneous model.  

 

 

Figure 220: Linear initial model (left) and homogeneous initial model (right). 

 

To base the initial model on N-values, select Use N-value. The model Depth will be 

automatically set to the deepest N-value. Note that the N-value file must already be open through 

the View menu under Open N-value file. If it is not open, you will be notified. Press OK, open 

the N-value file, and then come back to Initial model.  
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Layer thickness applies to all models. Selecting Identical sets all layers to equal thickness. By 

default, the layer thickness is set to Variable, and thus, layer thickness increases with depth. The 

Layer thickness gradient controls how the thickness increases with depth. A value of 1 means 

there is no gradient and layer thicknesses are identical. A value less than 1 thickens the layers 

with depth and as the value decreases, the gradient of thickening increases. The default value of 

0.5 is suitable for most models.  

 

The Bottom layer multiplier controls the thickness of the bottom layer relative to overlying 

layers. The thickness of the bottom layer, or layer just above the model half-space, can have a 

large impact on the calculated dispersion curve. Setting it thicker than the overlying layers 

stabilizes the inversion, hence the Variable default setting. After the Layer thickness gradient is 

applied, the thickness of the bottom layer is multiplied by the multiplier value. The multiplier 

default value is 3 and is suitable for most models.  

 

To set layer thickness based on N-values, select Based on N-value. As noted above, the N-value 

file must already be open through the View menu under Open N-value file.  

 

To disallow velocity inversions in the final VS model, check Use assumption that velocity is 

increasing with depth. It is common to see small velocity inversions near the surface (especially 

at paved sites), and at the water table due to an increase in pore pressure, and thus, it is suggested 

to leave this setting unchecked. This setting can be useful when you detect higher modes and 

want to suppress their influence on the final result.  

 

For initial cross-sectional models, Apply horizontal interpolation is checked by default to allow 

construction by interpolation between a series of velocity curves.  

 

The Initial model for inversion dialog box settings revert to the default values each time the 

dialog box is opened.  
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7.7.2 INVERSION (LSM) 
 

 

 
 

 
 

To calculate the VS curve that best matches the observed data, select Inversion (LSM). The 

mathematical process is based on the Least-Squares Method and simply stated, iteratively 

modifies the initial model data to minimize the difference from the observed data. After running 

through several iterations, the modified initial model is output as the final model. Refer to 

Hayashi (2003) for a complete explanation. 

 

The following dispersion curve, H/V spectrum, and initial model are used as an example. The 

inversion performed by this menu only changes the S-wave velocity of each layer, and the 

number of layers in the initial model must be large (10 to 20).  

 

 

 

Figure 221: Example dispersion curve, H/V spectrum, and initial model. 
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Upon selecting Inversion (LSM), the Least Squares Method dialog box shows the Iteration 

parameter with a default value of 5.  
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Iteration is the number of times the initial model data will be compared and modified to 

converge on the best match with the observed data. In between iterations, the improved model is 

used as the new starting point, so the error or mismatch should decrease. The iteration concept is 

conveyed by the flow chart below.  

 

 
 

The default Iteration value of 5 is suitable for most cases. Increasing the Iteration value may 

occasionally be necessary; this will allow the process additional attempts to minimize the 

mismatch between the modified initial model data and the observed data.  

 

Set the weight ratio of Phase velocity and H/V in the inversion. Larger values give greater 

weight to dispersion curve data. The default value is 10, and this is suitable for most cases. 

 

 

 
 

Upon pressing OK, the inversion process begins and the error in velocity (m/s or ft/s) and 

percentage (%) is displayed. The error should decrease after each iteration and the final error 

should be less than about 5%, but this will depend on the dataset.  

 

 

Forward modeling
Observed and 
calculated data

Comparison Iteration

Forward modeling
Observed and 
calculated data

Comparison Iteration

  

Figure 222: Iteration flow chart. 
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Figure 223: Iteration process displayed on screen during Least Squares analysis. 

 

Once the inversion is complete, press OK.  

 

 
 

The final error value is saved to a file called RMSE.txt in the dataset directory.  

 

If the error ever increases during the inversion, the process will terminate. The initial model 

settings, inversion parameters, and units selected in the Option menu should be checked and 

modified, if necessary, before running the process again. 

 

An example of the inverted result is shown below. Error between observed and theoretical phase 

velocities and H/V is smaller than that in the initial model (Model C, Page 493).  
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Figure 224: Inverted result. 

  

Pressing on Advanced menu reveals the rest of the parameters with default values. Typically, 

none of these settings need to be changed. 
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The Alpha and Beta settings optimize the matrix inversion through deceleration and acceleration, 

respectively. An Alpha multiplier of the maximum logical value of 1 provides the least 

stabilization. Values less than 1 provide increasing stability but are more computationally 

intensive, and thus, cause the process to run more slowly. A value of zero cancels this factor.  

 

Alpha is so named because it is used in the first iteration to stabilize the inversion. As the process 

stabilizes, Alpha is multiplied by Beta to increase the inversion speed. A Beta value of 1 causes 

no acceleration; values greater than 1 are used for acceleration.  

 

e is a dumping parameter also with the effect of stabilization. e would be increased to increase 

stability.  

 

Regularization is a type of matrix smoothing, working to control large velocity gradients across 

each depth layer. For a higher degree of smoothing and lower tolerance of lateral velocity 

gradients, a lower value would be used. A value of 1 equals no smoothing. All the layers would 

be artificially similar if excessive smoothing was applied.  

 

The values for Alpha, Beta, e, and Regularization rarely need to be changed. Illogical values for 

these parameters will cause erroneous results.  
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Saying Yes to Constraint will use the indicated Minimum (phase) velocity and Maximum (phase) 

velocity to limit the lower and upper bounds of the inversion. This can be useful if you have 

accurate knowledge of velocity, otherwise the default values are automatically assigned 

corresponding directly to the low and high values observed on the dispersion curve. 

 

Weighting for quality incorporates dispersion curve pick quality into the inversion. Robust 

estimation puts less weight on data with large errors. Keep first layer velocity prevents the 

velocity of the shallowest layer from changing. This is useful if the first layer has a high known 

velocity, like pavement.  

 

If Save matrix information is checked, the Jacobian matrix from each iteration is saved to a file 

called Matrix.txt in the dataset directory.  

 

Note that the Least Squares Method dialog box parameters revert to the default values each 

time WaveEq is opened.  

 

7.7.3 INVERSION (LSM, WITH N)  
 

 

 
 

 
 

If N-values are used to construct the initial model, select Inversion with N instead of Inversion. 

The Least Squares Method dialog box settings are the same as those explained in Section 7.7.2, 

Page 483, except that the default value for e equals 0.1 and Regularization equals 0.5.  

 

7.7.4 ADVANCED INVERSION 
 

 

                        
 

 
 

There are many inversion options available. These are illustrated below. 
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7.7.4.1 LSM (THICKNESS ONLY)  
 

 

 
 

 
 

 
 

 

Select MASW/MAM (1D) | Advanced Inversion | LSM (thickness only) to perform an inversion in 

which the thickness of each layer is changed. The following dispersion curve and an initial 

model (Model D) are used as an example. The inversion performed by this menu only changes 

the thickness of each layer and it is better to keep the number of layers small (3 to 7).  

 

 

Figure 225: Example velocity model and dispersion curve. 

 

Set the number of iterations for the inversion. The default value of 5 for Iteration is suitable for 

most cases. 
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An example of the inverted result is shown below. The error between observed and theoretical 

phase velocities is smaller than that in the initial model (Model D). 

 

 

 

Figure 226: Inverted result. 
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7.7.4.2 LSM (VS AND THICKNESS) 
 

 

 
 

 
 

 
 

Select MASW/MAM (1D) | Advanced inversion | LSM (VS and thickness) to perform an inversion 

in which both S-wave velocity and thickness of each layer are changed. The inversion performed 

by this menu changes both S-wave velocity and thickness of each layer and it is better to keep 

the number of layers small (3 to 7). The Initial Model D is used as an example. 

 
Set the number of iterations for the inversion. The default value of 5 for Iteration is suitable for 

most cases. 
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An example of the inverted result is shown below. The error between observed and theoretical 

phase velocities is smaller than that in the initial model (Model D). 

 

 

 

Figure 227: Inverted result. 

 

7.7.4.3 GA (VS ONLY) 
 

 

 
 

 
 

 
 

Select MASW/MAM (1D) | Advanced inversion | GA (VS only) to perform an inversion in which 

only the S-wave velocity is changed. An inversion that only uses a dispersion curve and a joint 

inversion that uses both a dispersion curve and an H/V spectrum can be performed by this menu. 

The inversion applied by this menu changes the S-wave velocity of each layer, and the number 

of layers in the initial model must be large (10 to 20). Model C is used as an example. 
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Figure 228: Example dispersion curve, H/V curve, and VS model. 

 

The dialog box shown below will appear when the data contains both phase velocity and H/V 

data. Press Yes if you intend to apply the joint inversion of phase velocity and H/V data. Press No 

to apply only the inversion of phase velocity data. 

 

 
 

Set the parameters for the Genetic Algorithm. The default values (Iteration=50, Population=50, 

Binary digits=5, Crossover probability=0.5, Mutation probability=0.5) are suitable for most 

cases. Press the OK button to proceed. 
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Set the parameter for constraint based on site conditions. Press the OK button to proceed. 
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Confirm the setup for the inversion. Press OK to continue. 

 

 
 

Set the weight ratio of Phase velocity, H/V and peak frequency of H/V in the inversion. A larger 

value gives more weight to the dispersion curve data. The default values (10 and 0.01) are 

suitable for most cases. 
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An example of the inverted result is shown below. The error between observed and theoretical 

phase velocities is smaller than that in the initial model (Model C, Page 44). 

 

 

 

Figure 229: Inverted result. 

 

7.7.4.4 GA (VS AND THICKNESS) 
 

 

 
 

 
 

 
 

Select MASW/MAM (1D) | Advanced inversion | GA (VS and thickness) to perform an inversion 

in which both S-wave velocity and thickness of each layer are changed. An inversion that only 

uses a dispersion curve and a joint inversion that uses both a dispersion curve and an H/V 

spectrum can be performed through this menu. The inversion performed through this menu 
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changes both S-wave velocity and thickness of each layer, and it is better to keep the number of 

layers small (3 to 7).  

 

A)  Example using the Fundamental Mode 

 

The Initial Model D is used for an example. 

 

 

Figure 230: Example dispersion curve, H/V curve, and VS model. 

 

The dialog box shown below will appear when the data contains both phase velocity and H/V 

data. Press Yes if you intend to apply the joint inversion of phase velocity and H/V data. Press No 

to apply only the inversion of phase velocity data. 
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Set the parameters for the Genetic Algorithm. The default values (Iteration=50, Population=50, 

Binary digits=5, Crossover probability=0.5, Mutation probability=0.5) are suitable for most 

cases. Press the OK button to proceed. 

 

 
 

Set the parameters for constraints based on site conditions. (Contact support@seisimager.com for 

assistance.) Press the OK button to proceed. 
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The WaveEq Module Functions 
 

 

502 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

Confirm the setup for the inversion. Press OK to continue. 

 

 
 

Set the weight ratio of Phase velocity and Peak frequency of H/V in the inversion. A larger value 

gives more weight to dispersion curve data. The default values (10 and 0.01) are suitable for 

most cases. 
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An example of an inverted result is shown below. The error between observed and theoretical 

phase velocities is smaller than that in the initial model (Model D, Page 499). 

 

 

Figure 231: Inverted result. 

 

B)  An example using higher modes. 

 

Press the  button to apply the inversion using higher modes. The Initial Model D is used as 

an example. Press the  button and the theoretical dispersion curves (or H/V) of fundamental 

and higher modes will appear together with averaged (effective mode) or maximum phase 

velocities (or H/V). The inversion takes into account higher modes when the  button is 

pressed. 
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Figure 232: Example dispersion curve, H/V curve, and VS model. 

 

The inversion procedure is exactly the same as the inversion using the fundamental mode.  

 

Make sure it uses higher modes in the dialog box shown below.  

 

 

 
 

You can change the Love/Rayleigh ratio automatically during the inversion.  
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An example of the inverted result is shown below. The error between observed and theoretical 

phase velocities is smaller than that in the initial model (Model D, Page 499). 

 

 

 

Figure 233: Inverted result. 
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7.7.4.5 SHOW ALL THEORETICAL DATA FOR GA MEMBERS 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.4.6 CALCULATE 1D AMPLIFICATION FOR GA MEMBERS 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.7.5 COMPARISON  
 

 

 
 

 
 

 

To calculate and overlay a theoretical dispersion curve on an observed dispersion curve, select 

Comparison or press the Calculate theoretical dispersion curves  button. The calculated curve 

is shown as a black line. To remove the calculated dispersion curve from the display, press the 

Calculate theoretical dispersion curves button again.  

 

7.7.6 SHOW VELOCITY MODEL  
 

 

 
 

 
 

 

To toggle to the velocity model display from the dispersion curve display, select Show velocity 

model or press the Show velocity model  button.  
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7.7.7 VELOCITY MODELING (1D)  
 

 

          
 

 
 

 

Continue. 

 

7.7.7.1 GENERATE NEW VELOCITY MODEL 
 

 

 
 

 
 

 
 

 

A synthetic velocity model can easily be created independent of a waveform file. Modeling can 

be useful for planning a survey, modeling borehole data, or testing and comparing various 

results. To set the parameters for a velocity model, select Modeling (1D) or press the Creating a 

new velocity model for modeling  button.  
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Depth of model is used to indicate the maximum depth of the model. The default Frequency 

range is suitable to simulate depth of penetration from an active-source. If the Depth of model is 

greater than 30 m or 100 ft, correspondingly, the lower-end frequency should be set to 0.2 Hz to 

simulate a greater sampling depth. 

 

The frequency range is divided by the Number of frequency and sets the resolution of the 

dispersion curve. The Number of frequency default value of 60 is suitable for the default 

frequency range. If the frequency range is widened significantly, the Number of frequency should 

also be scaled up accordingly. If you would like to use Love waves in the analysis, check Love 

wave.  

 

Note: Love waves are rarely used in surface wave methods. 

 

Upon pressing OK, the following homogeneous model appears; the associated dispersion curve 

does not yet exist.  
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 Figure 234: Homogeneous model. 

 

To modify the velocity model, press the Correct velocity model  button. Horizontal black lines 

defining the model layers appear. Use the mouse to click on the vertical edge of a layer and the 

selected layer edge will turn red. Drag the edge to the desired velocity.  

 

 

Figure 235: Homogeneous model with layers inserted. 

 

Position the rest of the layers and set the water table if desired.  
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Figure 236: Final model including water table. 

 

Refer to Section 7.7.9, Page 521, to continue modeling by simulating a survey and generating a 

dispersion curve.  

  

 

7.7.7.2 GENERATE NEW VELOCITY MODEL (FROM DOWNHOLE SEISMIC) 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.7.7.3 CONVERT SYNTHETIC DATA TO “OBSERVED” DATA 
 

 

 
 

 
 

 
 

You may convert synthetic data to “observed” data by the following procedure. 

 

Select MASW/MAM (1D) | Velocity Modeling (1D) | Generate New Velocity Model. You will see 

the following dialog box: 

 

 

 
 

 

Set the model parameters as desired and press OK. If necessary, modify the model by adding 

layers (Section 7.6.9, Page 455) and modifying their velocities (Section 7.6.7, Page 453). Once 

the model has been created (see below), press the  button and then the  button. The 

synthetic phase velocity curve will be displayed: 

 



The WaveEq Module Functions 
 

 

513 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

Figure 237: Synthetic dispersion curve. 

 

To convert to “observed” data, select MASW/MAM (1D) | Velocity Modeling (1D) | Convert 

synthetic data to “observed” data. 
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Figure 238: “Observed” dispersion curve. 

 

The data will now be recognized by the application as “real” or “observed” data and can treated 

as such. 
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Figure 239: “Observed” velocity model. 

 

7.7.8 WAVEFORM MODELING 
 

 

          
 

 
 

 

Continue. 

 

 

 

 

 

 

 

 

 



The WaveEq Module Functions 
 

 

516 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

 

7.7.8.1 FINITE-DIFFERENCE METHOD (2D) 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.8.2 DISCRETE WAVE-NUMBER METHOD (3D P-SV) 
 

 

 
 

 
 

 
 

Once a synthetic velocity model exists, a synthetic waveform file must be generated to calculate 

the dispersion curve. Only active-source waveform files can be simulated. To generate the 

waveform file, select Waveform Modeling | Discrete wave-number method (3D P-SV). The 

DWM parameters dialog box settings determine how the waveform record is calculated: 
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The Data length is the record length in time. Number of samples relates to the sample interval 

used in field acquisition; 1 second divided by 128 samples equals a sample interval of 7.8 

milliseconds. Although this is much larger than what is commonly used in the field for a 1D 

MASW survey, a value of 128 is sufficient and makes the calculation less computationally 

intensive.  

 

The Periodicity length multiplier defines the size of the calculation, and the default value is 

suitable for most cases. First receiver distance is the near offset, the Receiver spacing is simply 

the geophone interval, and the Number of receivers is the number of channels. Refer to Section 

3.1, Page 11, for values similar to what would be used in the field for a 1D MASW survey. The 

Source depth is the depth below surface of the source; for a surface source, enter zero. Epsilon 

controls the accuracy of the calculation, and the default value is suitable for most cases.  

 

To revert to the default values, press Default.  

 

Press OK and the corresponding waveform file is calculated and automatically displayed in 

Pickwin. 
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Figure 240: Synthetic waveform file. 

 

The waveform file is automatically saved to the current directory with the file name 

waveform_data_DWM.8hd.  

 

Proceed with calculating phase velocity and picking the dispersion curve as if the synthetic 

waveform file was a field record.  

 

 

Figure 241: Phase velocity-frequency plot corresponding to synthetic waveform file in Figure 240. 

 

Import the dispersion curve picks into WaveEq, set up an initial model, and run the inversion. 

Refer to Section 7.11.7, Page 593, for explanation of additional modeling functions.  
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7.7.8.3 DISCRETE WAVE-NUMBER METHOD (3D P-SV AND SH) 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.8.4 ADVANCED OPTIONS 
 

 

                     
 

              
 

 
 

 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

 

7.7.8.4.1 DISCRETE WAVE-NUMBER METHOD (3D: MICROTREMOR MODEL) 
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This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.8.4.2 DISCRETE WAVE-NUMBER METHOD (3D-3C: MICROTREMOR 

MODEL) 
 

 

 
 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.8.4.3 DISCRETE WAVE-NUMBER METHOD (3D: CHANGE SOURCE DEPTH) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.7.9 ADVANCED OPTIONS 
 

 

 
 

 

The features in the following sub-menus are highly specialized and rarely used. Please contact 

support@seisimager.com for assistance. 

 

7.7.9.1 COMPARISON WITH N-VALUE 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.9.2 COMPARISON WITH PS 
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This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.9.3 PLATE 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.9.4 PLATE MODEL INVERSION (1D) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.7.9.5 SENSITIVITY ANALYSIS 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.9.6 SPAC INVERSION 
 

 

 
 

 
 

 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. At tutorial on SPAC inversion can be found here. 
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7.7.9.7 GET MIN. AND MAX. VELOCITY MODEL (FROM .RST FILES) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.9.8 GET MIN. AND MAX. VELOCITY MODEL (FROM GA RESULTS) 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.7.9.9 SURFACE WAVE MODE 
 

                                  
 

                               
 

 
 

Continue. 

 

7.7.9.9.1 CHANGE TO LOVE WAVE 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.7.9.9.2 CHANGE TO RAYLEIGH WAVE 
 

 

 
 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.7.9.10 UNIT 
 

 

                                          
 

                                       
 

 
 

 

You may change the units between meters and feet using the next two sub-menus. 

 

7.7.9.10.1 CONVERT TO FEET 
 

 

 
 

 
 

 
 

 
 

You may convert the units of your model from ft and ft/sec to m and m/sec and vice-versa. 

Compare the following displays of the same dispersion curve and model. The first pair is in m 

and m/sec; the second pair is in ft and ft/sec.  

 

Note: You will most likely need to adjust the axis limits [Ctrl+A] when converting between units. 
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Figure 242: Dispersion curve displayed in m/sec. 
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Figure 243: Velocity model displayed in m and m/sec. 
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Figure 244: Dispersion curve from Figure 242 displayed in ft/sec. 
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Figure 245: Velocity model from Figure 243 displayed in ft and ft/sec. 

 

7.7.9.10.2 CONVERT TO METERS 
 

 

 
 

 
 

 
 

 
 

This is just the reverse of that described in the previous section. 
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7.8 MASW/MAM (2D/3D) MENU 
 

The MASW/MAM (2D/3D) menu includes functions for calculating an initial model for a 2D 

dataset and running the inversion to find the best fit of the modified initial model data with the 

observed data. For purchasers of SeisImager/SW-1D, this menu is not active.  

 

 
 

7.8.1 SHOW 2D VELOCITY MODEL <LAUNCHES GEOPLOT> 
 

 

 
 

 
 

 

Once initial or final models exist for a series of CMP cross-correlation gathers, the applicable 

cross-sectional model can be viewed in GeoPlot by selecting Show 2D velocity model. The unit 

labels set in WaveEq carry over. Refer to Section 4.1.3, Page 90, for more information on setting 

display parameters in GeoPlot. 
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7.8.2 SHOW 3D VELOCITY MODEL <LAUNCHES GEOPLOT3D> 
  

 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. You might find it useful to look at this tutorial. If you would like to work through it, 

an example dataset can be found here. 

 

7.8.3 INITIAL MODEL 
 

 
 

 
 

The initial cross-sectional VS model is the starting point for the inversion. For 2D MASW, the 

initial cross-sectional model is interpolated from individual 1D initial models for a set of CMP 

cross-correlation gathers. To generate an initial cross-sectional model from the set of gathers, 

select Initial model. The Initial model for inversion dialog box settings are the same as those 

explained in Section 7.7.1, (Page 479) except that Apply horizontal interpolation is checked by 

default to allow the cross-sectional model to be constructed by interpolation between the series 

of 1D models. 

 

7.8.4 INVERSION (2D/3D: ALL DATA)  
 

 
 

 
 

 

The Inversion (2D/3D: All Data) and Inversion (with N) processes can be computationally 

intensive, and may take some time to complete, depending on the size of the dataset. Also, the 

higher the Iteration value, the longer the process will take. In the Windows Task Manager, 
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WaveEq may report as “Not Responding”, but if the memory usage is dynamically changing, this 

indicates the process is running properly. 

 

7.8.5 INVERSION (2D/3D: ALL DATA) 
 

 

 
 

 
 

 

To calculate the VS cross-section that best matches the observed data, select Inversion 

(2D/3D:All Data). The Least Squares Method dialog box settings are the same as those 

explained in Section 7.7.2 (Page 483), except that the default value for e equals 0.1 and for 

Regularization equals 0.5.  

 

7.8.6 INVERSION (WITH N) 
 

 
 

 
 

If N-values are used to construct the initial model, select Inversion (with N) instead of Inversion 

(2D/3D:All Data). The Least Squares Method dialog box settings are the same as those 

explained in Section 7.7.2 (Page 483), except that the default value for e equals 0.1 and for 

Regularization equals 0.5.  
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7.8.7 ADVANCED INVERSION 
 

 

                        
 

 
 

 

SeisImager includes several advanced inversion tools. Many of the items in the following sub-

menus are rarely used, and when they are, support from Geometrics is generally required. 

 

 

7.8.7.1 GA (2D: AVERAGE DATA) 
 

 

 
 

 
 

 
 

 

 

Select MASW/MAM (2D/3D) | Advanced inversion | GA (2D: Average data) to apply the 

inversion to two-dimensional data using the Genetic Algorithm (GA).  

 

A 2D velocity section of the initial model, example of 1D dispersion curve, and velocity model 

are shown below. 
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Figure 246: Example 2D velocity section, 1D dispersion curve, and1D VS model. 

 

Set the parameters for the Genetic Algorithm. The default values (Iteration=50, Population=50, 

Binary digits=5, Crossover probability=0.5, Mutation probability=0.5) are suitable for most 

cases. Press the OK button to proceed. 

 

 

 
 

 

Set the parameters for constraints based on site conditions. (Contact 

support@seisimager.com for assistance.) Press the OK button to proceed. 
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An example of an inverted result is shown below. The error between observed and theoretical 

phase velocities is smaller than that for the initial model. 

 

 

Figure 247: Inverted result. 

 

7.8.7.2 GA (2D: INDIVIDUAL DATA) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.7.3 INITIAL MODEL (INTERPOLATION) 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.7.4 SORT MODEL BY RMS ERROR FOR GA DATA 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.7.5 SET NUMBER OF MODELS TO BE SHOWN 
 

 

 
 

 
 

 
 

 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.8 CALCULATE RMS FOR ALL DATA 
 

 

 
 

 
 

To calculate the RMS error for an inversion, select Calculate RMS for all data. The RMS error is 

reported as a velocity (m/s or ft/s) and a percentage (%). It is preferable for the error to be less 

than about 5%, but it will depend on the dataset.  
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7.8.9 2D 
 

 

                    
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.8.9.1 SET LATITUDE AND LONGITUDE AT WAYPOINTS 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.9.2 DELETE DISPERSION CURVES OUTSIDE OF DISTANCE RANGE 
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This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

 

7.8.10 3D 
 

 

                       
 

 
 

 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.8.10.1 SET LATITUDE AND LONGITUDE AT CORNERS 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.10.2 CONVERT GRID DATA TO RANDOM DATA 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.10.3 CONVERT RANDOM DATA TO GRID DATA 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.11 SURVEY DESIGN (3D) 
 

 

                       
 

 
 

 

 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.8.11.1 NEW SURVEY 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.11.2 ACQUISITION GEOMETRY 
 

 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

 

7.8.11.3 VIEW OPTIONS 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.11.4 GENERATE NEW 3D VELOCITY MODEL 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.11.5 CALCULATE THEORETICAL DISPERSION CURVES 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.11.6 CONVERT SYNTHETIC DATA TO “OBSERVED” DATA 
 

 

 
 

 
 

 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12 ADVANCED OPTIONS 
 

 

                 
 

 
 

Many of the items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 
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7.8.12.1 CALCULATE 1D AMPLIFICATION FOR ALL DATA 
 

 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.2 RESULT OF GA 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.3 ALLOW EDIT ALL DISPERSION CURVES/MODELS 
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This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.4 COPY CURRENT VELOCITY MODEL TO ALL OTHER DISPERSION 

CURVES 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.5 2D/3D ANALYSIS 
 

 

                      
 

                    
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 
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7.8.12.5.1 CONVERT 2D DATA TO 3D DATA (SET XY LOCATION) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.5.2 READ AND APPLY X OR XY LOCATION FILE 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.12.5.3 CONVERT 2D DATA TO 3D DATA (IMPORT XY LOCATION FILE) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.5.4 SAVE EACH DISPERSION CURVE AS 1D RST OR XML FILE 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.12.6 STATIC QUALITY EVALUATION 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.7 CUSTOM COLOR 
 

 

                           
 

                         
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.8.12.7.1 SAVE CUSTOM DISPERSION CURVE LIST 
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This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.7.2 OPEN CUSTOM DISPERSION CURVE LIST 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.12.8 UNIT 
 

 

                                      
 

                                    
 

 
 

Continue. 

 

7.8.12.8.1 CONVERT TO FEET/METERS 
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You may convert between units for 2D and 3D models in a manner similar to that described in 

Section 7.7.9.10.1, Page 526. If you are working in units of feet, it will say “Convert to meters” 

and vice-versa. 

 

7.8.13 ALMIGHTY 
 

 

                        
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.8.13.1 INVERSION (2D: INDIVIDUAL DATA) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.8.13.2 PLATE MODEL INVERSION (2D) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.8.13.3 OPEN PHASE VELOCITY CURVES (ONLY DATA) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9 OPTIONS MENU 
 

The Options menu includes program controls and settings.  

 

 

 
 

 

7.9.1 DIMENSION SIZE 
 

 

 
 

 
 

To view or change the program data input allowances, select Dimension size.  
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Present size reflects the current Maximum dispersion curves number for 2D MASW. The 

Maximum of 2001 is the highest possible value. To change the number, enter the new value, 

check Change dimension size, and press OK.  

 

 
 

Press OK and restart the program.  

 

 

 
 

 

The wizard automatically defaults to standard dimensions to run efficiently. To use non-standard 

dimensions, you will need to process data manually.  

 

If a program upgrade is purchased, the new registration password can be directly entered in the 

Dimension size dialog box in the Password for upgrade field; however, it is strongly 

recommended to upgrade via the SeisImager Registration program instead. 
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7.9.2 SETTINGS 
 

 

                                
 

 
 

 

Various parameters can be set under Options | Settings. Some of the items in the following sub-

menus are rarely used, and when they are, support from Geometrics is generally required. 

 

7.9.2.1 MAXIMUM VALUE 
 

 

 
 

 
 

 
 

Theoretical phase velocity may be calculated under “averaged” or “maximum” dispersion curve 

assumptions. Activate Maximum value or Average value under Options | Settings to switch 

methods. We recommend using Maximum value and Average value for MASW and SPAC, 

respectively. 

 

7.9.2.2 AVERAGE VALUE 
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See prior section. 

 

7.9.2.3 SET UP (PHASE VELOCITY CALCULATION) 
 

 
 

 
 

 
 

Select Options | Settings | Setup (Phase velocity calculation) to change the settings for higher 

mode calculations of phase velocity. The following dialog box appears when the fundamental 

mode calculation is selected. (Press  before opening dialog.) Note that the number of modes is 

hardwired to one.  
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When the higher mode calculation is selected (press  before opening dialog), the number of 

modes defaults to 5. Use 5 to 20 for the number of modes. The number of modes integrated is 

proportional to computation time. Calculating five to ten modes is suitable for most cases. Use a 

large number (20 to 50) if the data includes significant higher modes that are due to a high 

velocity thin layer underlying a low velocity layer. 

 

 
 

For more information on working with higher modes, see Section 5.1.1, Page 174. 
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7.9.2.4 SET UP (H/V CALCULATION) 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.2.5 SET UP (AMPLIFICATION) 
 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.2.6 SET UP (FULL-WAVE CALCULATION USING DWM) 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.2.7 SAVE GROUP VELOCITY  
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.2.8 PARZEN WINDOW BAND 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.3 METERS AND M/SEC AND FEET AND FT/SEC 
 

 

 
 

 
 

Select the desired unit labels by choosing meters and m/sec or feet and ft/sec. The setting is 

reflected in the display labels, dialog box labels, and default values where applicable.  
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7.9.4 SITE NAME AND COORDINATES 
 

 

 
 

 
 

 
 

You may update the survey data, including coordinates, elevation, site name, and date by 

selecting Options | Site name and coordinates. The lower half of the dialog is applicable for 

surveys conducted in Japan and is rarely used. Contact support@seisimager.com for assistance. 
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7.9.5 LANGUAGE 
 

 

 
Continue 

 

7.9.5.1 ENGLISH, JAPANESE, CHINESE, SPANISH 
 

 

 
 

 
 

 
 

Choose your preferred language. At the time of this writing (January 2025), Chinese and Spanish 

were under construction. 
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7.9.6 NEURAL NETWORK 
 

 

                    
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 
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7.9.6.1 EXPORT TRAINING DATA 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.6.2 EXPORT OBSERVED H/V DATA 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.6.3 SHOW TRAINING DATA 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.6.4 RANDOM MODEL 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.6.5 OPEN STANDARD DATA AND/OR MODEL FILE (.JSON OR .TXT) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.6.6 OPEN MODELS 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.6.7 SAVE MODELS 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.6.8 REVIEW MODELS 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.6.9 SAVE TRAINING DATA 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

 



The WaveEq Module Functions 
 

 

568 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

7.9.6.10 SAVE OBSERVED DATA 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.6.11 IMPORT PREDICTED VELOCITY PROFILE (STANDARD VELOCITY 

MODEL) 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.6.12 CALCULATE WAVEFORM DATA 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.6.13 CALCULATE PHASE VELOCITY IMAGE 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.7 ADVANCED OPTIONS  
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The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.9.7.1 REVERSE Y-AXIS TEXT FOR CLIPBOARD COPY 
 

 
 

 
 

 
 

Reverse Y-axis text for clipboard copy controls how the label for the vertical axis appears when 

Copy to clipboard (Section 7.2.3, Page 342) is selected from the Edit menu. If Reverse Y-axis 

text for clipboard copy is selected, the vertical axis label appears written top to bottom. If not 

selected (the default), the vertical axis label appears written bottom to top.  

 

7.9.7.2 SET UP GEOPLOT.EXE LOCATION 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.7.3 SET UP GEOPLOT3D.EXE LOCATION 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.7.4 SET UP PICKWIN.EXE LOCATION 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.7.5 SET UP SEISIMAGERMAP.EXE LOCATION 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.7.6 PARALLEL PROCESSING 
 

 

 
 

 
 

 
 

If parallel processing is enabled, processing will be faster, but other apps may run slower. 

 

7.9.7.7 USE ONLINE DATABASE 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.7.8 USE THREAD 
 

 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8 ALMIGHTY 
 

 

                                           
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 
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7.9.8.1 LAYERED MODEL ANALYSIS 
 

 

                      
 

                  
 

 
 

The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.9.8.1.1 L.S.M. INVERSION (VS AND H: MULTI-LAYERS, MULTI-CURVES) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.1.2 L.S.M. INVERSION (2 LAYERS) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8.1.3 2 LAYER ANALYSIS 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.1.4 SELECT MODEL 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8.1.5 READ AND PLOT BEST SOLUTIONS 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.1.6 SAVE BEST SOLUTIONS 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8.2 SPAC 
 

 

                                        
 

                                   
 

 
 

The item in the following sub-menu is rarely used, and when it is, support from Geometrics is 

generally required. 
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7.9.8.2.1 SET MINIMUM PHASE VELOCITY 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8.3 HOMOGENEOUS MODEL 
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The items in the following sub-menus are rarely used, and when they are, support from 

Geometrics is generally required. 

 

7.9.8.3.1 1D 
 

 

 
 

 
 

 
 

 
 

 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8.3.2 1D  (COMPLEX) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.3 1D  (ATTENUATION) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8.3.4 2D 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.5 2D (ATTENUATION) 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8.3.6 3D 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.7 CIRCLE (VX) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

7.9.8.3.8 CIRCLE (VZ) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.9 COMPARISON FOR VARIABLE GRID 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.10 LAMB’S PROBLEM 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.11 LAMB’S PROBLEM (2) 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.12 LAMB’S PROBLEM (3) 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.13 LAMB'S PROBLEM (2 KM) 
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 
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7.9.8.3.14 PLANE WAVE (1D FREQUENCY DOMAIN SOLUTION) 
 

 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



The WaveEq Module Functions 
 

 

591 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

PN 770-00118-01 July 2024 

 

7.9.8.3.15 PLANE WAVE (1D TIME DOMAIN SOLUTION)             
 

 
 

 
 

 
 

 
 

This feature is highly specialized and rarely used. Please contact support@seisimager.com for 

assistance. 

7.10 HELP MENU  
 

 
 

Continue. 
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7.10.1 VERSION INFO 
 

 

 
 

 
 

The Help menu or Version info  button reports the software version information.  

 

 
 

7.10.2 SEISIMAGER.COM  
 

 

 
 

 
 

Selecting this item will take you to the SeisImager.com website. 

 

7.11 TOOL BUTTONS  
 

The WaveEq Tool Button functions not already discussed in association with specific menu 

functions are explained in this section.  

 

7.11.1 ENLARGE WAVEFORM AMPLITUDE  AND REDUCE WAVEFORM 

AMPLITUDE  
 

The Enlarge waveform amplitude and Reduce waveform amplitude buttons have no meaning in 

WaveEq.  
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7.11.2 REDUCE HORIZONTAL SCALE  AND ENLARGE HORIZONTAL 

SCALE  
 

To reduce or enlarge the horizontal scale of plots of dispersion curves, geometry, and velocity 

models, press the Reduce horizontal scale and Enlarge horizontal scale buttons. The associated 

keyboard shortcuts are the left arrow and right arrow keys, respectively.  

7.11.3 ENLARGE VERTICAL SCALE  AND REDUCE VERTICAL SCALE  
 

To enlarge or reduce the vertical scale of plots of dispersion curves, geometry, and velocity 

models, press the Enlarge vertical scale and Reduce vertical scale buttons. The associated 

keyboard shortcuts are the up arrow and down arrow keys, respectively.  

 

7.11.4 SHOW PREVIOUS  AND SHOW NEXT  
 

To scroll through individual dispersion curves or velocity models, press the Show previous and 

Show next buttons. In the geometry plot view, these buttons are also used to select a specific 

geometry of a waveform file to display. 

 

7.11.5 HOME  AND END  
 

To jump to the first or last of a set of dispersion curves or velocity models, press the Home and 

End buttons.  

 

7.11.6 CALCULATE THEORETICAL DISPERSION CURVE BY FUNDAMENTAL 

MODE  
 

The Calculate theoretical dispersion curve by fundamental mode button toggles off Calculate 

theoretical dispersion curve by harmonic mode. 

 

7.11.7 CALCULATE THEORETICAL DISPERSION CURVE BY HIGHER MODE 

 
 

In the dispersion curve view for synthetic modeling, higher modes can be modeled by first 

pressing on the Calculate theoretical dispersion curve by higher mode button, then pressing on 

the Calculate theoretical dispersion curves  button. The dispersion curve view will display a 

set of curves. The curves with connected open circles are fundamental mode dispersion curves 

and the solid lines are the higher mode dispersion curves, associated with each fundamental 

mode curve by color. The dashed lines are the relative amplitudes of the higher modes, also 

associated by color.  
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Figure 248: Theoretical fundamental dispersion curve with higher modes shown. 

 

To toggle off the higher mode dispersion curves, press the Calculate theoretical dispersion 

curves button again. To return to the fundamental mode, press the Calculate theoretical 

dispersion curve by fundamental mode  button.  

 

7.11.8 SELECT DISPERSION CURVE  AND CORRECT DISPERSION CURVE 

 
 

The Select dispersion curve and Correct dispersion curve buttons can be used for point-based 

editing. To reverse any changes, press the Undo  button.  

 

Press the Select dispersion curve button, then click on the point(s) on the dispersion curve that 

you wish to delete. The selected points will be highlighted in red.   
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Figure 249: Date points selected for deletion. 

 

When done selecting points, hit the Delete key or select Delete from the Edit menu. If you 

change your mind and do not want to delete the selected points, press the Select dispersion curve 

button to deselect the points and exit editing mode.  

 

To edit the dispersion curve by dragging points to new positions in the direction of phase 

velocity on the plot, press the Correct dispersion curve button. Left click on the point and drag to 

adjust; it will turn red and then revert to white at the new position when the mouse button is 

released.  

 

The Undo button can be pressed after any deletion or repositioning to reverse the effect. 
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Appendix A BASIC PROCESSING FLOWS  
 

The basic processing flows for 1D MASW, MAM, and 2D MASW datasets are summarized in this 

section. 

 

A.1 Active-source 1D MASW 

 

1. In Pickwin, open a waveform file. 

 

 
 

2. In Pickwin, set the unit labels to meters or feet by opening the Edit/Display menu and selecting 

Edit source/receiver locations (this is not an automatic part of the wizard, but should be done if there 

is a change from the unit labels last used). 

 

 
 

Alternatively, the unit labels may be set by opening the Options menu and selecting meters and 

m/sec or feet and ft/sec. 
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3. In Pickwin, calculate phase velocity.  

 

  
 

Upon viewing the phase velocity-frequency plot, if the calculation parameters need to be changed, 

press the Undo button, and re-run the process (this is not an automatic part of the wizard).  

 

4. In Pickwin, pick the dispersion curve.  

 

  
 

5. In Pickwin, import the picks into WaveEq.  

 

 
 

6. In WaveEq, edit the dispersion curve.  

 

 
7. In WaveEq, calculate the initial model. 
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8. In WaveEq, run the inversion. 

 

 
 

  

A.2  passive-source MAM 

 

1. In Pickwin, make a list of the waveform files in the dataset.  

 

 
 

2. In Pickwin, set the unit labels to meters or feet by opening the Edit/Display menu and selecting 

Edit source/receiver locations (this is not an automatic part of the wizard, but should be done if there 

is a change from the unit labels last used). 
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Alternatively, the unit labels may be set by opening the Options menu and selecting meters and 

m/sec or feet and ft/sec. 

 

 
 

3. In Pickwin, run the spatial autocorrelation.  

 

  
 

4. In Pickwin, calculate phase velocity. 
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Upon viewing the phase velocity-frequency plot, if the calculation parameters need to be changed, 

press the Undo button, and re-run the process (this is not an automatic part of the wizard).  

 

5. In Pickwin, pick the dispersion curve. 

 

  
 

6. In Pickwin, import the picks into WaveEq. 

 

  
 

7. In WaveEq, edit the dispersion curve. 

 

 
 

8. In WaveEq, calculate the initial model. 

 

 
 

9. In WaveEq, run the inversion.  
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A.3 Active-source 2D MASW 

 

1. In Pickwin, make a list of waveform files in the dataset. 

 

 
 

2. In Pickwin, set the unit labels to meters or feet by opening the Edit/Display menu and selecting 

Edit source/receiver locations (this is not an automatic part of the wizard, but should be done if there 

is a change from the unit labels last used). 
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Alternatively, the unit labels may be set by opening the Options menu and selecting meters and 

m/sec or feet and ft/sec. 

 

 
 

3. In Pickwin, save the file list for future use. 
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4. In Pickwin, set up the source-receiver geometry.  
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5. In Pickwin, calculate and assemble the CMP cross-correlation gathers.  
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6. In Pickwin, calculate phase velocity for the CMP cross-correlation gathers and automatically pick 

the dispersion curves.  

 

 
 

7. In Pickwin, import the dispersion curves into WaveEq. 

 

 
 

8. In WaveEq, calculate the initial model. 

 

 
 

9. In GeoPlot, view the initial model.  

 

 
 

10. In WaveEq, run the inversion. 
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11. In GeoPlot, view the final model.  

 

 
 

A.4 Viewing and Editing Individual Dispersion Curves in Pickwin 

 

In Pickwin, prior to launching WaveEq, dispersion curves from a 2D MASW dataset may be 

individually edited in the phase velocity-frequency plot view. Usually, with 2D MASW datasets, 

there are too many curves to pick manually, and the automatic picker is more precise than the human 

eye. Occasionally, however, there may be a need to override the automatic picks. This section 

describes the processing flow; these steps would be added in between Steps 6 and 7 on Page A-11.  

 

1. In Pickwin, press the Geometry  button to display the geometry view. Use the Show previous 

waveform  and Show next waveform  buttons to select the CMP cross-correlation gather for 

which you want to view and edit the dispersion curve.  
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Figure A-1: Geometry plot with CMP cross-correlation gather selected (red). 

 

2. Press the Waveform  button to display the waveform file for the selected CMP cross-

correlation gather.  

 

3. Calculate phase velocity for the CMP cross-correlation gather. 

 

 
 

4. The phase velocity-frequency plot for the selected CMP cross-correlation gather is displayed with 

the rest of the dispersion curves picked in Step 6 on Page A-11. The pink line connecting red picks is 

the individual dispersion curve associated with the selected CMP cross-correlation gather. The rest 

of the curves are shown in green.  

 

 

Figure A-2: Phase velocity-frequency plot for selected CMP cross-correlation gather. 
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Adjust the dispersion curve picks as desired and use the Update  button to register the new picks.  

 

 

Figure A-3: Adjusted dispersion curve picks. 

 

5. To edit other dispersion curves, repeat the process from Step 1. 

 

6. Once editing is complete, save the revised dispersion curves. 

 

 
 

7. Import the revised dispersion curves into WaveEq.   
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#  

 

As an alternative, the saved dispersion curve file can be opened in WaveEq. 
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Appendix B DATA EXAMPLES AND QUALITY CONTROL 
 

Continue. 

B.1 Active-source Waveform Data 

 

Continue. 

B.1.1 Lower Quality 

 

The shot record below lacks coherent surface wave signal from the near to far traces and is 

heavily contaminated with relatively lower frequency noise, particularly from 75 to 170 feet. 

Shot stacking or a larger source, and waiting for a quieter recording period, would probably help.  

 

 

Figure B-1: Example of low-quality active-source record due to poor signal-to-noise ratio. 

 

In this shot record, the takeouts for channels 6, and 12 through 16 were left open with no 

geophones connected. No signal was recorded, giving up 100 ft of offset on the far end of the 

spread and creating a 40-foot gap in between traces 5 and 7.  
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Figure B-2: Example of low-quality active-source record due to dead traces. 

 

Due to a small near offset, in this shot record, the signal on the geophone at 51 feet was clipped. 

A few overdriven channels can be tolerated but it is best practice to not record clipped signal.  

 

 

Figure B-3: Example of low-quality active-source record due to small near-offset, resulting in clipped traces. 

 

B.1.2 Higher Quality 

 

The shot record below displays high signal-to-noise ratio, no clipped traces, and coherency from 

trace-to-trace.  
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Figure B-4: High-quality active-source record. 

 

B.2  Passive-source Waveform Data 

 

Continue. 

B.2.1 Lower Quality 

 

The record below shows wide variation in trace amplitude from trace-to-trace.  

 

 

Figure B-5: Low-quality  passive-source record due to large amplitude variation between traces. 

 

Upon viewing the spectrum, it is clear that the frequency content is uneven.   
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Figure B-6: Frequency spectrum of record shown in Figure B-5. 

 

A similar condition is evident in this record and associated frequency spectrum.  

 

 

Figure B-7: Second example of low-quality  passive-source record due to large amplitude variation between traces. 

 

 

 

Figure B-8: Frequency spectrum of record shown in Figure B-7. 
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In this record, the traces are similar to each other, but over time, there is a wide range in 

amplitude.  

 

 

Figure B-9: Example of low-quality  passive-source record due to large amplitude variation over times. 

 

The spectrum shows fairly consistent frequency content from trace-to-trace, but not as tight as it 

could be.  

 

 

Figure B-10: Frequency spectrum of record shown in Figure B-9. 

 

B.2.2 Higher Quality 

 

The record below is ideal, showing even signal amplitude from trace-to-trace and in time.  
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Figure B-11: Ideal  passive-source record. 

 

The corresponding frequency spectrum shows the energy contained in a neat envelope from 

approximately 2 to 7 Hz.  

 

 

Figure B-12: Frequency spectrum of record shown in Figure B-11. 

 

 

This record has some intermittent higher-amplitude noise from passing cars (between 21 and 26 

seconds).  
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Figure B-13:  passive-source record with noise from passing car. 

 

The frequency spectrum shows the car noise has relatively little impact on the record quality 

since it was of short duration compared to the total recording time.  

 

 

Figure B-14: Frequency spectrum of record shown in Figure B-13. 
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B.3 Dispersion Curves 

 

Continue. 

B.3.1 Characteristics  

 

Dispersion curves are smooth, curved or straight lines. 

 

 

Figure B-15: VS models and corresponding dispersion curves. 
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Dispersion curves reflect the average velocity model beneath the geophone spread.  

 

 

Figure B-16: Gradual change of dispersion curves over abrupt change in velocity. 
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Only the Rayleigh wave fundamental mode is used for analysis, although higher modes are 

present and often visible. 

 

 

 

Figure B-17: Phase velocity-frequency plot and dispersion curve indicating fundamental mode, higher mode, and 

noise. 

 

The frequency range within which phase velocity is considered stable corresponds to the 

minimum and maximum wavelengths recorded, and there is generally a one-to-one relationship 

between the minimum and maximum wavelength, and the geophone interval and total offset 

(spread length), respectively.  

 

The bounds of the stable frequency range are depicted on the phase velocity-frequency plot by 

blue lines (shown above) and by bold black lines (shown below), with slopes that correspond to 

the minimum and maximum wavelengths. 
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Figure B-18: Bounds of the stable frequency range. 

  



Appendices 
 

 

B-12 
Hayashi/Underwood/Lippus SeisImager/SW Manual v. 4.0 

P/N 770-00118-01 July 2024 

 

B.3.2 Comparison of data from ground with variable stiffness 
 

 

Figure B-19: Comparison of waveform files, phase velocity-frequency plots, and Vs models for different geology 

types. 
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Appendix C H/V THEORY 
 

Theory and methods of the Horizontal to Vertical Spectral Ratio Method, or H/V method, are 

summarized from the USGS publication, Estimation Of Bedrock Depth Using The Horizontal-To-

Vertical (H/V) Ambient-Noise Seismic Method by Lane et al. 

 

The H/V method uses passive seismic data to evaluate a site’s resonant frequency. Three-component 

ambient seismic data is collected and used to calculate the horizontal-to-vertical spectral ratio. The 

method has primarily been used for micro zonation studies to characterize earthquake site response, 

and to estimate depth to bedrock. 

 

The theoretical seismic resonant frequency may be estimated for a two-layer model according to the 

equation below, where n, VS, and Z correspond to mode, average shear-wave velocity of the upper 

layer in m/s, and sediment thickness respectively. 

 

 
 

Nakamura (1989) demonstrated how the fundamental resonant frequency of a site can be 

approximated from the H/V spectral ratio. The H/V spectral ratio is calculated as follows. 

 

 
 

The method assumes an acoustic impedance contrast equal to or greater than two between the 

bedrock and overlying sedimentary layer. Case studies have shown the inability of the method to 

accurately determine depth to bedrock where this assumption does not hold (Lane et al., 2008). The 

assumption may not hold if gradational cementation, strong heterogeneity, or deep weathering exists. 

 

Please see the referenced article for further discussion on H/V theory. 
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Appendix D TUTORIALS AND EXAMPLE DATA 
 

Atom: Active and Passive surface wave methods using Atom for AVS30 investigation: Tutorial 

 

Atom: 3D ambient noise tomography using Atom and SeisImager/SW3D: Tutorial 

 

Atom: 2D MASW (Atom data) processing using SeisImager/SW 2D: Tutorial 

 

Atom-3C: 3C SPAC processing using Atom and SeisImager/SW3C: Tutorial 

 

Atom-3C: Horizontal to vertical spectral ratio (H/V) using Atom-3C and SeisImager/SW: Tutorial 

 

Atom-3C: Horizontal to vertical spectral ratio (H/V) using Atom-3C and SeisImager on mobile 

devices: Tutorial 

 

 

Atom-3C: 3D and 3C ambient noise tomography using Atom/Atom-3C and SeisImager/SW3D: 

Tutorial 

 

Geode/Atom: Calculate a dispersion curve from multi-shots in 1D MASW: Tutorial 

 

Geode: 2D SPAC processing using Geode and SeisImager/SW2D: Tutorial 

 

Geode: 2D MASW (Geode data) processing using SeisImager/SW2D: Tutorial 

 

 

Instant downloads 

 

Atom: 3D passive: Tutorial and example data (108.5 Mb) 

 

Atom: 1D active (2 m spacings) and passive (Triangle 10 50 m): Tutorial and example data (19.7 

Mb) 

 

Atom: 1D passive (L-shape 11 75 m): Data only (22.6 Mb) 

 

Atom: 1D passive (Triangle 10 50 m with 3C): Tutorial and example data (9.6 Mb) 

 

Atom: Horizontal to vertical spectral ratio (H/V or HVSR): Tutorial and example data (1.2 Mb) 

 

Atom: 2D Passive: Tutorial and example data (97.7 Mb) 

 

Geode: 1D MASW: Data only (0.2 Mb) 

 

Geode: 2D MASW (variable receiver): Tutorial and example data (5.8 Mb) 

 

Geode: 2D MASW (fixed receiver): Data only (1.4 Mb) 
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Geode: 1D Passive: Data only (7.8 Mb) 

 

Geode: 1D active and Passive (linear array with 10 ft receiver spacing): Data only (14.6 Mb) 
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Appendix E SHORT COURSE PRESENTATIONS 
 

 

Overview of Surface Wave Methods 

 

Waveform Data Processing 

 

Calculating Phase Velocities 

 

Data Acquisition 

 

CMPCC and CMPSPAC 

 

Data Processing Using SeisImager 

 

Inversion and Uncertainty 

 

Application Examples 
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